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Welcome to Extensis™ Preflight Pro™! With Preflight Pro you
can quickly identify and solve prepress problems, eliminating
incomplete files and wasted film, while also saving precious time
by automating much of the preflight process. 

Preflight Pro’s easy-to-use, intuitive Job Jacket interface makes it
easy to check your documents and take corrective action before
output. Simply inspect your documents for problems, then
generate and examine the problem report. If all is well, you’re
ready to output the job. If the report has identified problems, you
can use the exclusive Pilot feature to navigate the problem list
from inside the document, examining and solving problems as
you go.

You can use Preflight Pro’s comprehensive Collect Job Elements
feature to gather everything together, and optionally compress it
in the same operation. You can even create PDF files to add to the
collection. And if you have a number of jobs of similar type, you
can automate the entire preflight process using Preflight Pro
Actions.

With Extensis Preflight Pro you can:

•  Increase the overall speed, reliability, and automaticity of
your preflight process.

•  Collect every element of your job and be completely
prepared  for final output.

•  Use the Pilot feature to go immediately from the Preflight
Pro problem report to your  document to find and fix
problems.

•  Inspect and report on multiple files and multiple file types, so
you can see the entire job at a glance, not just one file.

•  Reduce training costs; eliminate wasted time and film.
•  Customize to meet the differing needs of each job.

System and Software Requirements

To install and use Preflight Pro, you will need the following:

•   Apple® Macintosh® 68040 or faster, including Power
Macintosh® and PowerPC compatible

•   1.5M RAM, minimum, for Preflight Pro
•   Mac OS® System 7.5 or later
•   Adobe® Acrobat Distiller® 3.0 or later required for  

“Export to PDF” feature
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Introducing Preflight Pro

Preflight Pro supports
documents created with the
following program versions:

•   QuarkXPress® 3.32 and later,
including 4.0

•   PageMaker 6.5 and later
•   Photoshop 3.0 and later
•   Illustrator 5.5 and later
•   FreeHand 7.0 and later
•   Multi-Ad Creator2 1.0 and later



Installation

Instructions for quick and easy installation can be found on the
CD-ROM that is included with your product.

Registration

It is important to register your copy of Preflight Pro so we can
provide you with the best possible service. Registered users of
Preflight Pro are eligible for technical support, information regard-
ing new versions and products, discounts and special offers on
new products. 

Your registration number is located on the back cover of this man-
ual. You will need to enter that number to personalize your copy of
Preflight Pro. If you choose not to personalize your copy, Preflight
Pro will run in a demonstration mode that allows you to use the
product for 30 days. You can purchase additional registration num-
bers at 1-800-796-9798.

Technical Support 

For questions regarding Preflight Pro, please first refer to this
manual, which describes the features and basic operations. We
invite you to visit our Preflight Pro page on the Extensis web site
(www.extensis.com) for frequently asked questions and trouble-
shooting tips.

If you have a question which is not addressed in this manual or
on the Extensis web site, Technical Support is available by
phone at (503) 274-7030, Monday through Friday, 8:00 a.m. to
5:00 p.m.Pacific time. When calling for technical support, please
be at your computer and have the following information available:
your Preflight Pro registration number, your computer configura-
tion, and your question or a description of the difficulty you’re
experiencing—what specifically occurs and when. Take note of
any displayed error numbers or messages and any other informa-
tion you think may be relevant.

6

Tip

We can also be reached by:

Fax: (503) 274-0530

E-mail: support@extensis.com

Internet:
http://www.extensis.com/support



What Is “preflighting”?

Jobs that print or output properly in the hands of the designer, and
jobs that output properly to low or medium resolution printers,
very often will not output properly when transferred to a service
bureau or output facility, or will not print or output as the design-
er had expected or hoped. 

The output facility will almost certainly have completely different
computer systems and setups, different font configurations, differ-
ent—usually high or very high—resolution output devices, and
they may even be adding high resolution images in place of the
lower resolution images originally placed in the document by the
designer. Any of these differences, and many others, can sabotage
the job and cause problems in outputting or printing.

Preflighting is the process of making sure that all the elements
necessary for the job to output properly are in place, and that
problems in job documents that might keep them from outputting
properly on high-end equipment have been accounted for and cor-
rected. Problems with the output can be very costly and time-con-
suming to fix, and they become even more costly, in both delays and
actual costs, the further along in the production cycle the job gets. 

How Can Preflight Pro Help Me?

Proper preflighting can be invaluable in saving time and money in
the output process, and in reducing or eliminating costly delays.
And automated preflighting, unequaled with Preflight Pro, makes
the process—which in the past was so complex that it often
required the most technically qualified people in the shop—
quick, easy, and less expensive. 

Preflight Pro will answer the following questions: 
• Are all the elements necessary for properly outputting this job

available to the system that will output it?
• Will it process properly through the RIP?
• Can the job be printed on the required press(es) with proper

quality, and will it trim and bind correctly?

Knowing what potential problems exist, and being able to locate
and fix them prior to output will make all the difference in your
ability to get the job right before tying up costly equipment, labor,
and supplies. 
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What’s New in Preflight Pro 2.0

If you’ve been using Preflight Pro 1.0 to analyze and prepare
your documents for output, you’ll be pleased to know that
Preflight Pro 2.0 offers you a number of exciting enhancements
to make the task of preflighting even easier than before!

New features:

• Support for documents created in PageMaker, Illustrator,
FreeHand, Photoshop, and Multi-Ad Creator2.

• Automation features including Watch folders, allowing you to
automatically preflight jobs, then move files and run
AppleScripts based on pass/fail conditions  (page 97). 

• Create PDF files as a part of the preflight job using
customizable Acrobat Distiller profiles (page 78). (Requires
Adobe Acrobat Distiller 3.0 or later.) 

• Addition of Font Search Paths so you can preflight documents
without installing or opening job fonts (page 53).

• OPI support to inspect and collect high resolution graphics
(page 87).

Enhancements:

• Faster inspection and problem analysis.

• Button bar moved outside the Files tab for easier access. 

• Increased Report capability that captures just the data you want
to see (page 63).

• Parent application icons in the Job Jacket and Report windows
for easy document recognition.

• Enhanced problem descriptions and solution tips (page 159).

• Additional Preferences for automating the inspection and
reporting process, such as auto-open Report window when
Inspection is complete, and auto-open Pilot when Report is
opened (page 49).

• Improvements to the Collection process, allowing you to more
easily limit what gets collected, and how the collection is
organized (page 87).

• Improved comprehensive tutorial, for experienced preflight
users new to Preflight Pro, and preflighting beginners
(page 103).

The process of preflighting with Extensis Preflight Pro can be

8
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summarized in just a few quick steps:

1. Launch Preflight Pro, then name and save your new job.

2. Drag the document(s) to be preflightedinto the open Files
window of the new Job Jacket.

3. Enter Output Instructions critical to your job when the
Output Instructions dialog appears. 

4. Create and assign a Profileto be used for problem analysis,
or simply allow Preflight Pro to use the automatically-
assigned (default) Profile.

5. Inspect your document(s)by selecting them in the Job
Jacket Files list and clicking the Inspect button. 

6. Correct the problems listed in the Problem Report which is
automatically generated when the Inspection is complete. Use
the floating Pilot to go directly to problems for correction.

In addition to the basic preflighting steps listed on the previous

Getting Started with Preflight Pro

Inspect

Report

Tip

Read through the General
Overview (page 12) to see exactly
what tasks Preflight Pro performs
during each step in the preflight
process, then use Edit > Prefer-
ences > General (page 49) and
Preflight Pro Automations (page
97) to automate the process to
suit your needs. 
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page, Preflight Pro provides these additional functions to make
the job of preparing documents for output even easier:

• Specify Job Ticket information (page 20)by clicking the
Job Ticket button. Important and comprehensive job
instructions can be entered here and automatically sent with
the job.

• Make PDF files (page 78) from your documents and include
them in the collection, if you wish. Create numerous PDF
and Distiller settings for future use. Save or automatically
discard the intermediate PostScript file.

• Collect all Job Elements(page 87)for archiving or sending
to the output facility, either compressed or uncompressed.
Automatically collect documents, fonts, graphics, Profiles,
and PDFs, and include or exclude items as you wish.

• Completely Automate the preflight process(page 97)with
Preflight Pro Automations, where a specified folder is moni-
tored for incoming jobs, and preflight operations are automat-
ically performed on the contents. Then when preflighting is
complete, the jobs are output to specified Pass or Fail  folders
depending on completion parameters that you set.

• Print Reports (page 60)of pertinent job information, such as
the Job Ticket, document and page statistics, uncorrected
problems, and more.



Where to Turn for Information

Where you turn in this User Guide will depend on what you
would like to learn about Preflight Pro:

• To get a detailed overview of the steps it takes to successfully
preflight documents with Preflight Pro, see Getting Started
(page 9) and General Overview (page 12).

• To learn all about using Preflight Pro to create and inspect jobs
prior to output, see the comprehensive Preflight Pro Tutorial
(page 103).

• To experiment on your own, using either the Sample Files in
the Preflight Pro folder on the Extensis CD or your own docu-
ment files, see the following sections: The Job Jacket (page
24), Working in the Job Jacket (page 39), Profiles (page 55),
and Problem Reporting and Correction (page 63). These sec-
tions provide reference material for the major preflighting oper-
ations in Preflight Pro.

• For information on additional features and options, including
collecting for output, making PDF files, and automating the
preflight process, see: Collecting Job Elements (page 87),
Exporting to PDF (page 78), andAutomating Preflight Pro
(page 97). 

• For a listing of the Profile Items (potential problems) that are
identified by Preflight Pro and what they mean, seeAppen-
dix A: Profile Items (page 134).

• For a listing of problems and potential solutions that can be iden-
tified by Preflight Pro, or for templates to use in building your
own Profiles, see Appendix B: Problems/Solutions (page 159).

About the Sample Files

We have provided some sample documents with typical preflight
problems for you to use in learning Preflight Pro. These “Sample
Files” are located on the Extensis CD. 

Combined with the comprehensive Preflight Pro Tutorial
(page 103), the Sample Files will help you learn about the many
features and options available. Besides using them in the tutorial,
you can drag the Sample documents into an open Job Jacket,
Inspect them, then examine the problem Report to see what
problems were found.

11
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General Overview

1. Launch Preflight Pro, then name and save your new job.

When launched with no job selected, Preflight Pro automati-
cally opens a new “Job Jacket” with the Files tab selected.
Name and save the new job using the “Save” command in
the File menu. All changes made to the job file will be auto-
matically saved as you work on the job, and when the Job
Jacket is closed.

2. Drag the document(s) to be preflighted into the open
“Files” window of the new Job Jacket.

The Output Instructions dialog will be presented automa-
tically, allowing you to specify the Output Instructions for
the documents (see step 3). You can elect not to have
Preflight Pro automatically present the Output Instructions
dialog in Edit > Preferences > General.

The Job Jacket is the main window in Preflight Pro. From it
you can access: the Files tab, containing a list of documents in
the job and document status; the Button Bar, giving you
access to the major functions and operations; and the different
tabs containing information gathered during the Inspection.

You can determine button functions, column functions, and
the functions associated with each icon in the files list by
passing the mouse over each item and noticing what appears
in the Help box at the bottom-left corner of the window.
Many Preflight Pro windows provide a similar Help box,
giving you either a function description or additional
information about the selected item.

Tip

You can also drag and drop files
onto the Preflight Pro application
icon. 
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3. Enter document Output Instructions.

Preflight Pro can gather nearly all document informa-
tion critical to the successful output of the job auto-

matically during the inspection process (see step 5). The out-
put instructions themselves, however, must be hand-entered so
they may be checked against the document settings. Since this
need is so common, your are automatically presented with this
dialog when you add files to the Job Jacket. You can disable
this automatic process in Edit > Preferences > General. 

3a. Optional: Enter Job Ticket information.

Preflight Pro allows you to view and enter all types of
information found on the Job Ticket, such as contact,

delivery, and billing information. Access the Job Ticket by
clicking the “Edit Ticket” button. 

Tip

Even if you don’t use Preflight Pro’s
Watch folder Automations (page 97)
you can still automate the preflight
process using the options in Edit >
Preferences > General. It’s a good
idea to set your Default Output
Instructions and default Profiles
before enabling these automations.

For a typical job you could drag
and drop your files onto the
Preflight Pro icon, then have
Preflight Pro automatically: Create
the Job Jacket; apply your Default
Output Instructions; apply your
default Profile(s); Inspect your doc-
uments; open the problem Report;
and open the Preflight Pro Pilot. 

Then all that’s left to do is use the
Pilot to walk through the problem
list, correcting each problem as you
go. When that’s done, just save the
document(s), reinspect to verify that
all the problems were corrected,
and collect the job!
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4. Create and assign a Profile to your documents for use in
problem analysis, or simply allow Preflight Pro to use the
already-assigned (default) profile for each document type.

With Preflight Pro, you have complete control over what con-
ditions will be indicated as problems, and how those prob-
lems will be reported. The place you specify this information
is in the Profile. 

You assign a Profile to a document from
the Profiles pop-up on the document list of
the Job Jacket Files tab. If you don’t assign

a Profile, the Default Profile for that document type is auto-
matically assigned. 

Profiles are an extremely powerful tool, and they are
easy to configure and use. You use profiles to determine
which problem conditions are of concern to you, how
critical each problem condition is, and to set certain
thresholds or tolerances. 

You access the Configure Profiles dialog from
the Configure menu in the menu bar. A differ-
ent Profile can be assigned to each document,
as well as to specific pages within a docu-
ment. Profiles are discussed in the section
“Profiles” (page 55), in Appendix A (page
134) andAppendix B (page 159), and in the
Preflight Pro Tutorial starting on page 103.
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5. Inspect the document(s) by clicking the Inspect button.

Select the document(s) you wish to inspect, then click
the Inspect button. 

If the document is a PageMaker or QuarkXPress document,
Preflight Pro will launch the application, open the specified
document(s) and gather the data needed for the preflight
report. It will then close the document(s) and close the appli-
cation. If the document is a graphic or Multi-Ad Creator2
document, Preflight Pro will fetch the information without
opening the parent application. 

Icons in the Job Jacket window keep you updated on overall
document status and individual page status, as well as letting
you see at a glance the application that created the document.

If you have more than one copy of the PageMaker or
QuarkXPress application, you can specify which copy to use
in Preflight Pro Preferences. 

You can also have Preflight Pro leave the document open
when the inspection is complete. 

For creating PDF files from your documents, Preflight Pro
will select the Acrobat Distiller PPD, if it is available. You
can select a different printer driver from the “Make PDF PPD
file”: pop-up menu.

For more information on Inspections refer to Inspecting
Documents (page 41), The Job Jacket (page 24),
Preferences (page 49), and to the tutorial “Preflight Pro
Tutorial,” starting on page 103.
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6. Examine the problem report.

After a document is inspected, the problem Report is
created and automatically displayed. You can instruct

Preflight Pro to open Reports only when you click the Report
button by setting this option in Preferences > General.

The problem report is called a “Consolidated Report”
because it includes problem conditions for all documents in
the job which have been inspected and selected for reporting,
and for all pages within those documents which have not been
specifically excluded from the report. 

The problem report will show you only those conditions that
you consider important, based on the problem information
you specified in the Profile assigned to the document.
Problems are sorted and listed in two ways: by document and
page, and by problem condition. 

Look through the problem listings to see what problems were
found. If the listed problem involves a font, picture, or color
element, double-clicking it will bring up a more detailed win-
dow about the element.

Use the “error,” “caution” and “ignore” problem severity
checkboxes (at the top
of the window) alone

or in combination to instantly expand or contract the prob-
lems list (the problem severity flag for each problem is set in
the Profile).
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7. Go to and correct problem(s).

Once you have examined the Report, you can correct the
problem(s) indicated. 

If the listed problem can be resolved from inside the docu-
ment (for example, output set to be reduced or enlarged), you
can use the Preflight Pro Pilot to open the document and go
to the first occurrence of the problem.

From the Consolidated Report problem list, select the problem
you wish to correct, then click the “Open Pilot” button at the

top of the Report window. On the Pilot palette,
click “Show.” Preflight Pro will launch the par-
ent application and open the document. If it is a
PageMaker or QuarkXPress document, Pilot will

take you to the first occurrence of the problem in the docu-
ment. 

When the problem has been corrected, save the document
and use the Pilot to return to Preflight Pro.
Preflight Pro will be aware that a change was

made and will change the document listing in the Report
window to red, indicating that the file should be reinspected.

If the problem cannot be resolved from within the document
(for example, a missing printer font) simply correct the prob-
lem using conventional methods. 

Use the navigational buttons on the Pilot palette to move
through the problem list, and continue correcting
problems as you go.

8. Optional: Reinspect the document(s) to verify that all
problems have been corrected.

When you return to the Job Jacket, any documents that had
been modified will be listed as such on the Job Jacket Files
list. You should reinspect modified documents to verify that
all problems have been resolved.

Select the documents to be inspected in the Files list,
then click the Inspect button. 

When the inspection is complete, the Report window
will be displayed, showing that all problems have

been successfully corrected, or any problems remaining.
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9. Optional: Export selected documents as PDF files.

To create PDF files from your PageMaker or Quark-
XPress documents, simply select those documents on

the Job Jacket Files list, then click the Export as PDF button.
You can also have Preflight Pro create PDF files when the Job
is collected.

Preflight Pro will allow you to set appropriate PDF settings
“on the fly,” or you can create sets of preconfigured settings.
With the settings in place, Preflight Pro will launch the docu-
ment’s parent application to create the PostScript file, then
launch Acrobat Distiller (part of the Adobe Acrobat Exchange
program) to complete the conversion. You can have the inter-
mediate PostScript file deleted or saved. 

When the process is complete, a sticky note is placed inside
the PDF file, and the completed PDF is added to the  Job
Jacket Files list.
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10. Optional: Collect all the job elements for archiving or
sending to the print facility.

Gather together all the documents, pictures, and fonts
that make up the job by clicking the “Collect Job

Elements” button. 

From the Collection Setup dialog you can: include fonts and/or
pictures (including imbedded pictures) and OPI images in the
collection; compress the collection (and even segment it); save
and/or print a Collection Report; and automatically create a
PDF file of any QuarkXPress and PageMaker documents in
the job. 

When you have made your selections, Preflight Pro gathers the
job elements and displays them on the Collection Preview list.
From the list you can remove items from the collection, or add
items that are not a part of the preflight job.

Preflight Pro then gathers the collection and compresses it, if
that option was selected. For more information on the collec-
tion process and collection options, refer to page 87.
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The Job Ticket is the place, inside the Job Jacket, where all the
information about a job that is not associated with problem condi-
tions is kept. Job Ticket information is not required, but when
used, it is usually hand-entered by a human being. 

The electronically generated Job Ticket in Extensis Preflight Pro,
just as with the job ticket for a print job handled the mechanical
way, includes such important information as: who to contact with
questions; due dates; pickup and delivery instructions; how the
files were received; additional items sent with the job, such as art-
boards; what media the job will be output to prior to printing, etc. 

This information can be entered by the author prior to sending the
job to the service bureau, by the service bureau staff prior to sending
the job to the production facility, or by a combination of sources.

The Job Ticket window consists of the following tabs:

• Contact—includes particulars about the client, including com-
pany name, primary contact, creator/author, and billing address.

• Order Info —includes job name and number, dates received
and due, information about the job, and billing information.

• Delivery—includes shipping address for completed job, along
with information on carrier type, ship method, and account
number if applicable.

• Media—includes information about the media on which the job
is supplied, such as the type of disk, and any additional materi-
als supplied, such as artboards, color proofs, etc. The output
media section of this tab allows you to indicate whether the job
will be output to film or RC paper, as a laser proof, as separa-
tions, etc.

• Instructions—allows you to enter text-based information perti-
nent to the job.

To create, edit, or view a Job Ticket:

1. Click the “Edit Job Ticket” button on the Job Jacket
button bar, or select “Job Ticket” from the Job menu,
or press zT.

2. Click the Job Ticket tab of your choice, then enter or
examine the desired information.

The Job Ticket
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The Job Ticket window displays tabs for
all the information that can be entered in
the Job Ticket.

A Job Ticket window

B Contact information tab

C Order Info tab

D Delivery information tab

E Input and output Media tab

F Instructions tab

The Contact tab contains information
about who is responsible for the job and
how to reach them.

G Enter Company Name 

H Enter Primary Contact information 

I Enter Creator/Author information 

J Enter Billing Address information 

Job Ticket and Content tab

B C

I

J

E F

G

H

A

D

The Order Info tab contains information
about the job order.

A The Order Info tab inside the Job
Ticket window

B Enter job numbers associated with
this job

C Enter job description information

D Enter billing information associated
with this job

E Enter order input contact information 

F Indicate Rush or Call When Ready

G Enter job date and time information

Order Info tab

B

C

E

FA G

D
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The Delivery tab contains information
about how the completed job will be
delivered back to the client.

A The Delivery tab inside the Job Ticket
window

B Enter Delivery information including:

¥ Customer Pickup
¥ Courier or Private Carrier pickup,

type of carrier, contact information, 
type of delivery, and account 
number  

C Enter the address where the job is to
be delivered

Delivery tab

The Media tab contains information about
both the input media and output media.

A The Media tab inside the Job Ticket
window

Input Media:

B Enter type of electronic media the job
was delivered to the shop on, such
as SyQuest, Zip, Jaz, Optical,
Internet

C Enter information about other media
delivered with the job, such as proofs
or artboards, and indicate whether
supplied images are For Placement
Only, to be replaced with high-resolu-
tion images

Output Media:

D Indicate whether cropping and regis-
tration marks are required, and
whether to output job in spreads 

E Enter information about proofs, if
proofs are required for this job

F Enter information about the media to
be output for this job, such as Film or
RC paper, and film specifics

Media tab

B

C

A

B

C

FA

D E
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Default Job Ticket

You can specify a default Job Ticket by selecting “Default Ticket”
from the Edit > Preferences menu. The information you specify
will become the Job Ticket for all new jobs created. You can then
edit the Job Ticket and make changes as appropriate.

The Instructions tab provides a place to
enter any special instructions for the job.

A The Instructions tab inside the Job
Ticket window

B Enter any special instructions that
apply to this job

Instructions tab

B

A
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The electronically generated Job Jacket in Extensis Preflight Pro,
just as with the job jacket for a print job handled the mechanical
way, includes everything associated with a particular job: the
documents included in the job, output instructions, job ticket
information, problem reports, special instructions, logs, and notes.
A Button Bar, located near the top of the window, provides access
to most Preflight Pro operations. Not all buttons are available at
all times—buttons that do not apply to the active tab will be
dimmed. In addition, the electronic Job Jacket in Preflight Pro
provides access to all the information that can be gathered about
the various job elements (fonts, pictures, colors) by document and
page, that must be checked to ensure that the job will output
properly. 

The first tab in the Job Jacket, the “Files” tab, is the primary
window within Extensis Preflight Pro. Icons for each document
keep you informed about overall document status, individual page
status, and show you which application created the document. 

The Job Jacket

The Job Jacket window is the primary
window in Preflight Pro. All job elements
that can be checked and flagged (such
as Pictures, Fonts, and Colors) are
available on tabs, and the Preflight Pro
operations Button Bar. The first tab in
this window, the Files tab, includes the
informative Files list of job documents.  

A Job Jacket title bar and ÒJobNameÓ

B Files tab

C Pictures tab

D Fonts tab

E Colors tab

F Log tab

G Notes tab 

H Button Bar: Provides easy access to
major Preflight Pro operations.
Button functions are dimmed when
the function is not available on the
active tab. See page 25.

I Help box: Displays each button, col-
umn heading, or icon function as the
mouse passes over it.

J “ Show onlyÓ check boxes: Click to
indicate which problem levels will be
displayed in the report. See page 31.

Job Jacket and Files tab

B C

I

E F G

H

A

J

D
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Button Bar

The Button Bar provides access to many operations within
Preflight Pro. As you pass the mouse over each button, refer to
the Help box in the bottom left of the screen for a short descrip-
tion of button function. Click the button to open up a dialog box
or window to complete the desired operation.

The Button Bar inside the Job Jacket
Files tab provides access to many fea-
tures. Click a button to activate it.

A Extensis: Access information about
Extensis Preflight Pro. 

B Add documents: Add documents to
the Files list.

C Remove documents: Remove docu-
ments from the Files list.

D Inspect: Inspect documents selected
in the Files list.

E Output Instructions: Open the
Output Instructions for viewing or
editing.

F Exclude pages: Exclude pages from
the report.

G Report: Report on the documents
selected in the Files list.

H Open: Open the documents selected
in the Files list in their parent
application.

I Job Ticket: Open Job Ticket for view-
ing or editing.

J Collect: Collect job elements.

K Export to PDF: Create PDF files (for
viewing and printing from Adobe
Acrobat) of the items selected on the
Files list.

Button Bar

B CA E FD IG H J K
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To do this… Follow this procedure…

Add documents to the job. Click the ÒAdd DocumentsÓ button, then locate the documents to 
be added. Or drag documents into the open Files window,
or select ÒAdd Document...Ó from the Job menu.

Remove documents from Select the document(s) to be removed from the Files list, then
the job. click the trash (Remove Documents) icon. Note: This action

removes the document reference from the list, it does not delete
the document from the disk. Or select the documents to be
removed, then select ÒRemove Document...Ó from the Job menu.

Inspect a document. In the Files list, select the document(s) to be inspected. Click the
ÒInspectÓ button. The documents will be scanned and processed. 
Completion time depends on document(s) size, processor
speed, image size, and other factors. Or select the document(s)
to be inspected, then select ÒInspectÓ from the Job menu.

Edit or view the Job Ticket. Click the ÒJob TicketÓ button. Or select ÒEdit Ticket...Ó from the
Job menu, or press zT.

Open a document in the parent Select the document(s) on the Files list and click the ÒOpen 
application. DocumentÓ button. Or select the document(s), then select

ÒOpen DocumentÓ from the Document menu.

Exclude pages from the Select the document, then click the ÒExclude PagesÓ 
problem report. button. Or double-click in the ÒSelectedÓ or ÒTotalÓ column of the

desired document. In the dialog box, click the page(s) to be 
excluded. No check mark beside the page number indicates 
that the page is Òexcluded.Ó Or select the document, then select
ÒExclude Pages...Ó from the Document menu.

Edit or view the Output Instructions Click the ÒOutput InstructionsÓ button. Or select ÒOutput
for a document. Instructions...Ó from the Document menu.

Generate a report of the problems Select the documents you wish to include in the problem report. 
in the document(s) that might Click the ÒReportÓ button. Or select ÒReport...Ó from the Document  
prevent proper output. menu, or press zR.

Collect all job elements. Click the ÒCollectÓ button. Or select ÒCollect ...Ó from the Job
menu, or press zK.

Create a PDF file for viewing or From the Files list, select the items for which you wish to create 
printing in Adobe Acrobat, or a separate PDF files, then click the ÒExport to PDFÓ button. 
PostScript file for output. Or select ÒExport to PDF...Ó from the Document menu.

Determine the function of a button Pass the mouse over the item. The item function will be  
or icon, or determine the page shown in the Help box in the bottom left corner of the 
number of a page icon. Job Jacket Files tab.
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Files tab

The Files tab in the Job Jacket is a primary window in Preflight
Pro. Here you will find the list of documents and graphics cur-
rently included in the job, pages included in the problem report,
page icons representing the overall status of each page, total
pages in the document, and the Profile assigned to the document.

The Files list shows all the documents, independent graphics, and
other files included in the job. This is a primary workspace for
preflighting job files. From the Files list you can see page status,
number of pages in the document, which pages are included for
problem checking, and which Profile is being used during for the
inspection and when generating the problem Report.  

For information on excluding pages, see “Excluding Pages from
Reports” on page 43.

To do this… Follow this procedure…

Display more detailed information Double-click in the Documents column of the selected
about the document. document.

Display more detailed information Double-click the page icon for the desired page of the selected
about a particular page. document.

Exclude pages from the Double-click in the ÒSelectedÓ or ÒTotalÓ column of the desired
problem report. document. Or select the document, then click the ÒExclude 

PagesÓ button. In the dialog box, click the page(s) to be 
excluded. No check mark beside the page number indicates that 
the page will be excluded from the report.

Assign a new Profile to the Select a Profile from the pop-up menu in the Profile column. To
document. create Profiles, select Configure > Profiles... from the menubar.
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The Files List in the Job Jacket shows
all the documents available for inspec-
tion. The columns can be resized as
needed: place the cursor on the edge of
a column and drag the column to the
desired size.

A Document Type icon: Provides a
quick visual indication of the docu-
ment type. When the column is
expanded, displays the Host (parent
application) name. 

B Document: Displays the name of the
file. Full pathnames can be specified
in Edit > Preference > General.

C Pages: Shows all document pages.
White page icon indicates page has
been included in the report, slashed
page icon indicates excluded from
the report. Red page icon indicates
problem(s) found: generating a
report for this page is recommended.

D Selected: Displays page numbers
included for inspection.

E Total: Indicates total number of
pages in the document.

F Profile: Indicates the currently
assigned Profile for this document.
Profile name is also a pop-up menu
for assigning Profiles.

G Document Info: Double-click in the
Icon or Documents column of the
selected document to open the ÒGet
InfoÓ window for this document.

H Document Status icon: Indicates the
overall status of the document (see
page 29).

I Page Status icon: Shows individual
page status (see page 29). Double-
click a Page icon for the selected doc-
ument to open the ÒGet InfoÓ window
for that page. When you pass the
mouse over a page icon, its page num-
ber is displayed in the Help box at the
bottom of the window.

J Exclude Pages: Double-click in the
Selected or Total column for the
selected document to open the
ÒExclude PagesÓ dialog.

K Profile pop-up: Click and hold to open
the Profiles pop-up menu, then select
a Profile from the list to assign it to
the document.

Files list

BA E FD

JG IH K

Files list

C
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Icon/Function Meaning Affected By

OK Document has no errors / cautions / ignores   Profile; Show Only checkboxes  

Error Document has errors Profile; Show Only checkboxes 

Caution Document has cautions Profile; Show Only checkboxes 

Ignore Document has ignores Profile; Show Only checkboxes 

Modified Document has been modified Document changes 

Missing Document disk file is missing File name change; File move

Document Status icons

Icon/Function Meaning Affected By

OK Page has no errors / cautions / ignores   Profile; Show Only checkboxes  

Error Page has error / caution /  ignore Profile; Show Only checkboxes 

Excluded Page is excluded from report Profile; Show Only checkboxes 

Page Status icons

Icon/Function Meaning Affected By

Unknown Document Creator/Type unknown  Applications available to system  

Type Document Creator/Type shown Applications available to system  

Document Type icons
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Document Info

The Document Info window gives pertinent information about the
selected document or file, such as name, location, creation and
modification date, parent application, page count, and size, and
dimensions. You can open this window by double-clicking in the
Type or Documents column of the selected document; by select-
ing a document in the Files list and then selecting “Get Info”
from the File menu; or by selecting a document in the Files list
and entering zI.

Double-clicking in the Status or
Documents column of the selected
document, or selecting a document in
the Files List and selecting ÒGet InfoÓ
from the File menu, or selecting a
document in the Files List and entering
zI, opens this window.

A Document Info window 

B Document name and location

C Document data:

Created date and time, Modified
date and time, Creator name, Type, 
number of Pages, document Height
and Width

D List of Document Items (job ele-
ments): Pictures, Fonts, and Colors

E Job elements listed by category
(Pictures, Fonts, Colors). Click
arrow to expand/condense list.

Document Info window

B

C

D

E

A



31

“Show Only” Checkboxes

The Show Only checkboxes allow you to filter the problem report
by problem severity. In the Profile you determine what problem
flag (representing problem severity) will be applied to each type
of problem, then, using the Show Only checkboxes, you deter-
mine which severity group(s) you would like to have reported.

The ÒShow OnlyÓ checkboxes inside the
Job Jacket Files window allow you to
determine which problem severity
group(s), will be reported.

Only problems in the severity group(s)
indicated by the Show Only checkboxes
will be reported, as follows: 

A Error checkbox: Indicates that
problems flagged as error will be
reported.

B Caution checkbox: Indicates that
problems flagged as caution will be
reported.

C Ignore checkbox: Indicates that
problems flagged as ignore will be
reported.

D White page icon: Indicates this page
has no problems in the severity
group(s) indicated by the ÒShow onlyÓ
severity flag checkboxes.

E Red page icon: Indicates this page
has at least one problem in at least
one of the severity groups indicated
by the ÒShow onlyÓ condition flag
checkboxes.

F Slashed page icon: Indicates this
page will be excluded from the
problem report. 

“Show Only” Checkboxes

A

D E F

B C
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Pictures Tab

The Pictures tab in the Job Jacket lists all the pictures in all inspect-
ed documents in the Job Jacket and indicates—for each occurrence
of the picture—where it is used, the type of picture, its status, and
other information. Picture status will be displayed as OK, missing,
or modified. The “Used In” column will show the filename of
Picture files shown on the document list of the Files tab. 

The Pictures tab in the Job Jacket lists
the pictures required to output the job
and displays their status. Includes pic-
tures from all included pages of inspect-
ed documents in the Files list.

A Pictures tab of the Job Jacket

B Name: Displays picture name.

C Used In: Lists where the picture is
used. Indicates if a graphic was
used in another picture. Graphics
files from the files list are shown
with their own name.

D Page: Lists the page number the
picture was found on.

E Type: Indicates the picture file type,
such as TIFF, EPS, PICT, DCS, etc.

F Eff Res: Effective picture resolution.

G Mode: Indicates the color mode of
the picture, such as RGB, CMYK,
bitmap, grayscale, etc.

H Status: Indicates the current status
of the picture: OK, missing, modified.

I Placement: Indicates whether the
picture is embedded in the docu-
ment or linked. 

Embedded: Graphic is embedded
in another documentÑa separate
disk file not needed to output the
job. If there is a problem with the
embedded image, the original file
may be needed for correction. 

Linked: Graphic is linked to another
documentÑthe graphic file is need-
ed to output the job. 

J Creator: Indicates the application
that created the picture.

Pictures tab

B E F

A

H JIGC D
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Double-clicking a picture, or selecting a
picture then choosing ÒGet InfoÓ from
the File menu or pressing zI, opens
this Picture Info window.

A Picture Info window

B Information gathered about a picture:

File Name, File Location, OPI
Location, Creation Date,
Modification Date, Picture Creator,
Document Used In, Document
Page, Picture Placement, Picture
Status, Picture Type, Picture Color
Mode, Picture File Size, PicBox
Origin Across, PicBox Origin Down,
PicBox Height, PicBox Width,
Picture Width, Picture Height,
Picture Scaled Vertical %, Picture
Scaled Horizontal %, Physical
Resolution, Effective Resolution
(after scaling), Background Color,
Picture Color, PicBox  Angle ¡,
PicBox Skew ¡, Picture Angle ¡,
Picture Skew ¡, Picture Flipped,
Picture Styled, Transfer Function,
Has Clipping Path, Flatness of Path 

C Items Used In picture: Colors used,
Fonts used (in vector EPS files).

D Thumbnail preview of original file, if
the file was saved with a thumbnail
preview.

Picture Info window

B

C

A
D
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Fonts Tab

The Fonts tab in the Job Jacket lists every font used in all the
inspected documents in the job which are needed to output those
documents, and indicates their status.

Status is determined by what fonts are currently available to the
System or located in a place you specify by selecting Configure >
Font Search Paths... from the menubar.See page 53.

The Fonts list is updated dynamically as font availability changes.

The Fonts tab lists fonts in the job and
displays their status. Includes fonts from
all included pages of inspected docu-
ments in the Job Files list. You can
specify search paths for fonts if job
fonts are available for output but you do
not want to make them active to the
system just for preflighting.

A Fonts tab in the Job Jacket

B Screen Font: Indicates the name of
the font.

C Style: Indicates the style applied to
the font, if selected from a style
menu.

D Printer Font: Indicates the required
printer font for the listed screen font.

E Type: Lists font type as TrueType,
PostScript, Multiple Master, etc.

F Font Status: Reports on availability
of both screen and printer fonts on
disk.

Active: Currently active in the System.
Located in the Fonts folder in the Sys-
tem folder, or opened by a font man-
agement utility such as Adobe Type
Manager Deluxe¨.

Available: Located in a Font Search
Path, but not active in the System.

Missing: Not active in the System and
not available in a Font Search Path.

G Foundry: Indicates the font manu-
facturer. Helps ensure that the out-
put facility owns the same font.

H Version: Indicates font version.

Fonts tab

A

G HFD EB C
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Double-clicking a font, or selecting a
font then choosing ÒGet InfoÓ from the
File menu, or pressing zI, opens this
Font Info window.

A Font Info window

B Screen Font Name and Location

C Printer Font Name and Location

D Information gathered about this font:

Styles Applied, Font Type, Font
Status, Foundry, Font ID, Font
Version

E Documents using this font         
Colors used with this font
Pictures using this font 

Font Info window

B

C

A

D

E
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Colors Tab

The Colors tab in the Job Jacket lists all the colors in all the
inspected documents in the job, indicates color name and type,
and shows a sample of the color. Colors listed may be used in
pictures and/or type. Both spot and process colors are listed. 

Colors listed as type “Printing Ink” are either one of the primary
printing colors (Cyan, Magenta, Yellow, Black) or a Spot color.
These are colors that will generate a separate plate when out-
putting separations.

The Colors tab in the Job Jacket lists
the colors in the job and displays their
type. Includes colors from all included
pages of inspected documents in the
Job Jacket Files list.

A Colors tab in the Job Jacket

B Color Sample: Shows a sample of
the indicated color.

C Name: Displays color name.

D Type: Indicates color type, such as
Printing Ink (Spot), Process.

E CMYK: Lists the QuarkXPress or
PageMaker CMYK equivalent values
for the color. 

F Screen Angle: Indicates the screen
angle that the color will be output as.

Colors tab

Double-clicking a color, or selecting a
color and choosing ÒGet InfoÓ from the
File menu opens this Color Info window. 

A Color Info window

B Color sample

C Information gathered about the color:

Color Name, Color Type (Process
or Printing Ink), Screen Angle,
CMYK values, RGB values, Hue ¡,
Saturation %, Brightness %

D Documents where color is used
Pictures where color is used
Fonts where color is used

Also lists what process colors use
each printing ink.

Color Info window

B

C
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D
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Log Tab

The Job Jacket Log lists some types of events that have occurred
with the job since the Job Jacket was created. Events logged
include the date and time documents were added, inspected, or
deleted. Unlike information in the Notes tab window, information
in the Log cannot be edited.

The Log tab inside the Job Jacket lists
everything that has happened to the job
since the Job Jacket was created.

A Log tab in the Job Jacket

B Date: Indicates the date when a
document was added to the Files
list, date when inspected, or date
when deleted from the Files list.

C Time: Indicates the time when a
document was added to the Job
Jacket Files List, time when
inspected, or time when deleted
from the Files List.

D Log: Indicates what action was
taken, and gives the name of the
document the action was taken on.

Log tab

B C
A

D
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Notes Tab

The Notes window provides a simple yet effective way to add
notes to the Job Jacket. Think of these Notes as sticky-notes for
the Job Jacket—a place to jot down information that can’t be
added anywhere else.

To create a Note:

1. Go to the Job Jacket Notes window by clicking the
“Notes” tab, then click “New Entry.”

2. Enter your name and the text of your note.

3. Click “OK.”

The Notes tab is a simple communica-
tion tool for adding information to the
Job Jacket. 

A Notes tab in the Job Jacket

B New Entry: Click to create a new note.

C Edit Entry: Click to edit the selected
note.

D Delete Entry: Click to delete the
selected note.

E Date: Indicates the date the note
was created or modified.

F Time: Indicates the time the note
was created or modified.

G Name: Indicates the name of the per-
son who created or edited the note.

H Notes: The text field for the note.

I Double-click the selected note to
open the Edit Entry window.

Notes tab

Double-clicking a note, or clicking the
New Entry or Edit Entry button in the
Notes tab of the Job Jacket opens
this window.

A New Note window

B Cancel: Click here to leave the note
unchanged.

C OK: Click here to indicate you are
finished editing the note.

D Name: Enter the name of the person
creating or editing the note here.

E Notes: Enter the text of the note
here.

New Note window

A
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Specifying Document Output Instructions

Each document in your print job will include specific output
instructions, such as trim size, inks, and line screen. This output
information must be entered into the job file so that Preflight Pro
can check it against the document. Information entered here is
used to calculate the number of printing inks used, find possible
resolution problems, and determine if the final trim size matches
the page size indicated in the document.

Printing Inks The total number of inks used in the document, to ensure that 
extra plates are not output.

Line Screen The resolution of each picture in the document. Preflight Pro 
determines whether resolution problems exist by using this setting
along with the resolution settings in the Profile assigned to the 
document. 

Trim Size The Page Size specified in the document. Note: Displays in
inches. Values entered in points, picas, mm, cm must include the
measurement name. Values other than inches will be converted 
and displayed in inches when the dialog box is reopened. 

When you specify… Preflight Pro compares your specification to…

The Output Instructions dialog allows
you to indicate how each document in
the job should be output. These values
will be checked against the values spec-
ified in the document.

A Output Instructions

B Printing Inks: Indicate CMYK and
Spot colors here.

C Line Screen: Indicate Screen in
Lines per Inch here.

D Trim Size: Indicate page Trim height
and width. Displays in inches. Enter
values in points, picas, mm, or cm.

E Cancel: Click here to close the
Output Instructions window without
making changes.

F OK: Click here to save changes and
close the Output Instructions win-
dow.

Output Instructions dialog

C

A

D

E

B

F

Working in the Job Jacket



40

To specify Output Instructions:

1. Go to the Job Jacket Files window by clicking the
“Files” tab, or press z1, then select the document for
which you wish to specify output instructions.

Note: You can apply the same output instructions to more
than one document. To do so, select all the documents
requiring the same output instructions from the Job Files
list before you open the Output Instructions window. The
Output Instructions dialog box will change, allowing you
to indicate which specifications to apply to the selected
documents. 

2. Click the Output Instructions button, or select “Output
Instructions” from the Document menu.

3. Enter your instructions.

4. Click “OK.”

Note: Changing the settings in the Output Instructions does
not change settings in the document.

Default Output Instructions

You can specify a Default Output Instruction that includes your
standard output information and is automatically applied to new
documents added to the Job Files list. You can then change the
instructions on those jobs that require it. To change the default
Output Instructions, select Edit > Preferences > Default Output
Instructions.
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Inspecting Documents

Inspecting a document causes Preflight Pro to gather all the
information from the document to determine what might prevent
it from outputting properly. Before a document can be inspected,
it must be added to the Job Jacket. Once in the Job Jacket,
documents can be inspected individually, all at once, or in any
combination.

Using the various tabs inside the Job Jacket window you can
examine information that was gathered during the inspection
regarding document parameters, fonts, pictures, and colors. 

Inspecting a document is the first step in determining possible
problems. Information gathered during the inspection is added to
the database of information in the job file. Without the inspection,
no information about the document is available for problem
reporting. 

After the inspection, Preflight Pro examines the data gathered
during the inspection, checks it against the problem conditions
specified in the Profile and Output Instructions, determines
whether problems exist, and displays an overall summary of the
results using the icons in the Page column of the Job Jacket
Files list.

If problems are reported by the icons, you can generate a detailed
Report. The Report lists each and every problem found (according
to the settings in the assigned Profile and the problem condition
flag checkboxes). You can limit your Report to just the offending
pages, if you wish, by using the Exclude Pages feature. See
“Problem Reporting and Correction” (page 63)for more infor-
mation on problem reports.

When the problems have been identified and corrected, the docu-
ment can be reinspected to verify that all the problems have been
corrected.

Tip

If youÕre preflighting a job that uses
low resolution OPI graphics,
Preflight Pro will not report on the
low-resolution data. Instead, it will
find the high-resolution graphic (if it
is available) and report on it. See
page 87 for more information on
preflighting with OPI graphics.
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Tip

Documents are not reinspected if
they have not been modified. If you
click the Inspect button and nothing
happens, it means that nothing has
changed since the last inspection.

To Inspect a document:

1. Go to the Job Jacket Files window by clicking the
“Files” tab, or press z1, then select the document(s)
you wish to inspect.

If the documents you wish to inspect do not appear on the
document list in the Files tab window, locate and drag
them into this window. Or click the “Add Documents” but-
ton and locate the document in the files list, or select “Add
Document...” from the Job menu.

Note: In the Files List, use the SHIFT key to select multiple
documents contiguously; use the z key to select multiple doc-
uments non-contiguously; use zA to select all documents.

2. Click the “Inspect” button, or select “Inspect” from the
Document menu.

For QuarkXPress and PageMaker documents, Preflight Pro
will launch the parent application, then open the specified
document(s) and gather all the information necessary for
preflighting; Preflight Pro does not need to open other
types of documents to inspect them. Preflight Pro keeps
you posted on it’s progress with a progress bar. When the
inspection is complete, Preflight Pro will close the docu-
ment(s), if they were closed prior to inspection.

Note: If a document was open prior to inspection by Preflight
Pro, Preflight Pro will leave it open after inspection. You can
instruct Preflight Pro to always leave documents open when
the inspection is complete. See “Parent Application
Preferences” on page 52.
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Excluding Pages from Reports

Extensis Preflight Pro allows you to quickly and easily exclude
document pages from the problem report. You might, for example,
be having problems with a particular page and wish to see a prob-
lem report on just this page as you work on correcting it. 

Or you might want to apply a different profile to certain pages of
a document. For example, you might be printing different pages of
a single document on different presses, perhaps because the four-
color cover has been included in the same document as the one-
color inside pages. In this case you would use the Exclude Pages
feature along with the Duplicate Document feature to apply differ-
ent Profiles and Output Instructions to selected pages.

To Exclude pages from a Report:

1. Go to the Job Jacket Files window by clicking the
“Files” tab, or press z1, then select the document for
which you wish to change page selections.

2. Click the “Exclude Pages” button, or double-click in
the “Selected” or “Total” column for the selected docu-
ment, or select Document > Exclude Pages....

This will bring up the Exclude Pages dialog. 

3. In the Include/Exclude dialog, click beside the desired
page(s) to toggle the checkmark(s) off or on. 

A checkmark next to the page indicates the page will be
included in the report. No checkmark indicates the page
will be excluded from the report.

Click “None” to exclude all pages from the problem report,
or click “All” to include all pages in the report.

4. The page icons for all excluded pages (on the Job Jacket
Files list ) will be shown with a slash through them, while
page icons for included pages are either white (indicating
no problem) or red (indicating problem(s) found). 

Note: When a page is “excluded,” all information associated
with that page and any job elements on it (unless they are
used elsewhere on an included page) are removed from both
the informational and problem reporting windows. This
includes the Report window, reports printed after the exclu-
sion is indicated, and the various job element windows such
as the Pictures, Fonts, and Colors tabs in the Job Jacket. The
information remains in the job file database however, and is
instantly available by changing the page designation from
“exclude” to “include.”Excluded Pages
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Duplicating Documents

Preflight Pro’s “Duplicate Document” feature is a very powerful
option that allows you to test different output scenarios for a doc-
ument by applying different Profiles and/or Output Instructions
and then checking for problems. This might be useful when you
need to output a document to both a medium resolution color
laser printer and a high resolution imagesetter. Using the
Duplicate Document feature you can generate a single report that
includes both output scenarios.

And used in conjunction with Preflight Pro’s “Include/Exclude
pages” feature, duplicating a document allows you to apply a dif-
ferent set of problem parameters for different pages of a docu-
ment. For example, a document might contain a 4-color cover
along with 1-color inside pages, requiring different Output
Instructions and posing a completely different set of potential
problems. To simplify your work, you can duplicate the document
and use different Profiles to check for problems. 

To Duplicate a document:

1. Go to the Job Jacket Files window by clicking the
“Files” tab, or press z1.

2. Select the document(s) to be duplicated.

3. Select “Duplicate Document” from the Job menu, or
press zD.

The original document will have “:1” appended to the file-
name, while the duplicated document will have “:2”
appended to the filename.
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Adding and Removing Documents

Documents can easily be added to or removed from the Job Jacket
Files List as the job changes. Note that when a document is added
to the Files List, it is automatically assigned the specified Default
Profile and the specified Default Output Instructions.

Note: Adding Documents to and Removing Documents from the
Job Jacket does not add files to or remove files from the disk.
Preflight Pro merely adds the name of the document to its list of
documents in the job, and uses a pointer to determine where these
documents are located. 

To Add a document to the Job Jacket:

1. Go to the Job Jacket Files tab window by clicking the
“Files” tab, or press z1.

2. From the Finder, locate the document(s) you wish to
add to the job, then drag them into the open Files tab
window.      

— or —
2. Click the “Add Documents” button in the button bar or

select Job > Add Documents... or press z=. 

3. Locate the document(s) you wish to add, then click “Add.”

This will add the document(s) to the “Choose documents to
add” list. If you have more documents to add to the job, use
the file/folder hierarchy to locate them, then select and
“Add” them to the document list. Newly added documents
are automatically assigned the Default Profile and Default
Output Instructions.To add all the documents in a folder at
the same time, click “Add All.”

4. When all documents to be added to the job are displayed
in the “Choose document to add” list, click “Done.”

Add Documents
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To Remove a document from the Job Jacket:

1. From the Job Jacket Files list, select the document(s) to
be removed.

2. Click the “Remove selected documents” button in the
button bar, or select “Remove Document...” from the
Job menu, or press z-. 

You will be presented with a dialog box that asks “Are you
sure you want to remove the selected documents?”

3. Click “Remove” to remove the selected documents from
the job. Click “Cancel” if you do not wish to remove the
documents.

Note: Removing a document from the Files List also removes
from the job file database all information about the document
that was gathered during the inspection.

Opening documents

With Preflight Pro’s “Open Document” command you can open
any document or file in the Job Jacket Files List without leaving
Preflight Pro. And the document doesn’t have to be a one that can
be inspected by Preflight Pro—any document can be added to the
Job Jacket regardless of which program created it.  

Notes: The application that created the document must be avail-
able to the Macintosh System before you can open it. And while
you can open a document created in another application, at this
time, only QuarkXPress documents can be inspected and checked
for possible output problems using Preflight Pro.

To Open a document from Preflight Pro:

Note: The document will be opened in the parent application.

1. Go to the Job Jacket Files window by clicking the
“Files” tab, or press z1.

2. Select the document you wish to open.

3. Click the Open Document button, or select “Open
Document” from the Document menu. 

Remove Selected Documents
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Exporting Job Information

Preflight Pro gives you the opportunity to export data collected by
the inspection into a text file that can be imported into another
application according to your needs.

Note that the exported text file is not the same as a printed prob-
lem report. Printed reports display problems found and other job
information, whereas the export file is a text file intended for
users who wish to import job information into a custom database
for their own purposes.

To Export Job Information:

1. Select “Export Job Info...” from the File menu.

2. Choose a name for the Job Info file, then choose loca-
tion to store it.

3. Click “Save.” This will export the job information to
the named text file in the location indicated in step 2.

Reveal in Finder

Preflight Pro can take you right to the disk location of a selected
job document or picture.

To locate a document’s disk file or a picture’s disk file:

1. Go to the Job Jacket Files tab or Pictures tab by click-
ing the appropriate tab, or press z1 or z2.

2. Select the document or picture you wish to locate.

3. Select “Reveal in Finder” from the Document menu.

Preflight Pro will switch to the Finder, open the folder con-
taining the located file, and highlight the file.
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Relinking Documents

Preflight Pro keeps track of files by name and location. If a docu-
ment is renamed or moved while the Preflight Pro Job file is
closed, it will be listed as missing when the job file is reopened.
The word “Missing” will be displayed in the Selected pages col-
umn, and the document list entry will be dimmed.

To Relink a document to the Job Jacket:

1. Select a document indicated as “Missing” from the Job
Jacket Files list.

2. Select “Relink...” from the Document menu.

You will be asked to locate the missing document.

3. Locate the document, then click “Open.”
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Using the Preferences settings in the Edit menu, you can specify
some default parameters for Preflight Pro such as prompting for
Output Instructions, specifying Default Job Ticket and Default
Output Instructions parameters, and parent application preferences.

General Preferences

From the General preferences you can elect to:
• Automatically prompt for Output Instructions each time a

document is added to the Job Jacket.
• Automatically Inspect documents when they are added to the

Job Jacket.
• Automatically generate and display the problem Report after a

document is Inspected.
• Automatically open the Pilot window when the Report window

is opened.
• Automatically add PDFs created with Preflight Pro to the Job

Jacket Files list.
• Analyze for problems only when a Report is generated, or

instead check for problems: each time that a Profile is created
or assigned, or when the Output Instructions are changed.

• Display the full pathname for documents in the Documents
column of the Job Jacket Files list.

• Disable the Export as PDF function if an Inspected document
contains errors (“error” flag set).

• Display document measurements in Points, Picas, Inches or
Millimeters.

To change the General preferences:

1. Select Preferences > General... from the Edit menu.

2. Indicate your desired options.

3. Click “OK” to save the selected options.

Preferences
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Default Ticket

Information entered into the Default Job Ticket will automatically
be applied to all new jobs after the Default Ticket has been
changed. 

Use the Default Ticket to enter job information that is consistent
from job to job to save data entry time, then change the Job
Ticket information as needed for each document. 

If no information is entered into the Default Job Ticket, the Job
Ticket for all documents will initially be blank.

To create or change the Default job Ticket:

1. Select Edit > Preferences > Default Ticket.

2. Enter the desired information.

Click through the tabs one at a time and enter the appropri-
ate information in each tab window. This information will
be assigned to each new document added to the Job Jacket
Files List, and to documents in all future jobs as they are
created.

3. Click “OK” to save Default Ticket information.
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Default Output Instructions

Information entered into the Default Output Instructions dialog
will automatically be applied to all documents added to existing
jobs after the Default Output Instructions have been changed. 

You might want to enter job information that is consistent from
job to job to save data entry time, then change the Output instruc-
tions specifications as needed for each document. 

To change the Default Output Instructions:

1. Select Edit > Preferences > Default Output Instructions.

2. Enter default output instruction information.

Enter the appropriate information by section: Printing Inks,
Line Screen, Trim Size. This information will be assigned
to each new document added to the Job Jacket Files list,
and to documents in all future jobs as they are created.

3. Click “OK” to save Default Output Instruction informa-
tion.
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Parent Application Preferences

Use the Application Preferences to specify whether to leave docu-
ments open in the application after inspection, and which copy of
the application to use for inspection and problem correction.
Preferences set here affect only PageMaker and QuarkXPress
documents, since these are the only document types that are
opened by Preflight Pro during inspection.

To set Preferences for the desired Parent Application:

1. Depending on which application you wish to set prefer-
ences for, select Edit > Preferences > PageMaker or
Edit > Preferences > QuarkXPress.

2. Enter the desired information.

To prevent Preflight Pro from closing the document when
the inspection is complete, click the box labeled “Leave
Inspected Document Open in <program>.” Note that the
application itself is always left open after an inspection.

To specify which copy of the application to use, click
“Specify,” then locate the appropriate copy.

For creating PDF files, Preflight Pro automatically selects
the Acrobat Distiller PPD. You can select a different driver
from the “Make PDF PPD file” pop-up. Preflight Pro looks
for PPDs in Extensions: Printer Descriptions and in the
PDF folder in the QuarkXPress folder.

3. Click “OK” to save the new Preference settings.

Tip

Preflight Pro will always inspect
QuarkXPress documents using the
same version of the application in
which the document was saved
(either 3.3 or 4.0).
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Font Search Paths

The Font Search Paths preference allows you to specify one or
more locations for Preflight Pro to check when determining
whether fonts listed in the document are available. Ordinarily a
font search would include only those fonts available to the system
(such as those in the System Fonts folder or opened by a font util-
ity), thus forcing you to open all the necessary font suitcases
before preflighting can be completed. 

Through Font Search Paths, Preflight Pro offers you the ability to
inspect “unopened” font suitcases, allowing you to preflight the
job without actually installing the fonts needed for the job. For
example, a service bureau or output facility might want to pre-
flight jobs right from the Collection, without opening the includ-
ed fonts in the System. By setting up one or more Font Search
Paths, you can preflight your jobs using the fonts included on the
removable media containing the job, without ever opening those
fonts to the system. 

Preflight Pro searches for fonts in the order in which they appear
on the Font Search list. You can temporarily disable a path with-
out deleting it. Two search paths <Job’s Folder> and <Document
Folder> are permanently installed on the list, and indicate that
Preflight Pro will (if these paths are enabled) look for missing
fonts first in the Job Folder, if the Preflight Pro Job has been
saved, then in a “Fonts” folder in the same folder as the document
being inspected. 
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To specify or change a Font Search Path:

1. Select Configure > Font Search Paths... or press zF.

2. Drag and drop your font folder(s) onto the list in the
Font Search Paths Setup dialog, or click “Add” or
“Change” and locate the font folders you wish to
include in the search path.

3. Click “Done” to save the new search paths.

To remove a Font Search Path from the current search without
removing it from the list, click the “ü” column. No checkmark
indicates that the folder will not be included in the search path.

Note: The default Font Search Paths labeled “<Job’s Folder>”
and “<Document’s Folder>” allow you  to search for fonts in the
Job folder and/or in the folder where the document is located.
These folders cannot be removed from the list.
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Preflight Pro gathers an enormous amount of data and checks a
large number of conditions for problems. Profiles allow you to orga-
nize this information so that it is meaningful for each job. Using
Profiles, you specify which problems you consider important, set
their severity (so you can separate “job stoppers”—problems that
would keep the job from outputting, from non-essential problems—
conditions that might not be considered good housekeeping in a
document, but won’t prevent it from outputting). You can even set
your own threshold for some problem conditions. There are separate
Profiles for each program type: Image profiles (for files created in
FreeHand, Illustrator, and Photoshop), and profiles for PageMaker,
QuarkXPress, and Multi-Ad Creator2 documents.

Profiles

The Profile configuration dialog displays
tabs representing the different problem
categories for each document type.
Listed on each category tab are all the
possible items that can be flagged and
reported as problems in the indicated
category. Severity, as indicated in the
problem Report, is determined by which
condition flag is set here: Error, Caution,
or Ignore.

A Profile Name title bar

B Document category tab

C Fonts category tab

D Pictures/Graphics category tab

E Colors category tab

F Trapping category tab

Problem severity flags:

G Error: Select the Error flag to indicate
that a problem found with this item
should be flagged as Òerror.Ó 

H Caution: Select the Caution flag to
indicate that a problem found with this
item should be flagged as Òcaution.Ó 

I Ignore: Select the Ignore flag to indi-
cate that a problem found with this
item should be flagged as Òignore.Ó

J Help box: Displays a detailed
description of the profile item as the
mouse passes over the item.

K Cancel: Click here to close the
Profile without making any changes.

L Save: Click here to Save the current
Profile settings and close the Profile.

M Grow box: Drag to reduce or enlarge.

Profiles dialog box

B C D E
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What Is a Profile and Why Do I Need One?

When a document is “inspected,” all of the information which is
available about the document is gathered. This information is
stored in a database of information inside the Preflight Pro job
file. Some of this information can be viewed inside the Job Jacket
window using the Pictures, Fonts, and Colors tabs. (Even more
detailed information is available by double-clicking an item listed
in any of these three tabs). This information by itself, while very
useful and valuable, is just information. You could view each
piece of the collected data (which you may want to do for other
reasons), but doing so would be a cumbersome way to determine
whether the conditions have been met which will allow the docu-
ment to output properly. That’s where Profiles come in.

Profiles act like filters for problem conditions, allowing you to
determine what conditions constitute a problem, and what impor-
tance that problem will be given when it is reported. Profiles are
specified by you. They don’t affect what information is gathered—
all available information is gathered for all pages of every document
selected for inspection. By configuring a Profile and assigning it to a
document, you tell Preflight Pro what the information gathered dur-
ing the inspection means to you in relationship to outputting the
job; that is, what conditions you to consider to be a problem, and
how serious an issue you consider each problem to be. 

There are four different Profile types, one for each type of document
that can be preflighted by Preflight Pro: Image profiles (for
FreeHand, Illustrator, and Photoshop documents), plus Multi-Ad
Creator2, PageMaker, and QuarkXPress profiles. Each Profile
type lists potential problems particular to the type of document
that it will be used to analyze.

When Does Preflight Pro Look at the Profile?

Unless you specify otherwise (in Edit > Preferences > General),
Preflight Pro looks at the Profile after the document has been
inspected; when a Profile is assigned; when the Output
Instructions are edited; and when a problem Report is generated.
Information gathered during the inspection is compared with
baseline data from the Profile and the Output Instructions to deter-
mine whether a problem condition exists. 

After an inspection, when the Job Jacket Files window appears,
you can select a different Profile from the Profile pop-up, and the
icons in the Page column will reflect whether or not problems

Important

After you configure a Profile, you
must assign it to a document. If
you do not, Preflight Pro will not
use that Profile when analyzing the
document for problems.

Profile icon



were found based on the new Profile. To view the specific prob-
lems found on each page you must generate a Report.

When a Report is generated, any problems found will be reported
as one of the three problem conditions (error, caution, ignore) that
you specified in the Profile assigned to the document. If no prob-
lem was found for a given Profile item, the item will not be dis-
played in the Report at all. 

Since all available information is gathered when the document is
inspected, you can reassign Profiles on the fly, and Preflight Pro
will respond by quickly generating a new Report based on the
new Profile. This allows you, for example, to test the document
for laser proofs using a more generous outline of problem condi-
tions, then quickly re-check the document with a more stringent
set of conditions appropriate for outputting to a specific RIP. 

Refer to “Configuring Profiles” starting on page 59, and
Appendix A and B for information on Profile items and options.

To create a New Profile:

1. Select “Profiles...” from the Configure menu.

2. Click “New,” or select a Profile similar to the one you
wish to configure and click “Duplicate.”

3. If you clicked “New,” select a Profile type from the
“Host” pop-up list.

Select the Profile type that matches the type of document
you will be analyzing with the new Profile.

4. In the “Name” box, enter a name for the new or dupli-
cated Profile.
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Important

After you create a Profile, donÕt for-
get to assign it to the appropriate
document(s) using the pop-up in the
Profile column of the Job Jacket
Files list. If you donÕt assign the
Profile to the document it wonÕt be
used during file analysis. See page
61 for more information on assign-
ing Profiles.
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To Rename a Profile:

1. Select “Configure Profiles” from the Profile menu.

2. Select the profile you wish to rename, then click
“Rename.”

You will be presented with a dialog box allowing you to
change the name of the profile.

3. Enter the new name, then click “OK.”

4. Click “Done” to return to the Job Jacket.

To Delete a Profile:

Note: When you delete a Profile that has been assigned to a docu-
ment (as shown on the Job Jacket Files list), the Default Profile
for the document’s parent application is automatically assigned
to the document—see “Default Profiles,” below.

1. Select “Configure Profiles” from the Profile menu.

2. Select the profile(s) you wish to delete, then click
“Delete.”

3. Click “Delete”to delete the selected profile(s), or click
“Cancel” to return to the Configure Profiles dialog
without deleting any profiles. Click “Done” to close the
Configure Profile dialog and return to the Job Jacket.

Default Profiles

Every document that can be preflighted with Preflight Pro will
have a Profile assigned to it. When you add a document to the Job
Jacket, the “Default” Profile for that document type (Graphics,
Multi-Ad Creator2, PageMaker, QuarkXPress) is automatically
assigned. Unless you specifically assign a different profile to your
documents, the Default Profile for that document type will be
used. You can designate a different Default Profile for each docu-
ment type.

To designate a new Default Profile:

1. Select “Profiles...” from the Configure menu.

2. Select the profile you wish to make the Default, then
click “Make Default.”

The word “Default” will be moved from the profile previ-
ously indicated as the Default, and displayed in the Default
column next to the newly assigned Default profile 

3. Click “Done” to close the Configure Profile dialog and
return to the Job Jacket.
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Configuring Profiles

Problem severity flags
There are three levels of importance or severity you can set for
each problem condition in a Profile: “error,” “caution,” or
“ignore.” Each of the three levels has an icon associated with it,
so that when the problem report is generated, you can see just
how serious (according to your specifications) each problem is. 

You can use the “error” “caution” and “ignore” (“Show only”)
checkboxes near the top of the Consolidated Report window to
quickly expand or contract the problem list. This allows you to

concentrate, say, on just the “error” conditions, or view
both the “errors” and “cautions,” or to quickly view all of
the problems no matter how insignificant they may be.

Note: Problem conditions set with the “ignore” flag are
not really ignored. All problems in the document will be
located and a flag assigned. However, using the “error”
“caution” and “ignore” checkboxes you can limit your
view so that “ignore” conditions are not shown in the
Report list, and do not affect the overall status of the docu-
ment. See “The Job Jacket” (page 31), and Preflight Pro
Tutorial (page 122)  for more information on problem

severity flag (“Show Only”) checkboxes.

You can use the “error” “caution” and “ignore” checkboxes near
the top of the Job Jacket win-
dow to see which document
pages contain problems. The

page icons will show the color associated with the highest level of
problem found, as follows (see also page 29): a Redpage icon
signifies one or more problems were found; a Whiteicon indicates
that no problems were found; a Slash through the page icon indi-
cates that the indicated page was excluded from the report.

To Edit a Profile:

1. Select “Profile...” from the Configure menu.

2. Select the Profile you wish to change, then click “Edit.”

This will open the Profile options for the selected Profile.
The Profile is automatically opened for editing when you
click “New” or “Duplicate.”

3. Select each Profile tab (tabs will differ for each parent
application, for example: Document, Fonts,

Problem severity flags

Tip

You can quickly identify which page
number contains the error by pass-
ing the mouse over the page icon
on the Job Jacket Files list while
looking at the help box at the bot-
tom left corner of the window.
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Graphics/Pictures, Colors, Trapping, etc.) in turn and
indicate, for each item on each tab, the severity of the
condition to be reported. Enter any additional problem
parameters required for profile items where indicated.

See Appendix A (page 134)for specific information about
each of the problem elements contained on each tab of the
different parent application profiles and what they test. See
Appendix B (page 159) for a listing of Profile items and
their associated error message.

If you don’t consider a profile item a problem, it’s wise to
use the “ignore” severity flag. While the item won’t really
be ignored, you’ll be able to easily limit the report by
excluding items flagged as “ignore.”
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Assigning a Profile to a Document

After a Profile is configured, it must be assigned to a document
before it can be used in problem analysis.

To assign a Profile to a document:

1. From the Job Jacket Files tab, select the document you
wish to assign the Profile to.

2. In the Profile column for the selected document, select
the desired Profile from the Profiles pop-up menu.

Highlight the profile then release the mouse to select it.

Note: Only Profile types matching the selected document
type (Graphic, Creator2, PageMaker, or QuarkXPress)
will be displayed in the Profile pop-up menu.

Where to Place Profiles

Profiles must be located in the Profiles Folder located in the same
folder as the Extensis Preflight Pro application (or alternately, in
the Profiles folder located with the Job file—see page 62), to be
available for your job. Profiles are placed here automatically when
they are created. However, if a document has been assigned a
Profile that has been deleted or moved, the Profile for that docu-
ment will become the Default profile for that document type.

Note: Profiles are gathered along with other job elements when a
job is “collected” (unless you specify otherwise in the Collection
options dialog box). These profiles can then be sent to the service
provider, if necessary, when the job is ready for output. See
“Collecting Job Elements” (page 87) for more details.

¥



Sharing Profiles

You can easily share profiles, for example between clients and
service providers, or between work groups, simply by copying
and sending them.

Note: Preflight Pro automatically gathers all the Profiles assigned
to documents in the job when you use the “Collect Job Elements”
function. You can even have Preflight Pro add unused Profiles to
the collection, if desired. For more information on the job
collection feature, refer to “Collecting Job Elements” starting on
page 87.

To share a Profile with another Preflight Pro user:

To automatically gather Profiles with other job elements, refer to
“Collecting Job Elements” on page 87.

1. Make a copy of the Profile(s) you wish to share.

2. On the receiving end, place the Profile(s) in one of these
locations:

• Inside the “Preflight Pro Profiles” folder located
inside the Preflight Pro application folder. 

— or — 

• Inside the ~ Job Profiles folder located in the Job
Folder for each job where the Profile(s) will be used.

On the Profiles pop-up menu on the Job Jacket Files list,
Profiles available in the Preflight Pro Profiles folder are
listed above the line; Profiles available in the ~Job Profiles
folder in the Collection are listed below the line.

62
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After documents have been Inspected, Preflight Pro compares the
information gathered in the Inspection against the settings in the
assigned Profile, and against the data entered in the Output
Instructions. Any problems that are found are listed in the “Con-
solidated Report.” This Report window appears automatically
when the Inspection is complete, unless you specify otherwise in
Edit > Profiles > General. From the Report window you can
examine all the problems that were found, or you can limit the list
in any number of ways to make the information most meaningful
to you. 

Preflight Pro’s report feature is extremely flexible. Since all docu-
ment data is collected when the document is inspected, reports
can be modified and changed “on-the-fly,” assigning different
profiles, including and excluding documents and pages, limiting
and expanding the problem levels displayed, and limiting and
expanding the document and problem lists. You can inspect all the

Problem Reporting and Correction

The Report window lists the documents
and pages included in the report, and
displays problems found on those
pages. Problems are displayed accord-
ing to settings in the Profile assigned to
each document and the problem severi-
ty flag checkboxes.

A Title of Report: Shows job being
reported on.

B Job Jacket button: Click here to
return to the Job Jacket Files tab
window.

C Open Pilot button: Click here to open
the Pilot palette which can take you
directly to the location of the select-
ed problem.

D Report On: Lists documents and
pages selected for reporting.

E Consolidated Report: Displays found
problems. Problems are grouped
by Profile category and item.

F Problem severity flag or ÒShow onlyÓ
checkboxes: Click here to indicate
which problem level(s) to display in
the report.

G More Info: Gives a detailed descrip-
tion of the selected problem, and
suggests solutions.

The Report window

C E

G

D

A

FB
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documents at one time, then create whatever reports you need, as
you need them, to view and correct the problems.

Problems listed on the Report are organized in the same way that
Profile items are organized: by Profile category (Document,
Fonts, Graphics/Pictures, Colors, and Trapping) according to the
particular type of document being analyzed (Graphic, Creator2,
PageMaker, or QuarkXPress). Only documents that have been
inspected will be shown on the list. 

If problems listed in the report can be corrected from inside the
document, you can use Preflight Pro’s convenient Pilot feature to
go to the problems and correct them. For Graphic files and
Creator2 documents, clicking “Show” on the Pilot palette will
open the indicated document in the parent application. For
PageMaker and QuarkXPress documents, clicking “Show” will
take you directly to the problem in the document. Using the
navigational arrows on the Pilot you can work your way through
the list, correcting each problem in turn before returning to
Preflight Pro.

You can also Print the Consolidated Report (with the Report win-
dow open, select File > Print, or press zP). The printout will
include only the information visible in the on-screen report (for
the full length of the scroll bar), so be sure to set up the on-screen
display to show just the items you want to see in the printed
report before you print. You can include or exclude information
using the checkmarks in the Report On area, the Show Only
checkboxes at the top of the window, and the twisty arrows in the
Consolidated Report area. 
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To generate a Report:

1. In the Job Jacket Files tab, select the document(s) you
wish to generate a Report for.

Note: Documents must be inspected before a problem
report can be generated for them.

2. Verify that the assigned Profile is correct, or assign a
new Profile.

Using the Profile pop-up menu, select a Profile. The pop-
up list will only display Profiles that apply to the selected
document’s host (parent application). To view, edit, or cre-
ate additional Profiles, select “Edit Profile” from the
Profile menu. See “Profiles”(page 55).

3. Optional: Indicate which, if any, pages you wish to
exclude from the report.

Click the “Exclude Pages” button, or select “Exclude
Pages...” from the Job menu. No check mark indicates that
the page will be excluded from the Report.

4. Indicate which problem condition(s) you wish to view in
the report.

Use the problem severity checkboxes to indicate which prob-
lem levels you wish to show on the report. These check-
boxes also appear in the Report window. Refer to “Pro-
files”(page 55) for more information on problem flags.

5. Click the “Report Selected Documents” button. Or select
“Report...” from the Document menu, or press zR.

The Report window will appear, indicating which docu-
ments and pages are included in the report, and displaying
all problems found, according to the settings of the condi-
tion flag checkboxes at the top of the Job Jacket and
Report windows.
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The Report On field lists all documents
in the job that have been inspected and
indicates which documents and pages
are included in the report. Allows you to
quickly select documents and pages to
include or exclude.

A Job name

B Document Name and Icon: Names
displayed in red have been modified
and should be reinspected.

C Page List: Every included page of
every inspected document selected
from the Job Jacket Files list is dis-
played here. 

D Expand: Click here to expand or
contract the page list for the
document.

E Exclude Page column: A check in
this column indicates that the docu-
ment or page is included in the cur-
rent report. No check indicates that
the document or page is not includ-
ed in the current report. An orange
check beside the job name or docu-
ment name indicates that at least
one page in the job or document is
excluded from the report.

F Job/Document Status: Orange check
indicates that at least one document
or page in the overall job or docu-
ment is excluded from the report.

G Page Status: Click here to quickly
include or exclude a document or
page from the current report. Check
indicates include; no check indicates
exclude.

Report Window —Report On list

A

G

E

F
B

D

C
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The Consolidated Report field displays
found problems. Problems are grouped
by Profile section and item. Problems
listed here are determined by the set-
tings in the Profile assigned to each
document, the Output Instructions, and
the problem severity checkboxes.

A Problem Severity (ÒShow onlyÓ)
Checkboxes: Click box to add or
delete problem levels from the report.
See page 59 for more information.

B First Only: Condenses the problem
list to display only the first occur-
rence of a problem. Many problems
can be solved by fixing the first
occurrence and then allowing the
application to resolve the other
problems. For example, if you fix the
first occurrence of an RGB color
mode graphic, all the other occur-
rences will be fixed as well.

C Profile Sections: Click arrow to
expand or condense the list.

D Problem Item (from Profile): Click
arrow to expand/condense occur-
rence list for this problem.

E Problems: Every occurrence of each
problem is listed (unless Òfirst onlyÓ is
checked). Includes the document
where problem occurs. Icon indicates
severity as set in assigned Profile.

F More Info: Displays a detailed
description of the problem currently
selected in the Consolidated Report.

Report Window —Consolidated Report

C

D

F
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To open a detailed information window about a problem:

Note: Applies only to document, font, color, and picture/graphic
problems. 

1. In the Consolidated Report problem list, double-click
the problem item you wish to view in more detail.

The detailed information window for the selected problem
will be displayed. 

Analyze

Note: Applies only if the option “Only Analyze when Building
Report” is selected in Edit > Preferences > General. 

This function, available from the Document menu, allows you to
request that the Page icons in the document list of the Job Jacket
Files tab be updated immediately, without generating a Report. 

When “Only Analyze when Building Report” is selected in Edit >
Preferences > General, document data is only analyzed when a
Report is generated. With this preference set, the status of the
page icons in the Job Jacket may not be accurate after the Output
Instructions are changed or when a Profile is reassigned. When a
Report is generated, the analysis takes place, and the Job Jacket
page icons are updated to show the new status. Selecting
“Analyze” allows you to update without requesting a Report.

68
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Printed Reports and Information

Preflight Pro provides printed job data in four types of reports: the
Consolidated Report, the Job Ticket printout, the Job Inventory
Report, and the Collection Report.

Consolidated Report—The printed Consolidated Report shows the
same information as given in the Consolidated Report window, such
as date of time of the Report, Job name, documents included, and
each problem found listed by document and page. Before printing this
report, you can use the checkmarks in the Report On list, and the
“Show only” checkboxes and twisty arrows in the on-screen Report
window to condense or expand the report to include just the informa-
tion you wish to capture on paper. By clicking the “first only” check-
box you can have only the first occurrence of some problems reported.

Job Ticket Printout—You can print out all information contained in
the Job Ticket by opening to any tab in the Job Ticket (zT) and
selecting the Print command. The printout will include information
from all the Job Ticket tabs: Contact, Order Info, Delivery, Media, and
Instructions.

Job Inventory Report—This report lists most of the information
gathered and entered about the job: Job Ticket information, infor-
mation about all the documents included in the job; data gathered
during document inspection about Graphics/Pictures, Fonts, and
Colors in the job.

Collection Report—The printed Collection Report lists the items
gathered in the collection. This report can only be generated when the
collection is gathered. In the Collection Setup dialog you can instruct
Preflight Pro to print the report when the collection process is com-
plete, or to save the report for printing at a later time, or both. The
saved report will be included with the other job files in the collection.  
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To print a Consolidated Report:

1. Prepare a Report as indicated under “To generate a
Report” on page 65.

Use the include/exclude pages checkmarks in the Report
On field of the Report window, along with the “Show only”
checkboxes and twisty arrows in the Consolidated Report
field, to condense or expand the report to include just the
information you wish to capture in the printed report.

2. Select “Print” from the File menu, or enter zP.

To print Job Ticket information:

1. Open the Job Ticket to any tab: Click the Job Ticket
button, or select Job > Job Ticket, or enter zT.

2. Select “Print” from the File menu, or enter zP.

You can print Job Ticket information from any tab in the
Job Ticket dialog box. The printout will contain informa-
tion from all tabs and fields on the Job Ticket. 

To print a Job Inventory Report:

1. If the Job Jacket is not the front window, bring it to the
front by clicking in it, or click the “Job Jacket” b utton
on the Report window. Select the Files tab.

2. Select “Print” from the File menu, or enter zP.

To print or save a Collection Report:

1. Initiate a Collection by clicking  the “Collect Job
Elements” button. Or select Job > Collect..., or enter
zK.

2. In the General field of the Collection Setup dialog box,
select “Save Collection Report,” “Print Collection
Report,” or both.   
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If you elected to Save the report, the report will automatically
be included in the Collection.

If you elected to Print the report, it will be printed to the cur-
rently active printer when the collection process is complete.

3. When you have entered all appropriate collection para-
meters click “Next.”

4. Click “Collect” to begin collecting the job.   

Tip

You can save the Report as a
PDF file by choosing to print to
disk, then distilling the resulting
Postscript file. Or you can select
PDFWriter in the Chooser before
starting the collection process, if
you have this driver installed.

The Collection Report printout includes
certain Job Ticket information, such as
Contact, Billing, and Output details, plus
a listing of all the items gathered in the
collection. This report can be printed
automatically when the collection
process has completed, and/or saved
for later printing.

A Job and Report Name: Displays
type of report and job name. 

B Job Ticket Data: Displays important
job information from the Job Ticket,
such as Contact, Billing, and job
Output details.

C Collection Data: Lists all the items
gathered in the collection.

D Report Statistics: Displays Job
Name, Date and Time report was
generated, and Page count.

Collection Report

D

B

C

A
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The Consolidated Report printout is
nearly an exact reproduction of the
Consolidated Report area of the on-
screen Report window: whatever infor-
mation shows in the window will be
printed in this report.

A Job and Report Name: Displays
type of report and job name. 

B Documents: Lists documents report-
ed on by name and icon. Also dis-
plays page count by document and
the Profile used in the analysis.

C Profile Sections and Problem Items:
Displays information identical to that
listed on the on-screen Consolidat-
ed Report at the time the Report
was printed.

D Report Statistics: Displays Job
Name, Date and Time report was
generated, and Page count.

Consolidated Report printout

B

C

A

The Job Ticket printout lists all the infor-
mation on all the tabs of the Job Ticket.

A Job and Report Name: Displays
type of report and job name. 

B Job Ticket Data: Each highlighted
field represents one of the Job
Ticket information fields. All infor-
mation from every tab in the Job
Ticket is included in the printout.

C Report statistics: Displays Job
Name, Date and Time report was
generated, and Page count.

Job Ticket printout

C

B

A

D
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Navigating Problem Lists with the Pilot

With the Report function in Preflight Pro you can easily locate
problems or potential problems in outputting your job. With
Preflight Pro’s Pilot, you can open your document right from the
Report window in Preflight Pro  and determine whether the indi-
cated problem must be corrected. If the problem can be corrected
from within a PageMaker or QuarkXPress document, you can use
the Pilot to go directly to each problem in turn and make the
appropriate correction immediately. 

The Pilot floating palette is active in all windows, so after check-
ing an item or making a correction in one document, you can go
back to Preflight Pro, or you can navigate through the problem list
to other documents, moving back and forth between documents
and programs with the problem list always at your fingertips. 

The Preflight Pro Pilot is a floating
palette that stays active in all windows.
It provides buttons for navigating
through the problem list without
returning to Preflight Pro. 

Navigation and selection area:

A Section Info and Navigation: Indicates
the problem item Section (from the
Profile) of the currently displayed
problem, plus the number of Sections
reporting problems. Click the arrows
to move back and forth through the
problem Sections in the report.

B Item Info and Navigation: Displays
the number of problem Items for the
indicated section; the number of the
current problem relative to total
problems in the Section; and the
total number of problems in the cur-
rent report. Click the arrows to move
through the problem Item list.

Problem detail area:

C Icon and Document Name: Indicates
which document indicated problem
was found in.

D Problem Severity Indicator and
Problem Item Description: From the
Consolidated Report.

E Problem Detail: Explains the prob-
lem in more detail, and suggests
possible solutions.

The Pilot palette

G

FA

B

C

D

E

F Preflight Pro button: Click here to return to Preflight Pro. 

G Show/Next button: Click here to go to the currently selected problem in the
document (opens the application and the document, if they are not already
open). If it is a PageMaker or QuarkXPress document, it goes directly to the
currently displayed problem, or goes to the next occurrence of the problem.

Tip

The Pilot is a system floating
palette which will always be in
the foreground. To close it, click
the close box on the palette, or
close the Report window in
Preflight Pro.
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To go to a problem in a document:

1. From the Consolidated Report window, select the prob-
lem you wish to go to.

Highlight the problem or section you wish to examine or
correct.

2. Click “Open Pilot.”

The Pilot palette will open to the problem selected in step 1.
If a section was selected, the Pilot will open to the first
problem indicated for that section.

3. Click “Show.”

Preflight Pro will open the application and document (if
they are not already open) where the selected problem is
found. If the problem resides in a PageMaker or
QuarkXPress document, the Pilot will move directly to the
indicated problem. You can then examine or correct the
problem, use the navigational arrows to go to the next
problem, or return to Preflight Pro using the “Preflight
Pro” button.
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To return to Preflight Pro from the document:

1. Click the “Preflight Pro” button on the Pilot. Or select
“Preflight Pro” from the Utilities menu in QuarkXPress
or from Utilities > Plug-ins in PageMaker.

You will be returned to Preflight Pro.

To go to a different problem:

1. On the Pilot palette, click the left and right navigational
arrows (indicating the Section and Item listings) until
the problem you wish to examine is listed in the prob-
lem detail area of the palette.

2. Click “Show.”

Preflight Pro will open the application and document (if
they are not already open) where the displayed problem is
found. If the problem resides in a PageMaker or
QuarkXPress document, the Pilot will move directly to the
indicated problem.

— or —

1. From the Report window in Preflight Pro, select a dif-
ferent problem from the problem list.

2. Click “Open Pilot.”

3. Click “Show.”

Preflight Pro will open the application and document (if
they are not already open) where the selected problem is
found. If the problem resides in a PageMaker or
QuarkXPress document, the Pilot will move directly to the
indicated problem.
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Working in QuarkXPress and PageMaker

Using Preflight Pro’s floating Pilot palette, you can make correc-
tions to problems inside QuarkXPress and PageMaker documents,
then walk through the problem list to the next occurrence of a
problem, or even go to a problem in another document. 

When you press the “Show” button on the Pilot palette, Preflight
Pro launches the document (if it is not already open) and takes
you to the problem. When you want to return to Preflight Pro
from your document, click the “Preflight Pro” button. But even if
the Pilot palette is closed, you can access Preflight Pro right from
your document. And you can open existing preflight jobs, or cre-
ate new jobs without leaving the parent application. 

To open Preflight Pro from QuarkXPress:

1. Select Utilities > Preflight Pro > Preflight Pro.

If Preflight Pro is already open, it will be brought to the
front as the active window.

If Preflight Pro is not open, it will be launched and a new
Job Jacket will be created.

To open Preflight Pro from PageMaker:

1. Select Utilities > Plug-ins > Preflight Pro.

If Preflight Pro is already open, it will be brought to the
front as the active window.

If Preflight Pro is not open, it will be launched and a new
Job Jacket will be created.

To create a new job and add the current document to it:

1. Select Utilities > Preflight Pro >  Add to New Job from
QuarkXPress, or Utilities > Plug-ins > Add to New Job
from PageMaker.

If Preflight Pro is already open, it will be brought to the
front as the active window, a new Job Jacket will be
opened, and the current document will be added to the doc-
ument list.

If Preflight Pro is not open, it will be launched, a new Job
Jacket will be created, and the current document will be
added to the document list.

QuarkXPress 4.0

QuarkXPress 3.3

PageMaker
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To add the current document to an existing job:

1. Select Utilities > Preflight Pro >  Add to Existing Job
from QuarkXPress, or Utilities > Plug-ins > Add to
Existing Job from PageMaker.

If Preflight Pro is open, it will be brought to the front as
the active window, and the current document will be added
to the open Job Jacket.

If Preflight Pro is not open, it will be launched, a new Job
Jacket will be created, and the current document will be
added to the document list (since no job was specified, this
has the result as selecting Add New Job).
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Preflight Pro allows you to create Adobe Acrobat PDF files from
PageMaker and QuarkXPress documents as a part of the pre-
flighting process. Having this ability can be especially important
for PDFs intended for direct output. From Preflight Pro you can
create numerous Settings files specifying different Page Setup and
Print parameters and different Acrobat Distiller Job Options—
something you can’t do using Distiller alone—and you can easily
share these files with other Preflight Pro 2.0 users. 

Preflight Pro inserts a PDF Sticky-Note inside each newly created
PDF document. The note includes creation date and time, and
important information about which Print and Distiller settings
were used to create the file. Then the PDF files are added to the
Job Jacket Files list for easy collection or archiving. And you can
save the intermediate PostScript file or have it automatically dis-
carded (it is discarded by default). 

Note: Acrobat Distiller, not the PDFWriter Chooser extension, is
used by Preflight Pro’s “Export to PDF” function. PDFWriter
alone does not offer all the options necessary for high-end
printing.

Note: When creating a PDF document, fonts used in the document
must be “active” in the system. If the fonts are not active, they
cannot be embedded into the PDF when it is created.

Exporting to PDF

The PDF Settings dialog allows you to
create and select settings for different
types of PDF jobs. You must have a
Postscript printer driver selected in the
Chooser to create a PDF file.

A PDF Settings: Select a settings file
from the list. These are the settings
that will be used to create the PDF.

B Export: Click here to use the
selected Settings file.

C Cancel: Click cancel to return to the
Job Jacket without making a PDF.
Cancels the Export to PDF opera-
tionÑdoes not cancel changes
made to Settings files using the edit
buttons.

D Settings File Editing Functions: Create,
modify, and remove PDF Settings
using the Edit..., New..., Duplicate...,
Rename..., and Delete... buttons.

PDF Select Settings dialog 

A
B

C

D

Important

You must have a Postscript printer
driver selected in the Chooser in
order to export a document as a
PDF file. QuickDraw printer drivers
(like AppleÕs Color Stylewriter)
wonÕt output Postscript files
without a RIP.
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PostScipt settings allow you to set Page
Setup and Print parameters to be used
in creation of the PostScript file. 

A PDF Settings PostScript tab

B Include Blank Pages, Registration
Marks, Delete PostScript File
(Checkmark=Yes)

C Resolution (specify DPI); Line Screen
Frequency (specify LPI); Paper Width
(specify in inches)

D Separations: (Off or On); Font
Inclusion: (None, All, All But
Standard 13, All But Fonts Included
in PPD); OPI: (Include Images, Omit
TIFF, Omit TIFF & EPS).

E Help box: Gives a brief description of
an item as the mouse passes over it.

F Cancel: Close the dialog box without
making changes to the settings on
any tabs.

G OK: Implement settings changes on
all tabs and close the dialog box. 

PDF Settings—Postscript tab

A

D

C

E

B

General settings are identical to and
override those set in Acrobat DistillerÕs
ÒJob Options.Ó 

A PDF Settings General tab.

B File Settings: Compatibility (Acrobat
2.1 or Acrobat 3.0); ASCII Format
(Checkmark=Yes).

C Device Settings: Default Resolution
(specify DPI); Default Page Size
(specify Width and Height in Inches,
Points, Pixels, or Millimeters).

D Font Settings: Embed All Font
(Checkmark=Yes); Embed Fonts
Below: (specify %).

E Help box: Gives a brief description of
an item as the mouse passes over it.

F Cancel: Close the dialog box without
making changes to the settings on
any tabs.

G OK: Implement settings changes on
all tabs and close the dialog box. 

PDF Settings—General tab

A

D

F

B

C

E

G

F G
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Compression settings are identical to
and override those set in Acrobat
DistillerÕs ÒJob Options.Ó

A PDF Settings Compression tab

B Compress Text and Line Art
(Checkmark=Yes)

C Color Bitmap Images: Downsample
or Subsample to: (specify DPI);
Automatic Compression (Zip/JPEG,
specify one of five levels) or Manual
Compression [JPEG (specify one of
six levels), ZIp (4 or 8 bit)]

D Grayscale Images: (same options as
Color Bitmap Images).

E Monochrome Bitmap Images: Down-
sample or Subsample to: (specify
DPI); Manual Compression (CCITT
Group 3 or 4, ZIp, or Run Length).

F Help box: Gives a brief description of
an item as the mouse passes over it.

G Cancel: Close the dialog box without
making changes to the settings on
any tabs.

H OK: Implement settings changes on
all tabs and close the dialog box. 

PDF Settings—Compression tab

A

D

C

E

F

G H

Advanced settings are identical to and
override those set in Acrobat DistillerÕs
ÒJob Options.Ó

A   PDF Settings Advanced tab

B Distill with prologue.ps / epilogue.ps;
Preserve OPI Comments; Convert
CMYK to RGB; Preserve Overprint
Settings; Preserve Halftone Screen
Information

C Transfer Functions: Preserve,
Remove, or Apply; Transfer
Functions: Preserve, Remove, or
Apply; Under Color Removal/Black
Generation: Preserve or Remove. 

D Color Conversion: Unchanged,
Device Independent, or Device
Dependent.

E Help box: Gives a brief description of
an item as the mouse passes over it.

F Cancel: Close the dialog box without
making changes to the settings on
any tabs.

G OK: Implement settings changes on
all tabs and close the dialog box. 

PDF Settings—Advanced tab

A

C

B

E

D

B

F G
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Export to PDF

Going straight from PDF to output is an exciting new way to get
trouble-free output that is both platform and output device inde-
pendent. But critical to the success of this technology, as with any
output, is ensuring that the PDF is error-free. 

Creating specific PDF Settings files for different types of jobs,
easily done in Preflight Pro, will help guarantee that your PDFs
are created with the proper options specified every time. But the
documents used to create the PDFs must be error-free as well. So
it’s good practice to preflight the original QuarkXPress or
PageMaker documents, make the appropriate corrections, then set
Preflight Pro to work making the PDFs. This will help ensure the
integrity of all your PDF jobs. And you can easily share your
PDF settings files with clients or other users in your workgroup.

In fact, the creation of error-free PDFs is so important to proper
output that Preflight Pro has a built-in safeguard to prevent PDF
files from being created from documents with errors. You can,
however, override this option in Edit > Preferences > General.

To Export a QuarkXPress or PageMaker document to  a PDF
file:

1. Go to the Job Jacket Files window by clicking the
“Files” tab, or press z1, then select the QuarkXPress
or PageMaker document(s) that you wish to create
PDFs for.

2. Click the “PDF” button, or select “Export to PDF...”
from the Job menu.

If the PDF button is dimmed after you select your docu-
ments in the Job Jacket File list, verify that they have been
inspected and that they are error-free.

Note: You can override the option to create PDFs only
from error-free documents. Select Edit > Preferences >
General and uncheck the setting “Disable ‘Export to PDF’
for Documents with Errors.”

The PDF Setting File Selection dialog will be displayed.

3. Select a PDF Settings file from the list.

Each time you Make PDF files from your documents in
Preflight Pro you must specify the Page Setup, Print, and
Distiller settings. With Preflight Pro this process is simpli-

Important

You will need version 3.0 or newer
of Acrobat Distiller to create PDFs
from Preflight Pro.
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fied with Settings files that you can create as you need
them for your different types of output jobs.

If an appropriate Settings file is listed, select it and proceed
to step 4. If not, continue with step 3a.

3a. If you do not have an appropriate PDF Settings file
you will need to create one: Click “New.” Enter a
name for the file, then click “OK.” Select the appro-
priate options for the Job from each of the four tabs
in the PDF Settings dialog box. Click “OK” to save
the Settings file and return to the Select Setting dialog.

For more information on the options available, refer to
pages 78-80, and to your Adobe Acrobat Distiller
documentation.

4. With a Settings file selected, click “Export.”

The document will be opened in the parent application
(QuarkXPress or PageMaker), and the PostScript file will
be created and distilled into a PDF file. 

A PDF Sticky-Note will be posted inside the document
listing the options and settings used in creating the PDF
file. The completed file will be given the same name as the
originating file with the extension “.pdf” and it will be
placed in the same folder as the document. The PDF file
will also be added to the Files list in the Job Jacket.

A separate PDF file will be created for each document
selected when the “Export to PDF” command is initiated.
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Configuring PDF Settings

To create a New PDF Settings file:

1. Select “PDF Settings...” from the Configure menu.

Note: You can create PDF Settings files on-the-fly when
you export a document as PDF. See page 87.

2. Click “New,” or select a Setting file similar to the one
you wish to configure and click “Duplicate.”

3. In the “Name” box, enter a name for the new or dupli-
cated Settings file.

4. Select the appropriate options for the Job from each of
the four tabs in the Edit PDF Settings dialog box. Click
“OK” to save the Settings file and return to the Select
Setting dialog.  
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The Settings file will be saved into a Settings folder located
in the same folder as the Preflight Pro application. 

For more information on the PostScript and PDF options,
refer to pages 78–80, and to your Adobe Acrobat Distiller
documentation.

5. Click “OK” to return to the Job Jacket.

To Rename a Settings file:

1. Select “PDF Settings...” from the Configure menu.

Note: You can rename PDF Settings files on-the-fly when
you export a document as PDF. See page 81.

2. Click “Rename.”

3. In the “Name” box, enter the new name.

4. Click “OK” to return to the Job Jacket.

To Delete a Settings file:

1. Select “PDF Settings...” from the Configure menu.

Note: You can delete PDF Settings files on-the-fly when
you export a document as PDF. See page 81.

2. Click “Delete.”

A dialog box will be displayed asking you to verify the
delete operation.

3. Click “Delete” to delete the Settings file.

4. Click “OK” to return to the Job Jacket.
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PPD Preferences

When creating PDF files, Preflight Pro will automatically select
the Acrobat Distiller PPD, if this PPD is available either in the
System Folder: Extensions: Printer Descriptions or in the
QuarkXPress PDF folder. 

If you wish to use a different printer description when printing
the Postscript file generated during the PDF process, you can
select it from the PageMaker or QuarkXPress preferences (Edit >
Preferences > PageMaker or Edit > Preferences > QuarkXPress.) 

The PPD must be available in either the System Folder:
Extensions: Printer Descriptions folder or in the PDF folder in the
QuarkXPress application folder. If a previously defined printer
description file is deleted, Preflight Pro will use the Acrobat
Distiller PPD.

You can have Preflight
Pro add your newly
created PDF files to the
Job Jacket Files list and
include them in the
Collection by selecting
this option in Edit >
Preferences > General.
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Sharing PDF Settings Files

You can easily share PDF Settings files with other Preflight Pro
2.0 users, for example between clients and service providers, or
between work groups, simply by copying and sending them. 

To Share PDF Settings files with another Preflight Pro 2.0
user:

1. Locate the “Preflight PDF Settings” folder in the same
folder as the Preflight Pro application.

2. Copy the desired PDF Settings files and give them to the
other user.

3. Have the other user place the copied Settings files in the
Preflight Pro Settings folder for their Preflight Pro
application.

¥
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Using the Collect Job Elements function, you can instruct
Preflight Pro to automatically gather together all the elements
required to output the job, including the documents that make up
the job, any Preflight Pro Profiles used, the Preflight Pro Job File,
all images—even embedded ones, and the job fonts. You can even
have a Collection Report generated and included in the job. 

You can specify which items are collected, and how they are
arranged in the job folder—either as loose items or in special sub-
folders. You can add items individually to the collection, or
remove items from the collection. You can even have Preflight
Pro create PDF files from your documents automatically as part
of the collection process.

If you’re using low-resolution OPI images in your documents but
will use high-resolution images on output, you can direct
Preflight Pro to collect the high-resolution OPI images, the low-
resolution images, or collect both. You set which images to
include in the collection in the Collection Setup dialog. 

Preflight Pro can automatically compress the collection into a
self-extracting archive after the items are gathered, and you can
have Preflight Pro automatically bin-hex the archive if that format
is required, possibly to transfer the archive electronically. And
archive size isn’t a problem—you can select a common media
size from the pop-up, or specify any segment size of your
choosing. 

Collecting Job Elements
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The Collection Process

When you start the collection process, Preflight Pro displays a
dialog box offering you the opportunity to determine which
elements (Images, Fonts, Job File, Collection Report) should be
gathered together for inclusion in the collection. 

After you’ve indicated your collection options, Preflight Pro
builds a list of all the items that will be included in the Job folder.
The table below indicates which items will be gathered for the
different options. When the data for the collection has been com-
piled, a “Collection List” is displayed.

You can add items to the collection without adding them to the
Files List, such as text documents giving additional instructions,

The Collection Setup dialog lets you
specify which items will be collected,
allows you to select Compression or not,
and lets you generate or print a
Collection Report.

A Cancel: Click here to cancel the col-
lection process. 

B Next>>: Click here to accept the
indicated choices and start the col-
lection process. Takes you to the
Collection Preview dialog.

C Collect Images: Sub-options are
Collect Low-Res and/or High-Res
OPI; Collect Embedded Images;
and Create Images Folder.

D Compress: Options are Compress
into Self-Extracting Archive; Convert
compressed archive to BinHex; and
Segment: (specify segment size).

E Collect Fonts: Sub-options are
Create Font Folder; Collect All
Suitcases, Combine only used fonts
into a Single Suitcase, or Collect
only used fonts into Separate
Suitcases.

F General Options: Collect Job File;
Save Collection Report; Print
Collection Report; and Export to
PDF (specify PDF Settings file to be
used when outputting the Postscript
and PDF files).

Collection Setup dialog

A B

C

D

E

F
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other electronic document files not being inspected with the job,
or perhaps Profiles not currently assigned to a document in the
collection. And you can remove items from the collection, such as
individual pictures or fonts, if necessary. To add items to, or
remove items from, the collection, start the collection then add or
remove the items when the Collection Preview window appears.

If you select this option… Preflight Pro does this…

Documents  (not an option) Collects all documents listed on the Job Jacket Files  
List, including PDF files and un-inspected documents. 
Documents are always included on the Collection List. You can 
remove documents from the collection, but you must wait until   
the Collection List is displayed (see page 95).

Collect Images Collects all images found in all inspected documents on the Job 
Jacket Files List. You can direct Preflight Pro to collect high-
resolution OPI images, collect low-resolution OPI images, or
collect both. You can also specify to include or not include
Embedded images. (“Embedded” refers to the original disk file for 
images embedded in EPS graphic files—see page 96).

Collect Fonts Collects fonts found in all inspected documents listed on the  
Job Jacket Files List, based on the one of the following:

Collect All Suitcases Collects suitcases as they appear on the disk, including extra 
screen fonts, if they are located in the suitcase. 

Combine only used fonts into Collects only fonts used in the job and puts them into a
a single suitcase single suitcase named Ò<JobName> Fonts.Ó

Collect only used fonts into Collects only the fonts used in the job and puts each font family 
separate suitcases in its own suitcase.

Create Folder Saves job Image and/or Fonts to a special ~Job Images or 
~Job Fonts folder in the Job folder. If this option is not selected,
images and fonts are saved ÒlooseÓ in the Job folder.

Export to PDF Automatically creates a separate PDF file for each document in 
the job, and adds them to the job collection.

Collect Job File Adds a copy of the Preflight Pro Job File to the collection.  
It includes the Job Jacket, Job Ticket, Output Instructions, and
Consolidated Report for the job. Valuable if your output facility
will be using Preflight Pro to do further preflighting.

Collection Report Creates and saves a Collection Report text file with the collection.
Includes Job Summary information, Job Ticket information, 
and Output Instructions for each document in the collection.
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The Collection Preview dialog shows all
the files that will be included in the col-
lection, and allows you to add or remove
files before the collection is gathered.

A Exclude item: Click here to uncheck
an item and exclude it from the
collection.

B Files to Collect: Lists files that will
be added to the collection. Missing
items are displayed in red.

C Type and Size: Displays the parent
application and pre-compressed
size of each file in the list.

D Documents: Lists all Documents
that will be collected.

E Pictures: Lists all Pictures that will
be collected.

F Fonts: Lists all Fonts that will be
collected.

G Profiles: Lists all Profiles that will be
collected.

H User Files: Displays the files that
you add to the collection using the
ÒAddÓ button (L) or by dragging and
dropping them over the Preview
window.

I Approximate Total: Shows you an
estimate of how big the collection
will be before it is compressed.

J Collect: Click here to start the col-
lection. You will be asked to indi-
cate where to store the collection.

K << Back: Click here to go back to
the Collection Setup dialog (Cancel).

L Add: Click here to locate files to be
added to the collection.

M Remove: Select the file to be remov-
ed, then click here to remove it from
the list of items to be collected.

Collection Preview dialog

D
J

K

L

M

F

G

H

E

CB

I

A
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To create a Collection:

1. In the Job Jacket, click the Collect Job button or press
zK, or select “Collect Job Elements” from the Job
menu.

Note: All documents in the Job Jacket Files list will be col-
lected, even if they have not been inspected.

The Collection Setup dialog will be displayed, allowing
you to specify collection output options. If the job has not
been saved prior to starting the collection, you will be
prompted to save it.

2. Verify or change the collection options for your job,
then click “Next.”

Options include: Collect Images, High-Res and/or Low-Res
OPI, Embedded Images, and/or Fonts; Compress, Bin-Hex,
Segment; Save and/or Print Collection Report; and Collect
Job File. See page 89 for information on collection options.

Preflight Pro will gather the list of items to be collected,
and display it in the Collection Preview dialog.

3. Examine the list of files to be collected, and add or
remove files as desired.

You can drag and drop files from the finder, or use the Add
and Remove buttons provided.
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If any of the files to be collected are missing, they will dis-
played in red on the Collection Preview list.

4. When you are ready to gather the collection, click
“Collect.” If you change your mind about the collection
options you specified earlier, or wish to cancel the col-
lection process, click “<< Back.”

When you have finished adding to or removing items from
the archive, or if you have no items to add or remove, click
“Collect” to have Preflight Pro gather the items.

5. Indicate where to store the collection, then click “Save.”

Before Preflight Pro actually gathers the collection, you
will need to indicate where the collection is to be stored.
Locate the disk drive and/or folder where the collection is
to be stored. Click “Save” to begin collecting job elements.

For safety, you cannot use an existing filename for your
new collection if doing so will overwrite another collec-
tion. If you attempt to do so, Preflight Pro will display a
warning. Simply change the name of your new collection,
then manually delete the old one if you no longer need it.
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The Job Collection is the folder or
archive that contains all the files gath-
ered in the collection.

A Job Collection Folder: This folder
takes on the name of the Job file,
unless specified otherwise when the
collection is gathered.

B Job Collection Archive: The collec-
tion folder shown in (A) is com-
pressed as a StuffIt self-extracting
archive when Òcompress collectionÓ
is selected during the collection
process.

C Job Collection Folder contents:
Includes the Job File and folders for
each of the four items that can be
collected (Files, Profiles, Fonts, and
Pictures). Note: If no elements are
collected in a particular category
(such as ÒFontsÓ) no folder will be
created for that category. Collection
category folder names are always
preceded by Ò~Ó.

The Job Collection

C

A B
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To Compress (archive) a Collection:

1. Start the collection by clicking the Collect Job button.

2. Verify or change collection options, then select appro-
priate Compression options.

If you wish to compress the collection (create a self-
extracting archive), click the “Compress” checkbox. To
also convert the archive to BinHex, click the “Convert to
Bin-Hex” box. No Special Post-Processing indicates that
you wish to create only the self-extracting archive, without
segmenting it or converting it to Bin-Hex.

To save the compressed file to more than one volume, use
the “Segment” button and pop-up to specify maximum seg-
ment size.

3. When you have finished with the Collection Setup
options, click “Compress” to continue with the collec-
tion process. 

Preflight Pro to begin gathering the collection according to
the options you specified.

To Add files to the list of items to be collected:

1. Start the collection by clicking the Collect Job button.

2. Verify or change collection options, then click “Next.”

3. When the Collection Preview window appears, drag and
drop the documents or folders you wish to add to the
collection. 

— or —

3. When the Collection Preview window appears, click the
“Add” button. Locate the file(s) to be added, then click
“Open” to add them to the list.

Add files to list
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4. When you have finished adding files, click “Collect” to
instruct Preflight Pro to gather the collection.

Files you add to the collection will be added to the end of
the Collection List under the heading “User Files” and
saved to a folder named“~User Files” inside the Job folder. 

To Remove files from the list of items to be collected:

1. Start the collection process by clicking the Collect Job
Elements button.

2. Verify or change collection options, then click “Next.”

3. When the Collection Preview window appears, uncheck
the files you do not wish to include in the collection.

— or —

Select the file(s) to be removed from the list, then click
“Remove.”

Files that you either uncheck or actually remove from the
list will not be gathered along with other files when the job
is collected.

4. When you have finished removing files, click “Collect”
to instruct Preflight Pro to gather the collection.
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Collecting Embedded Pictures

Preflight Pro offers you the option of adding embedded images to
the collection. You must elect to collect all image files to enable
the embedded images option.

When a picture is embedded in an EPS image, the current path to
the embedded file is entered into the EPS file. If the embedded
file is in the same physical location during the collection process
as it was when it was embedded, it is available for collection. If it
has been moved or renamed, it is not available and cannot be col-
lected.

The disk file for an embedded file is generally not needed to
properly output the EPS, but if a change needs to be made to it,
such as converting it from RGB mode to CMYK color mode, the
original image must be available. If the disk file for an embedded
file has been renamed and you want to include it in the collection,
you may want to use Preflight Pro’s “Add to collection” feature
described on page 94.

Note: Regarding the Profile item “Disk file for an embedded pic-
ture is missing,” the pictures listed for this item in the Report win-
dow are the original disk files for the pictures that are embedded
in a picture, if a disk file ever existed. Some embedded pictures
are pictures that were pasted on the page and have no associated
disk file. 
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You can significantly automate the preflight process—essentially
creating a “headless” preflight server—using Preflight Pro’s inno-
vative “Automations.” With Automations, you specify Watch
Folders on your disk where jobs can be dropped and automatical-
ly run through the preflight process. Based on the results of the
preflight analysis, jobs are transferred to Success or Failure fold-
ers that you specify. Once in the Success or Failure folder, you
can indicate further pre-processing for these jobs, even specifying
AppleScripts to be launched based on the pass/fail conditions.

You can create as many Automations as you like: each
Automation allows you to specify actions based on a unique
Watch folder, and pass/fail actions based on unique Success and
Failure folders. Input Options include: the type of document to
watch for (such as QuarkXPress or PageMaker); Output
Instructions to check against; and which Profile to assign. Output
Options include: specifying the Success and Failure folders;
actions to take, such as Print Job Info, Print Report, Print Job
Ticket, Export Job Info, Collect Job, and Delete Input Files; and
specifying an AppleScript script to run.

The Automations List dialog allows you
to create, modify, and delete Automa-
tions.

A Activate/Deactivate: Click here to
deactivate an Automation without
deleting it from the list. 

B Automations: Lists all the Automa-
tions available.

C Caution Icon: Indicates that a folder
must be specified, or one or more of
the specified folders (Watch,
Success, Failure) has been moved
or renamed. 

D Checkmark: Indicates that the
Automation is active and running.

E Done: Click here when you have fin-
ished editing or activating your
Automations.

F Edit Buttons: Use these buttons to
Create, Duplicate, Delete, and Edit
Automations.

Preflight Automations List dialog

A B

C

D

E

F

Automating Preflight Pro
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The Automation Settings dialog allows
you to specify which Watch folder is to
be used for the indicated Automation,
and what actions should be taken based
on the Success or Failure of the preflight
analysis.

A Automation Name: Name of this
automation file. 

B Cancel: Close the dialog box with-
out making any changes to the
Automation.

C OK: Apply the indicated settings to
the Automation and close the dialog.

D Scan Frequency: Indicate how long
to wait when scanning the Watch
folder for new jobs. Allows time for
all job files to be entered into the
folder before preflighting starts.

Input

E Watch Folder: Click folder icon, then
locate the folder to be watched for
incoming Job folders.

F Watch Options: Select Host (appli-
cation) documents to watch for, and
specify Profile to be assigned.

G Output Instructions: Specify Output
Instructions for documents being
checked using this Automation.

Output

G Success Folder: Click folder icon,
then locate folder where Job folders
will be moved on successfully pass-
ing the preflight test.

H Success Options: Select specific
actions to take on Jobs placed in
the specified Success folder.

I Run AppleScript: Specify the Apple-
Script to run on Jobs placed in the
specified Success folder. 

J Failure Folder: Click folder icon,
then locate folder where Job folders
will be moved on failing to pass the
preflight test.

K Failure Options: Select specific
actions to take on Jobs placed in
the specified Failure folder.

L Run AppleScript: Specify the Apple-
Script to run on Jobs placed in the
specified Failure folder.

Automation Settings dialog

A B C

E

D

F
G

H
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Overview of Automation

Preflight Pro Automations watch for Job folders and will check
documents placed at the root level of those folders. You can
specify how long Preflight Pro waits before checking the
specified Watch folder. This ensures that all the files in the job
will have had a chance to be copied into the folder before
preflighting begins.

When a Job (folder) containing documents of the type specified in
the Automation enters the Watch folder, Preflight Pro starts the
preflight process: A new Job Jacket is created, and all the docu-
ments in the Job folder are entered into it. Output Instructions are
entered, and a Profile is assigned. The job documents are then
Inspected and analyzed against the assigned Profile and Output
Instructions. 

After the inspection, if even one error is found (“error” flag set
for any Profile item in the assigned Profile; “caution” and
“ignore” flags are ignored by Automations), the job is either
moved or copied to the indicated Failure folder. If no errors are
found (no “error” flags set) the job is either moved or copied to
the indicated Success folder. Based on whether the job has passed
or failed the preflight test, the indicated Success or Failure
options are initiated. 

Technical Details about Automations:

• The Automation process requires that any open Job Jackets be
closed before Jobs dropped into the specified Watch folder
will be processed. This prevents any accidental closure of pre-
flight Jobs in progress. 

• Automations watch only for documents at the root level of the
Job folder, so be sure none of the documents are buried in
sub-folders of the Job folder.

• A “caution” icon in the Automations dialog list indicates that
one or more of the specified folders (Watch, Success, Failure)
has been moved or renamed for that Automation. To reactivate
the Automation, open the Automation Setup dialog and
relocate the folder.

Tip

The Automation process watches for
folders only, not individual files. If
you wish to watch for files, place
them in a folder before dropping
them in the specified Watch folder.

Tip

You can set up multiple Automation
setups to monitor the same Watch
folderÑjust make sure each Auto-
mation is watching for a different
document host (file type). Otherwise
only the first or most frequent
automation will work. 
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To configure a new Automation setting:

1. Select “Automations...” from the Configure menu.

2. Click “New,” or select an Automation similar to the one
you wish to configure and click “Duplicate.”

3. Enter a name for the Automation and set the Watch
folder scan frequency.

You specify a scan frequency to ensure that all files have
arrived in the Watch folder before preflighting begins. If
you don’t know how long a scan frequency to set, just
leave this option at the default setting.
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4. Specify a Watch folder by clicking the Watch folder
icon, then locate the folder where your job folders will
be placed for preflighting.

5. Set the Input (preflight) options: Select the type of doc-
uments that will be watched for; specify which Profile
will be used when preflighting job documents in this
folder; and specify the Output Instructions that will be
checked against these documents.

These are the options that will be applied to all documents
in any job folders in the specified Watch folder. If Any
Host is selected, the default Profile for each document type
will be used.

Note: You can set up multiple Automation setups to monitor
the same Watch folder—just make sure each Automation is
watching for a different document host (file type). Other-
wise only the first or most frequent automation will work. 
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5. Specify the Success and Failure folders: Click the
Success folder icon and locate the folder to be used for
jobs that pass the preflight test. Click the Failure folder
icon and locate the folder to be used for jobs that do not
pass the preflight test.

After preflighting, the job will be moved to the indicated
Success or Failure folder. 

A job is considered to have failed if even one error is found
that is, if an “error” flag has been set for any Profile item in
the assigned Profile; “caution” and “ignore” flags are
ignored by Automations.  

If no errors are found (no “error” flags set) the job is
moved to the indicated Success folder. 

See page 98 for information on Automation options.

6. Set the remaining Output (disposition) options.

Based on whether the job has passed or failed the preflight
test, the indicated Success or Failure options are initiated.

7. Specify the AppleScript(s) to be run on Success and/or
Failure.

You can further automate the post-preflighting process by
specifying your own AppleScripts to be run on Success,
Failure, or both. Preflight Pro will look for an
“AppleScripts” folder located in the same folder as the
Success and Failure folders.

8. When you have finished setting it up, click “OK” to save
the Automation and close the dialog. Click “OK” again
to return to the Job Jacket.

Tip

To use your own AppleScripts, put
them in the AppleScripts folder in
the Preflight Pro application folder.
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How to Use the Tutorial

Extensis Preflight Pro gives you enormous control over what job
elements can be inspected and flagged, problem thresholds, and
how information is reported. Preflight Pro even assists you in
examining and correcting problems, gathers job elements together
when the job is ready to be transferred to another facility for
output, and makes the task of getting a job ready for output faster
and easier than ever before. 

The following tutorial, combined with the Sample Files on the
Extensis CD, gives you a comprehensive view of what’s possible
using Preflight Pro. You will be introduced to the overall process
of preflighting, become familiar with the different job elements
that can be checked and flagged, learn how to generate a problem
report, learn how to use Preflight Pro Pilot to examine and correct
problems, and become familiar with the Profile items and overall
document problems that can be identified with Preflight Pro.

Note: Detailed information on each of the features covered in this
tutorial, and information about Preflight Pro features not
covered, is provided in the other sections of this User Guide.

The following sections are included in the Tutorial:

1: Starting the Job  . . . . . . . . . . . . . . . . . . . . . . . . . . .104

2: Inspecting Documents  . . . . . . . . . . . . . . . . . . . . . .109

3: Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .113

4: Problem Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . .117

5: Using the Pilot to Correct Reported Problems  . . .123

Preflight Pro Tutorial

Tip

This Preflight Pro Tutorial provides
a comprehensive look at what Pre-
flight Pro can do, and how it does it.
For the greatest understanding of
this powerful product, we encour-
age you to complete the full tutorial.
You can even gain an enormous
amount of information just by read-
ing through the steps and examin-
ing the examples provided.

However, we realize that your time
is valuable. You can get a sampling
of each step required to preflight
your documents by performing or
reading the following sections: 

¥ 1: Steps 1, 2 and 3 (pgs 104-105)
¥ 2: Step 1 (page 109)
¥ 3: Step 1 (page 115)
¥ 4: Step 1 (page 118) and

Step 5 (page 122)
¥ 5: Step 1 (page 123) 
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1: Starting the Job

The first step in preflighting is to create a job file. The job file
contains all the information pertinent to the job, including (but not
limited to): documents included in the job; Job Ticket information
and Output Instructions; information gathered about potential
problem elements in each document such as pictures, fonts, and
colors; plus information from the last report generated prior to
closing the job jacket, including problems found and their severity. 

The first, and primary, screen in Preflight Pro’s electronic job file
is the Job Jacket. The Job Jacket provides access to nearly all the
features and functions available in Preflight Pro.

1. Prepare the Sample Files.

• Drag the folder “Sample Files,” which is located in the
Preflight Pro Tutorial folder on the Extensis CD, to your
hard disk. 

All the files that you will need for this tutorial are located in
this folder.

2. Create a new preflight Job:

• Launch the Preflight Pro application.

Double-click the Preflight Pro icon. With no job selected,
Preflight Pro automatically opens a new Job Jacket with the
Files tab selected.

• Name and save your new Job. IMPORTANT: Save this
Job into the Sample Files folder that you just placed on
your hard disk.

Select “Save as...” from the File menu (or press zS). Type
in a name for your new job, then save the job to the Sample
Files folder. 

For this tutorial, your Job file must be in the same folder as
the ~Job Profiles folder so that Preflight Pro can access the
Sample Profile. When you create your own jobs, you can
save them anywhere you like.

The name in the Job Jacket title bar will be changed to
reflect your new job name. We named our preflight job
“Sample Job.”

Note: Once the file is named and saved, Preflight Pro saves
changes automatically as you work.

Important

This tutorial uses QuarkXPress
examples. If you are using another
application, such as PageMaker or
Multi-Ad Creator2, you can learn a
lot about what Preflight Pro can do
and how to do it it just by reading
through the steps and examining the
examples provided. 
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3. Add documents to the job:

After you’ve created a new Job Jacket (be sure the job was
saved into the Sample Files folder), you’ll want to add docu-
ments for Preflight Pro to inspect. 

• Select the files Sample Oneand Sample Two in the
Sample Files folder, then drag and drop them into the
open Job Jacket.

The Output Instructions dialog will be displayed (unless this
option was deselected in Edit > Preferences > General).

The Output Instructions dialog allows you to enter document
information that you will want Preflight Pro to check—such as
Printing Inks, Line Screen, and Trim Size—during the process
of preflighting the document. 

• Verify that the Trim Size is 8.5” x 11” (the values for the
other parameters are not important for this tutorial),
then click “OK.”
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The documents are added to the Files list in the Files tab of
the Job Jacket. Notice that the status of the files on the Files
list is “Not Inspected.”

Note: For additional information on the Job Jacket and
Files list, see “The Job Jacket: Files tab” on page 27.

Note: You could also start a new job by dragging and drop-
ping the documents onto the Preflight Pro application. If a
Job Jacket is already open, dropping files onto the applica-
tion icon will add those files to the Files list of the open Job.
If no Job is open, Preflight Pro will create a new Job Jacket
and add the documents to it.
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4. Examine the tools available in the Button Bar:

• Pass the mouse over each button in the Preflight Pro
Button Bar, and notice that the button function appears
in the Help box in the bottom-left corner of the window. 

As you go through this tutorial, notice that the column
headers in the files list—as well as the page and status icons
associated with each document in the list—are all described
in the Help box. Look for similar Help boxes in other
Preflight Pro windows.

Note: When page icons appear in the Document list, such as
after an Inspection, passing the mouse over the page icon
displays the page number in the Help box. Also note that
columns in the document list can be resized by dragging left
or right, and documents can be reordered by dragging them
above or below another document in the list.

For detailed descriptions of the various tabs, buttons, and
icons, see “The Job Jacket” starting on page 20.

Help Box
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• Optional: If you have more than one copy (or version) of
QuarkXPress, specify which copy to use.

If you have only one copy of QuarkXPress, Preflight Pro
will locate it automatically when you inspect the document.
However, if you have multiple copies (such as on mounted
drives on a shared network) or multiple versions (such as
for compatibility with clients) you should indicate which
copy of QuarkXPress you wish to use. 

To do so, select Edit > Preferences > QuarkXPress. Click
“Specify,” then locate the copy of QuarkXPress you wish to
use. Note that this selection becomes the default. You can
repeat this process any time you wish to direct Preflight Pro
to use a different copy of the QuarkXPress application.

Note: If you have QuarkXPress launched when you select a
document for inspection with Preflight Pro, Preflight Pro will
use the open application when inspecting your document. 

From this Preference dialog box you can also elect to have
Preflight Pro leave the documents open in QuarkXPress
when the inspection is complete. The default is to close
documents after inspection. 

Tip

For document inspections, Preflight
Pro will use whichever version of
QuarkXPress (3.32 or 4.0) was
used to create the document. 
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2: Inspecting Documents

Before Preflight Pro can report on problems or conditions
that might prevent the document from outputting properly,
document data must be gathered and processed. This is done
by performing an Inspection. Inspecting a document causes
Preflight Pro to gather information from it that can be
analyzed for potential problems. 

Very detailed information about each document is available
after the inspection—including document parameters, output
parameters, and information about the job elements (fonts,
pictures, and colors) found in the document. Included in the
information gathered are the documents and pages where each
element was found, and other information specific to the
document or individual job element. 

You can use the various tabs inside the Job Jacket window to
examine the information that was gathered during the inspec-
tion, and later generate a problem report to alert you to potential
problems. 

1. Inspect both documents:

• Select (highlight) both documents, Sample Oneand
Sample Two.

In order to gather data about a document, Preflight Pro must
open and examine it in QuarkXPress.

Preflight Pro allows you to work with multiple documents.
Documents in the Job Jacket can be inspected individually,
all at the same time, or in any combination.

Tip

Use the Shift key to select multiple
documents contiguously; use the
z key to select multiple documents
non-contiguously; press zA to
select all documents at once. 
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• Inspect the selected documents by clicking the “Inspect
Selected Documents” button, or press zE.

Preflight Pro will launch QuarkXPress, open the specified
documents, and gather all of the information needed for
preflighting. Preflight Pro keeps you posted on it’s
progress with a progress bar. When the inspection is com-
plete, Preflight Pro will close the documents.

Note: If a document was open prior to inspection by Pre-
flight Pro, Preflight Pro will leave it open after inspection. 

Note: You can instruct Preflight Pro to leave documents
open when the inspection is complete, if you wish. Refer to
the “Optional” section of step 4 on page 108.

When the inspection is complete, an overall document
summary will be displayed, indicated by the Document and
Page Status icons in the Files list.

2. If the Report window appears, click the “Job Jacket”
button in the upper-left corner of the Report window to
return to the Job Jacket. You will learn about the Report
window a little later in this tutorial (page 117).

3. Examine the overall inspection results:

• On the Job Jacket Files list, notice the Document Status
and Page Status icons that now appear (you may see  dif-
ferent icons than the ones shown in the figure below).

When the inspection is complete, Preflight Pro summarizes
the results in the Files list. Problem severity is determined
by settings in the Profile assigned to the document
(Profiles are described in the section “Profiles” page 55).

Document Status

Page Status
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Document Status:Indicates overall document status.
Document Status is based on the highest severity problem
found anywhere in the document.

Page Status:Indicates overall page status. Page Status is
based on the highest severity problem found anywhere on
the page.

WHITE page icon indicates that no problems were
found.

RED page icon indicates that one or more problems
of any severity were found on that page.

SLASHED page icon indicates that the page is to be
excludedfrom the Report. 

You will learn a lot more about the Document and Page
Status icons as you go through this tutorial.

The Document and Page Status icons are also discussed in
the section“The Job Jacket”on page 24.
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4. Next, click through the Pictures, Fonts, and Colors tabs in
the Job Jacket to see the types of information gathered
during the inspection. 

As you’re looking through these three job element tabs,
double-click on a picture, font, or color to open a detailed
information window about that particular job element. In the
detail window you will be able to see exactly what
information was gathered about the element. 

Note: For a detailed description of job elements and the
information gathered during the inspection, refer to
“The Job Jacket” (page 24).

Notice that, although you now have access to an enormous
amount of very detailed information about the elements that
make up the job, you don’t yet have a quick and easy way to
identify problems in the job that might prevent it from out-
putting correctly. The next step in the process, “Creating
Profiles,” is important in assuring that Preflight Pro provides
you with exactly the information you need to determine
whether or not your job will output properly.
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3: Profiles

Profiles are an important part of the versatility of Preflight Pro.
Using profiles, you define which problem conditions are of con-
cern to you, and how critical each problem is. Inside the Profile
you can also set problem thresholds or tolerances as appropriate.
All of the problems that can be found and flagged by Preflight
Pro are listed in the Profile tabs.

The “default” Profile is automatically assigned to documents
when they are added to the Job. You can assign a different Profile
by selecting it from the Profile pop-up on the Job Jacket files list. 

You create Profiles by selecting “Profiles” from the Configure
menu.

Tip

If you are starting the Tutorial here,
you will need to do the following
before beginning:

¥ Drag the Sample Files folder from
the Extensis CD to your hard disk.

¥ Create a new Job with the Sample
One and Sample Two files and
save the Job File to this folder.

¥ Inspect both documents.
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You can assign different profiles for different documents in the
job, and even specify Profiles for particular pages within a
document. You can specify Profiles for certain types of output
devices, then share those profiles between clients and service
bureaus to ensure that all jobs meet the requirements of the
output device. And you can specify a default Profile that will
automatically be assigned to all new documents added to the job. 

Technical Note: Profiles are examined by Preflight Pro whenever
document data is analyzed. Data is analyzed: when a Report is
generated; when Output Instructions are changed; and when a
different Profile is assigned to the document. This is true unless
the option “Only Analyze when Building Report” is selected in
Edit > Preferences > General (see page 49).

Before you can see what problems were found in the document, a
Report must be generated. This is done automatically by Preflight
Pro after the inspection, unless “Auto-Open Report after Inspec-
tion” is deselected in Edit > Preferences > General (see page 49.

When the Report is generated, the information in the Profile is
checked to determine what threshold constitutes a problem, and
how the item should be flagged when a problem is found. Preflight
Pro considers each item in the Profile and the settings in the Output
Instructions and determines, for every document and every page
included in the Report, whether or not a problem exists.

When a problem is found, one of three condition flags will be set
for it: Error, Caution, or Ignore. Which of the three flags will be
set is determined by you when you configure each item in the
Profile. You might think of the problem condition flags as just dif-
ferent severity levels for problems, with “error” indicating a prob-
lem that would definitelykeep the job from outputting correctly,
“caution” indicating problems that might keep the job from out-
putting, and “ignore” as problems that don’t affect the output, or
issues that, in your environment, don’t constitute a problem at all
(in other words, issues you don’t care about). If no problem is
found when a profile item is tested, no problem flag is assigned
and the item will not appear on the problem report.

Note: You can assume whatever meaning you wish for the Error,
Caution, and Ignore flags. Also note that all problems are flagged
and available for display in the Report window; problems indicat-
ed as “ignore” are not ignored by Preflight Pro, they are simply
tagged with the Ignore flag. Using the “Show only” checkboxes
you can choose not to display problems flagged as “ignore.”

Note

Since every application provides
unique challenges to the process of
correctly outputting documents,
Preflight Pro provides separate
Profiles for each page layout
application that can be preflighted:
Multi-Ad Creator2, PageMaker, and
QuarkXPress, and another
ÒGraphicsÓ Profile for the graphics
documents that can be preflighted:
FreeHand, Illustrator, and
Photoshop.
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¥

For more information on problem conditions, problem severity
flags, and other profile information, see “Profiles” (page 55) and
“Problem Reporting and Correction” (page 63).

You will find out more about  profiles as this tutorial progresses.

1. Assign the profile “Sample Profile” to the Sample
documents:

Since Profiles determine what constitutes a problem, and how
severe each problem will be for the particular document type
and output device, you will probably use a number of differ-
ent Profiles in your work. You may even want to share
Profiles with service providers and other Preflight Pro users. 

New Profiles that you create in Preflight Pro are automatically
added to a “Preflight Pro Profiles” folder located in the same
folder as the Preflight Pro application. A copy of each Profile
used in the preflight job will be added to the ~Job Profiles
folder located in the same folder as the Job File when the job
is collected. Preflight Pro looks in both places for Profiles. 

Note: If the required Profile cannot be found in either of these
folders, the application’s Default Profile will be assigned. The
Default Profile will not work with this tutorial.

The Profile that you will be using in this tutorial is located in
the ~Job Profiles folder in the Sample Files folder where you
saved your Sample Job.

• Return to the Job Jacket Files tab window. Assign the
Profile “Sample Profile” to the document Sample One,
then do the same for document Sample Two:

On the Job Jacket files list, deselect the two Sample
documents. In the Profiles column for the document Sample
One, click and hold the mouse to enable the Profiles pop-up
menu. This pop-up menu lists all of the available Profiles,
including the Sample Profile from the ~Job Profiles folder.
Release the mouse over the profile item “Sample Profile” to
select it.

Do the same for the document Sample Two.
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• Examine the document list and verify that the new
Profile has been assigned to both documents.

Note: When you assign a new Profile to a document,
Preflight Pro automatically analyzes the document
information gathered during the inspection against the
problem settings in the new Profile, then updates the page
icons to reflect any changes.

2. Notice that the Document and Page Status icons have
changed.

Some of the Page Status icons in the Files list have changed,
and the Document Status icons should display “error” sign.

This indicates that the Profile “Sample Profile” is checking for
different errors than the default Profile that was automatically
assigned when the documents were added to the job.

Note: You can assign your own default Profile for each type of
page layout document that can be preflighted with Preflight
Pro (Creator2, PageMaker, QuarkXPress) and a Default
Graphics profile (for documents created in FreeHand,
Illustrator, or Photoshop). See “Profiles” page 55.
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4: Problem Reports

When you examined the Inspection results in the Job Jacket Files
tab (step 2:3, page 110,and step 3:2, page 116)you saw that the
Document and Page Status icons allow to you to see quickly
whether a document, or a specific page, is problem-free or
whether some kind of problem was found.

The problem Report gives you problem information in much
greater detail. And the Report window gives you access to the
Preflight Pro Pilot, a tool you can use to navigate through the
problem list to examine and correct problems right inside the
document.

The Report window shows you each and every problem that was
found in the document. Problem results can be viewed on-screen,
and the report can be printed. Using controls in the Report win-
dow, you can limit the information being displayed to only the
information you are interested in at the time. 

For example, you can limit the types of problems being
displayed, and you can indicate for which documents, and for
which pages within those documents, you wish to have problems
shown. You can also have Preflight Pro report on only the first
occurrence of a problem, since some problems (for example
picture problems) are caused by a single element but affect many
pages.

Tip

If you are starting the Tutorial here,
you will need to do the following
before beginning:

¥ Drag the Sample Files folder from
the Extensis CD to your hard disk.

¥ Create a new Job with the Sample
One and Sample Two files and
save the job to this folder.

¥ Assign the Profile ÒSample ProfileÓ
to both documents.

¥ Inspect both documents.
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1. Open the Report:

• In the Job Jacket Files tab window, select both docu-
ments Sample Oneand Sample Two, then click the
Report button on the button bar, or press zR.

The report window is displayed. 

Report On list: The left side of the window is the Report On
list, which displays the list of documents being reported on. 

Consolidated Report:The right side of the window is the
Consolidated Report, where the problems and the associated
document and page number are displayed.

More Info: At the bottom of the Report window is the
“More Info” field. This is a Help Box where information
about the problem—and suggestions for how to correct it—
are displayed.
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2. Examine the Report On list.

Using the Report On list you can quickly exclude documents
or pages from the Report to see just the information you want
to see. You can go back and forth between the Report On list
and the Consolidated Report as often as necessary to see
information for the documents and pages that you wish to see. 

• Select and deselect documents and pages and notice
what happens in the Consolidated Report.

Each time you change selections in the Report On list, the
Consolidated Report is updated immediately with the new
information. 

When documents or pages are excluded from the list, these
changes are reflected beside the job and document names
with a red checkmark. A red check next to the job name at
the top of the list indicates that one or more pages in the job
has been excluded. A red check next to a document name
indicates that one or more pages in the document has been
excluded.

• Before moving on to step 3, verify that all pages in all
documents are included in the Report (no red checks).

Note: All documents which have been inspected will be listed
in the Report On list (un-inspected documents are not shown
since no information has been gathered for them—therefore
no problem report can be generated). While an inspected doc-
ument will appear in the list, page numbers will only be dis-
played for those documents that have been selected to be
reported on in the current Report.
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3. Examine the Consolidated Report.

Recall that the job element tabs (Pictures, Fonts, Colors) in
the Job Jacket window show all the information gathered
about job elements when the Inspection was done, but do not
show any problem data. The Report window is where the
problems are shown. 

The Consolidated Report displays a combined or “consolidat-
ed” report of all the problems that were found when the prob-
lem Report was generated. Information displayed in the
Report is based on the Profile used to analyze document data,
the documents and pages that are selected for reporting, and
the setting of the “Show only” and “first only” checkboxes. 

• Examine the Profile sections and problem items in the
Consolidate Report. Use the scroll bars to see the entire
list. Notice that the listed problems are organized by
Section (category) and Item (individual problem).

These are the same problem Sections and Items that are
found in the Profile. The Profile is where you determine
what flags to assign to problems; the Consolidate Report is
where you display the detailed results of the problem
analysis. Only Profile Sections where problems were found
will be listed.

Note: If a problem is not covered in the Profile, it will not
be reported on here—or anywhere in Preflight Pro.

Tip

When preflighting your own docu-
ments, remember that problem
severity (Error, Caution, Ignore), as
indicated by the icon to the left of
the listed problem, is based on the
problem conditions and flags as
they were set in the currently
assigned Profile for the document.

Because a problem isnÕt listed in the
Report doesnÕt necessarily mean it
doesnÕt exist. If you suspect prob-
lems that arenÕt listed, verify that the
proper Profile has been assigned to
the document, and that the Profile
has the appropriate problems
selected for reporting.



4. Select a few problems, then look at the “More Info” area
at the bottom of the Report window.

In the More Info box, Preflight Pro provides additional
information about the selected problem, such as what might
be causing it, and offers suggestions for correcting it.

You can see a complete listing of the problems covered and
what they test in Appendix A (page 138). A list of the prob-
lem descriptions and solutions as displayed in the More Info
box is given in Appendix B (page 159).
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More Info
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5. Limit the display to only “error” flagged problems:

• Click the “caution” checkbox in the top-right corner of
the window to deselect it. 

The “Show only” checkboxes allow you to limit the type of
problems displayed in the Report by temporarily hiding
problems of different severities. These checkboxes are mir-
rored in the Job Jacket window, so the document summary
(as indicated by the Document and Page Status icons) is
also affected by the settings of these checkboxes.

By deselecting the “caution” box (with the “ignore” box
already off) Preflight Pro limits problem reporting to just
the problems indicated as “error,” and updates the display to
reflect this. 
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5: Using the Pilot to Correct Reported Problems

After you’ve generated a Report to show you what problems
exist in your documents, you are ready to begin correcting them.
Preflight Pro makes the task of navigating through the problem
list quick and easy with a special Pilot palette.

The Pilot is a convenient system-wide floating palette that stays
open until you close it so that you can move about inside your
document, checking and correcting problems as you go, only
returning to Preflight Pro as necessary to reinspect documents or
generate a new Report.

1. Open the Pilot and correct a Document Section problem:

• Click the “Open Pilot” button in the Report window.

When you click the Preflight Pro Pilot
palette appears. 

If a problem was selected in the Report window when you
clicked “Open Pilot,” the Pilot palette will display this
problem when it opens. 

If no problem was selected, the Pilot will open to the first
problem on the list. Since the “Document” Section is the
first tab in the Profile, all Document Section problems are
listed first.

• Become familiar with the Pilot palette.

Displayed at the top of the Pilot palette is the currently
selected Profile Section, and the total number of Sections
reporting problems. Directly beneath this information is a
numerical accounting of the problems (Item) in the
indicated Section. Notice that there are a total of six (6)
problem Items being reported. Arrows next to the Section
and Item information allow you to navigate the entire
problem list without returning to Preflight Pro. 

The middle area of the palette displays the document that
the problem was found in, and the problem Item name.

The bottom area displays the problem description and
possible solutions information from the More Info area of
the Report window.

The Pilot palette is a system-wide palette that stays open
until you close it, or until you close the Preflight Pro Report
window. You can minimize the Pilot palette by clicking the
minimize button in the upper-right corner.

Tip

If you are starting the Tutorial here,
you will need to do the following
before beginning:

¥ Drag the Sample Files folder
from the Extensis CD to your
hard disk.

¥ Create a new Job with the
Sample One and Sample Two
files and save the job to this
folder.

¥ Assign the Profile ÒSample
ProfileÓ to both documents.

¥ Inspect both documents.
¥ Open the Report window.  
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• Using the arrows on the Pilot palette, locate the problem
“Section: Document (1 of 4), Item: 3 of 3; Output set to
be reduced or enlarged.”

This is a problem sometimes encountered when oversize
pages are printed to a smaller page output device for
proofing, such as a laser printer.

• Click the “Show” button on the Pilot palette.

Preflight Pro will open the document that contains the
problem (in this case, Sample One), move to the appropriate
page, and select the appropriate job element or dialog box
in the document. 

Note: This action is similar to the picture update function
“Show me” in QuarkXPress.

• In the Page Setup dialog for the document Sample One,
change 80% to 100%.

This allows the document to print on the final output
device at the correct size, and completes the first problem
correction.

Note: If you were not going to be correcting more problems,
you would want to save the document before continuing.
Since you will be correcting a few more problems, there is
no need to save the QuarkXPress document at this time.

• Step to the next problem by clicking the right-hand
arrow beside the Pilot palette “Item” information until
you see the problem “Font menu-styled as ‘Outline’”
displayed on the Pilot.
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2. Correct a Fonts Section problem:

• Verify that the problem displayed on the Pilot palette is
“Section: Fonts (2 of 4), Item: 1 of 1; Font menu-styled
as ‘Outline’.”

Text in a Type 1 font which is styled from the Style menu in
QuarkXPress can cause problems when the output device
attempts to locate the printer font—a font that doesn’t exist.

• Click “Show.”

This problem item is contained in a different document
(Sample Two), so Preflight Pro opens that document and
moves to the problem area.

• Remove the “outline” styling from the text in the
selected box.

• Step to the next problem by clicking the right-hand
arrow beside the Pilot palette “Item” information until
you see the problem “Element colored with Registration
color” displayed on the Pilot.

Tip

Step one of the tutorial “Using the
Pilot to Correct Reported Problems”
has shown you all you need to know
to navigate the problem list using
the Pilot, and to use the Pilot to
examine and correct problems. 

The rest of the tutorial gives you
additional practice using the Pilot,
introduces you to one problem in
each of the Profile categories for
QuarkXPress, introduces you to
document problems not associated
with a page, shows you how to
verify that the problems were
corrected, and completes the
tutorial.



3. Correct a Color section problem:

• Verify that the problem displayed on the Pilot palette is
“Section: Colors (4 of 4), Item: 1 of 1; Element colored
with ‘Registration’ color.”

Sometimes a designer will accidentally select the color
“Registration” from the the Color palette in an application
instead of the more appropriate color selection “Black.”
Since the color “Registration” is used for items (like
registration marks) that print on all plates, selecting it
indiscriminately can cause problems in the output.

• Click “Show.”

This problem is in the Sample One
document, so Preflight Pro switches to

that document and selects the offending item.

• Open the Color palette and change the color applied to
the item from Registration to Black.

• Step to the next problem by again clicking the right-
hand arrow for Item until you see the problem “Element
set to suppress on output” displayed on the Pilot.
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4. Correct another Document Section problem:

• Verify that the problem displayed on the Pilot palette is
“Section: Document (1 of 4), Item: 2 of 3; Element set to
suppress on output.”

Sometimes a picture will be causing a problem or taking a
long time to image on the proofing device, and thus has
been set to not print. When the document is ready to be
imaged on the final output device, this setting must be
removed. 

• Click “Show.”

Preflight Pro moves to the problem area
and selects the offending item.

The item set to suppress is a grouped picture.

• Select the QuarkXPress Item tool (to select the whole
group), then open the Picture Box Specifications dialog
(zM in QuarkXPress) for the grouped image.

• Deselect the Suppress Picture Printout checkbox.

This corrects the suppressed item problem.

• This completes the problem corrections to be made
inside the Sample documents. Proceed to step 5 to save
your changes (do not close the documents or
QuarkXPress).

All but 2 of the original 6 problems have been corrected.
The final two problems will highlight other functions in
Preflight Pro, so you will be leaving the Pilot and
QuarkXPress.

Note

In this tutorial, the item with
Suppress Printout applied is a
grouped object. If you select a
grouped object with the Content tool
active, you will be selecting only one
element in the group. You can select
the item this way if you prefer, but
you will not be correcting all the
Suppress Printout items at the same
time; you will need to use the Pilot
to step to the next Suppress Print-
out problem in order to correct it.
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5. Save changes and return to Preflight Pro:

• Save the changes to both documents Sample Oneand
Sample Two by selecting “Save” from the QuarkXPress
File menu, or pressing zS. Do not quit QuarkXPress
and do not close the Sample documents.

• Click the “Preflight Pro” button on the Pilot palette.

The Pilot palette will close and you will be returned to the
Report window. 

• Note that the changes are not yet reflected in the Report
window. 

Don’t be surprised that your corrections have not yet been
reflected in the Report window—Preflight Pro must rein-
spect the documents before it will be aware of exactly what
has changed. 

• Examine the Report On list, and notice that the
document names are displayed in red. 

A document name in red type indicates that the document
has been modified, and alerts you that the problem Report
may therefore be inaccurate.

• Click the “Job Jacket” button in the Report window.

You will be returned to the Files tab in the Job Jacket
window (assuming this is the tab that was selected when
the Report was generated.)
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6. Reinspect the documents and verify that some problems
have been corrected:

• Examine the updated Job Jacket Files tab window.

The Document Status icons have changed to “Unknown”
and the word “Modified” is displayed in the “Selected”
column. This indicates that an inspection is required to
gather the changed document information.

• Select both documents Sample Oneand Sample Two,
then click the Inspect button.

When the inspection is complete, notice that the problems
you corrected no longer appear in the Report. This verifies
that the errors were indeed corrected.
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• Click the Job Jacket button to return to the Job Jacket,
then examine the Document and Page Status icons in the
Files list.

From the reinspection, Preflight Pro has determined that the
document Sample Onehas been checked and corrected,
and thus has changed the Page Status icons from red to
white, and updated the Document Status icon to a check-
mark. Remember that these status icons currently are report-
ing only on “errors,” since you have deselected both the
“ignore” and “caution” boxes. 

However, the document Sample Two still displays the
“error” status, so at least one “error” remains.
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7. Correct a problem in the Profile:

One of the problems noted in the Pilot palette which you did
not correct in the Sample documents involved an incorrect
Picture format. The problem item was stated as: “Incorrect
picture format (PICT).”

Since the Profile determines which problems are flagged as
“error,” if the Profile is incorrectly configured, you could get a
false error indication.

For this example, assume that you have consulted with the
document designer and determined that the picture format
PICT is an acceptable picture format for these two documents.
This means that the PICT “error” is not really an error at all,
as far as these two documents are concerned. But the Profile
for this document indicates that this picture format is a prob-
lem, and unless you change the setting in the Profile, the doc-
ument Report and status icons will continue to show this as an
error.

Profiles are very powerful tools for you in preflighting your
documents, and you would not want to change them indis-
criminately. However, when a “false indicator” such as this
occurs, you may want to create another Profile that allows for
this format. In this example, you can either create a new
Profile that allows the PICT format, or you can change the
current Profile and use it for other documents where pictures
in the PICT format should not be considered a problem.

• From the Configure menu in the menubar, select
“Profiles.”

Note: You must be in the Job Jacket window (not the Report
window) to access this menu option.

The Configure Profiles dialog box appears.

Notice that the “Sample Profile” is listed last,
under the heading “Local Profiles.” This is
where Profiles are displayed when Preflight Pro
finds them in the ~Job Profiles folder. Profiles
located in the Profiles folder in the same folder
as the Preflight Pro application are listed above
the line.



• In the Configure Profiles dialog box, select the Profile
“Sample Profile,” then click Edit.

Clicking “Edit” opens the Profiles dialog for the selected
Profile. To create a new Profile instead of changing this one,
you could have selected “Duplicate” or “New” instead.

• In the Profile dialog box, select the “Pictures” tab, then
scroll down to the problem Item entry for “Incorrect
picture file format.”

• Deselect the “PICT” problem Item.

You could also solve this problem by selecting “caution” or
“ignore” from the pop-up menu.

• Click “Save.”

This closes the dialog box and saves the change to the
Sample Profile.

The Configure Profiles dialog will be displayed.

• Click “Done.”

This completes the Configure Profiles operation and returns
you to the Job Jacket. 
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• Examine the updated Files list in the Job Jacket Files
tab window.

Notice that the last remaining red Page Status icon has
changed to white. All the problems have been corrected!
Well, almost—the Document Status icon is still indicating
that at least one error remains. Since only the Document
Status icon is affected by the error, it is an error that affects
the whole document, rather than a single page.

Note: Because the change you made to the Profile affected
only the reporting options and not the document, Preflight
Pro updated the Status icons without reinspecting the
document. 
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8. Determine what the last problem in the job is.

• From the Job Jacket files list, select the document
Sample Two and click the Report button (or press zR)
to generate a new report.

You will need to view the report to see what the last remain-
ing problem is.

• When the Report window opens, note the last remaining
problem in the Consolidated Report area: “Document:
Page size does not match trim size: Sample Two.”

Also notice that, in the Report On list, the document Sample
Onedoes not have a checkmark. This indicates that it is not
included in the Report. Additionally, the checkmark beside
the job name (Sample Job) is orange, indicating that not all
elements (documents and pages) are included in the current
Report.

• Click the Job Jacket button to return to the Job Jacket. 
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• From the Files list, select the document Sample Two,
then click the “Open Document” button.

This opens the document Sample Two in QuarkXPress.

• Inside the document Sample Two, open the Quark-
XPress “Document Setup” dialog (File > Document
Setup) and verify that the page size is set to 5 x 7. This is
the correct trim size for this document.

The trim size setting inside the document is correct, yet an
error is displayed in the Report. This indicates that you
should check the document Output Instructions in Preflight
Pro, to make sure that the correct problem-check parameter
for this document was set prior to preflighting it.

• Return to Preflight Pro by selecting “Preflight Pro”
from the Utilities menu in QuarkXPress (v3.32) or from
the Extensis > Preflight Pro menu in the menubar
(QuarkXPress v4.0).

Notice on this menu the other options for Preflight Pro:
“Add to New Job” and “Add to Existing Job.”

These selections allow you to easily create a new job from
the active document (the one you are working on), or to
display the system Open FIle dialog so that you can select
an existing job to add the active document to. 

• Click the Job Jacket button in the Report window to
return to the Job Jacket.
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9. Correct the Output Instructions settings:

• In the Job Jacket Files list, select the document Sample
Two, then click the “Output Instructions” button.

The Output Instructions dialog box will be presented.

• Change the “Trim Size” setting in the Output
Instructions dialog from 8.5 x 11 to 5 x 7.

• Click OK to save the change and return to the Job
Jacket Files tab window.
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10. Verify that all the corrections have been made.

The Document Status icons for both documents now indicate
that all the documents are error-free. 

11. Experiment!

For more experience in preflighting with Preflight Pro, you
could select both documents, generate a new Report, and
verify from the Report window that all errors have been
corrected. 

Or you could use the “Show only” checkboxes in the Job
Jacket Files tab window and/or the Report window to display
the problems flagged as “caution” to see what additional
problems are reported by the Document and Page Status
icons, and in the more detailed Consolidated Report. You
could then use the Pilot to locate and correct those problems
flagged as “caution.”

You could also try excluding some pages from the report
using the “Exclude Pages” command in the Job Jacket and/or
the Report On area of the Report window, and see how this
affects the Report.

Refer to other sections in this User Guide for information
about features not covered here, such as Collecting Job
Elements (page 87), Exporting to PDF (page 78),“Watch
folder” Automations (page 97), additional Preferences
(page 49),information on specifying Font Search Paths
(page 53), and information about what each Profile item
checks (Appendix A, page 138). A listing of problem
descriptions and suggested solutions is given in Appendix B,
page 159.
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QuarkXPress Profiles

QuarkXPress Document Profile Section

Problem conditions in the Document profile items category affect
the whole document (such as page size, output set to reduce or
enlarge, etc.) as opposed to problem conditions which affect a
particular job element (such as Fonts, Pictures, Colors, Trapping). 

Appendix A: Profile Items

This profile item… Tests this condition…

Page size does not match paper Compares the page size of the document to the trim size 
trim size set in the Document entered in the Job Jacket Output Instructions for the document.
Output Instructions

Document not saved in a Macintosh Flags QuarkXPress Windows version documents.
version of QuarkXPress.

Document output is set to be Determines if the document Page Setup is set to output at 
reduced or enlarged. more or less than 100%.

Item on page is set to suppress Finds elements that are set to Suppress on Printout in  
on print-out. the Modify dialog.

Document output is set for: Compares the page size of the document to the Trim Size
[x] Low Resolution  [x] Rough entered in the Output Instructions of each document.

Blank pages exist in the document. Finds pages that do not have elements on them.

Overflowed text box exists.  Finds text boxes that have text that does not fit into 
the text box.

QuarkXPress Document profile items
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QuarkXPr ess Fonts Profile Section

Most font problems occur when the document is moved to a
system with a different set of screen and printer fonts.

Some font types,such as TrueType and Multiple Master fonts,
and some style attributes,such as Outline and Shadow, while
printing properly to low and medium resolution Laser Printers,
will occasionally not output correctly to high resolution
imagesetters and other imaging equipment.

This profile item… Tests this condition…

Missing screen font. Lists fonts that are not available to the system or located in a
Preflight Pro Font Search Path.

Missing printer font. Lists printer fonts that are not found in the System Folder 
Fonts folder, or in a Preflight Pro Font Search Path 
with the screen font.

True Type font used in the document. Determines if a font used in the document is a TrueType font.

Multiple Master font used in the Determines if a font used in the document is a Multiple 
document. Master font.

Screen font menu styled Finds text that has an “Outline” menu style applied to it.
as “outline.”

Screen font menu styled Finds text that has a “Shadow” menu style applied to it. 
as “shadow.”

No printer font exists for menu style Finds menu styled fonts that do not have a corresponding 
applied to screen font. printer font.For instance, if a bold screen font has been menu

styled bold, Preflight Pro determines if it has a bold-bold 
printer font. If it doesn’t, this problem is reported.

Font sized too small. Flag fonts Finds text that has been sized smaller than the value entered 
sized below [specify] points in the Profile item.

Font sized below [specify] points, Finds text that has been sized smaller than the value entered  
and colored with [specify] in the Profile item, which is colored with the specified  

or more printing inks number of printing inks.

Font only used in an unused Finds fonts that are only used in an unused Style Sheet – 
Style Sheet. not used in any other part of the document.

Font used only on: [x] A Master Finds fonts that are only used on a Master page or the 
page [x] The pasteboard pasteboard – not in any other part of the document.

QuarkXPress Fonts profile items
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QuarkXPr ess Pictures Profile Section

Pictures profile items check for possible problems with pictures
created directly in the document and/or created in another applica-
tion before being placed in the document. Also checks for problems
related to missing disk files associated with placed pictures.

This profile item… Tests this condition…

Picture has been modified after the Finds pictures that have been modified on disk  
document was saved. after the document was saved.

Picture is missing. Finds pictures that have been deleted or moved on disk
after the document was saved.

Vector picture contains an embedded Looks for the original disk file for a picture embedded in a vector EPS.
picture with missing disk file. If it is not found with the EPS on disk, or in the place it was located

when it was saved into the EPS, this problem is reported.

No disk file exists for picture Determines when an embedded picture does not have a disk file—such
embedded in document. as a picture that was pasted into a picture box, rather than being 

imported into a picture box from a file on disk. 

A vector picture contains a linked, Determines when a picture was linked, instead of embedded,
not embedded, picture. in a vector picture.

Multi-file DCS picture is Looks for all five of the DCS picture files (file, file.C, file.M, file.Y, 
missing a plate file. file.K) on disk to determine if one of them is missing. 

High-resolution OPI picture is missing. Gets the path and name of the high resolution OPI picture from looking
inside the low resolution OPI picture. It then looks for the high resolution
picture on disk. If it’s not there, this problem is reported.

Picture is an OPI layout file. Determines if a picture is a low resolution OPI picture created by OPI
software—by looking for OPI version 1.3 or 2.0 comments inside the file.

Incorrect picture file formats: Flags picture file formats that match what is enabled for this profile item.
[x] PICT [x] TIFF [x] EPS [x] DCS 
[x] JPEG [x] Scitex CT

Import XTension for a picture is Flags pictures that require an XTension in order to be viewed or output
not available. correctly. For example, the Photoshop Import XT.

Picture is compressed. [x] LZW com- Determines if a TIFF was saved with LZW compression, or if an 
pressed TIFF [x] JPEG compressed EPS or DCS picture was saved with internal JPEG compression.
EPS  [x] JPEG compressed DCS

TIFF picture saved with extra channels. Determines if a TIFF picture was saved with extra channels.

Picture saved with custom Determines if a picture was saved with a custom line screen which
line screen. will override the document line screen on output.

Picture saved with a custom Determines if a picture was saved with a custom transfer function.
transfer function.

Picture clipping path flatness: Flags pictures which have clipping paths saved with a flatness
Less than [specify]  More than [specify] less or more than the value entered in the profile.

Clipping path created from non-white Flags pictures created with QuarkXPress version 4.0 that have a
pixels of picture, not embedded path. clipping path type of “Non-White Areas” set in the clipping path dialog.
(QuarkXPress 4.0)

QuarkXPress Pictures profile items
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Effective resolution of a color or gray- Calculates the effective resolution by finding the actual picture resolution
scale picture too low: the file was saved as, and how the picture is scaled on the page, then  
Less than [specify] times the line screen compares this value to the minimum resolution set in the Profile. If the line
Less than [specify] pixels per inch screen method is chosen, it will use the line screen set in the document

Output Instruction in the Job Jacket to calculate the needed resolution.

Effective resolution of a color or gray- Calculates the effective resolution by finding the actual picture resolution
scale picture is too high: the file was saved as, and how the picture is scaled on the page, then
More than [specify] times the line screen compares this value to the minimum resolution set in the Profile. If the line
More than [specify] pixels per inch screen method is chosen, it will use the line screen set in the document

Output Instruction in the Job Jacket to calculate the needed resolution.

Effective resolution of a bitmap (1-bit) Calculates the effective resolution by finding the actual picture resolution
picture is: the file was saved as, and how the picture is scaled on the page, then
More than [specify] times the line screen compares this value to the minimum resolution set in the Profile.
More than [specify] pixels per inch

Disproportionately scaled picture. Determines what the difference between the X and Y scaling of the
Horizontal and Vertical scaling picture in the picture box is, and compares it to the percentage entered
differs by [specify] percent. in the Profile.

EPS picture is cropped more than Compares the bounding box of the picture to the size of the picture box
[specify] percent. to determine how much of the picture is cropped, then compares this

figure to the value entered in the Profile.

Picture has been flipped horizontally Finds pictures that are flipped horizontally or vertically in a picture box.
or vertically.

Picture has been rotated or skewed Determines if a picture has been rotated or skewed in a picture box,
in the document. or if a picture box been rotated or skewed.

Style or contrast has been applied to Finds pictures with a QuarkXPress style applied to them through the
a picture in the document. Style menu. For example, Contrast or Screen.

Picture box with a background color Finds picture boxes with a background color applied to them,
contains a TIFF picture. that also contain TIFF format pictures

Picture box with a background “none” Finds picture boxes with a background color of “None” that also contain
contains a color or grayscale a TIFF or an EPS picture without a clipping path.
[x] TIFF picture or [x] EPS picture 
without a clipping path.

Picture box with a background “none” Finds picture boxes with a background color of “None” that also contain
contains a bitmap (1-bit) EPS picture a bitmap (1-bit) EPS picture saved without transparent whites.
saved without transparent whites.

Picture is only used on [x] A Master page Finds pictures that are only used on a Master page or the pasteboard—
[x] The pasteboard. not in any printing part of the document.

This profile item… Tests this condition…

QuarkXPress Pictures profile items (continued)
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QuarkXPr ess Colors Profile Section

The Color profile checks for possible problems with colors applied
to pictures or text within QuarkXPress,or with the color mode of
a picture—or text embedded in a picture—that was created in
another application.

This profile item… Tests this condition…

Incorrect number of printing inks Determines the total number of printing inks (separations) the 
as compared to the document document will output, and compares it to the Output Instructions
Output Instructions. assigned to the document in the Job Jacket.

A color’s value in the document Finds spot colors used in EPS pictures that have been converted
does not match the colors’ value to process in the QuarkXPress document, then compares the
in a picture. CMYK equivalent values for the color in the picture and the same

color in the QuarkXPress document. If these values are different,
this profile item is flagged.

Spot colors with identical values Finds spot colors that exist in the color palette with different
have different names. names, but with the same CMYK equivalent color values. For in-

stance, it will flag PANTONE 123 CV and PANTONE 123 CVC,
which have the same CMYK equivalent in QuarkXPress.

Total ink coverage of a color is Adds the C, M, Y, and K percentages together to see if the total
greater than [specify] percent. exceeds the value entered in the Profile.

Multi-Ink (Hi-Fi) color used. Finds colors that are defined as “Multi-Ink” in the document.

The color “Registration” is used Finds elements that are colored with the “Registration” color.
in a printing element.

RGB color mode picture is used Finds pictures used in the document that are saved in the
in the document. RGB color mode.

CMYK color mode picture is used Finds pictures used in the document that are saved in the
in the document. CMYK color mode.

Indexed color mode picture is used Finds pictures used in the document that are saved in the
in the document. Indexed color mode.

Monotone, duotone, tritone, or Finds pictures used in the document that are saved in the
quadtone picture is used in the monotone, duotone, tritone, or quadtone color mode.
document.

A TIFF picture is colorized in the Finds TIFF pictures that have a color applied to them in the
document. document, instead of in the actual image.

Rule or frame sized below Finds rules or frames in the QuarkXPress document that are
[specify] points used in document. sized smaller than the value specified in the Profile.

Rule or frame sized below [specify] Finds rules or frames in the QuarkXPress document that are
points, and colored with [specify] sized smaller than the value specified in the Profile and colored
printing inks. with the specified number of printing inks.

QuarkXPress Colors profile items
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QuarkXPr ess Trapping Profile Section

Trapping is the process of overlapping colors slightly, to solve the
problem of unsightly white areas in the printed piece when the
paper shifts on the press between printing one color and the next. 

Preflight Pro’s Trapping profile allows you to check and report
some of the common potential errors created when trapping is
done within a QuarkXPress document. Refer to the documenta-
tion provided with your QuarkXPress application for detailed
information about automated trapping.

This profile item… Tests this condition…

A page element has one of the Finds elements that have a user-defined trap of the specified
following trapping methods applied: type. This profile item does not flag these traps if they are 
[x] Overprint  [x] Knockout  [x] Auto applied with QuarkXPress auto-trapping.
Amount (+)   [x] Auto Amount (-)
[x] Custom

Color is saved with a custom Finds colors that are saved with a custom trap pair specified
trap pair. in the Trap Specifications dialog.

“Auto Amount” trap preference Checks the document “Auto Amount” trap preference to see if 
is not [specify] points. it matches the value entered in the Profile.

“Auto Method” trap preference Checks the document “Auto Method” trap preference to see if 
is not set to Absolute/Proportional. it matches the choice specified in the Profile.

“Ignore White” preference Checks to see if the “Ignore White” trap preference is enabled
is not enabled. or disabled.

“Overprint Limit” trap preference Checks the document “Overprint Limit” trap preference to see if 
is not [specify] percent. it matches the value entered in the Profile.

Process Trap preference Checks to see if the “Process Trap” preference is enabled
is not enabled. or disabled.

QuarkXPress Trapping profile items
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PageMaker Profiles

PageMaker Document Profile Section

Problem conditions in the Document profile items category affect
the whole document (such as page size, output set to reduce or
enlarge, etc.) as opposed to problem conditions which affect a
particular job element (such as Fonts,Graphics,Colors,Trapping). 

This profile item… Tests this condition…

Page size does not match paper trim Compares the page size of the document to the trim size 
size entered in the Document Output entered in the Job Jacket Output Instructions for the document.
Instructions

Document not saved in a Macintosh Flags PageMaker Windows version documents.
version of PageMaker.

Document output is set to be Determines if the document Print Setup is set to output at 
reduced or enlarged. more or less than 100%.

“Send Image Data” print setting Determines if the Send Image Data pop-up menu in the  
set to: [x] Normal   [x] Optimized Print dialog is set to one of the selected options.
Subsampling   [x] Low Resolution  
[x] Omit Images

Document output is set for “Proof.” Determines if the document Print Paper dialog is set to
output on “Proof.”

“Ignore non-printing” setting is Determines if the “Ignore Non-Printing” setting is enabled. 
enabled.

Page is set to not output Determines if a page has the “Display Master Page Items” menu
Master page items disabled (unchecked) in the Elements menu

Blank pages exist in the document. Finds pages that do not have elements on them.

Overflowed text box exists.  Finds text frames that have text that does not fit into the 
text frame.

PageMaker Document profile items
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PageMaker Fonts Profile Section

Most font problems occur when the document is moved to a
system with a different set of screen and printer fonts.

Some font types,such as TrueType and Multiple Master fonts,
and some style attributes,such as Outline and Shadow, while
printing properly to low and medium resolution Laser Printers,
will occasionally not output correctly to high resolution imageset-
ters and other imaging equipment.

This profile item… Tests this condition…

Missing screen font. Lists fonts that are not available to the system or located 
in a Preflight Pro Font Search Path.

Missing printer font. Lists printer fonts that are not found in the System Folder 
Fonts folder, or in a Preflight Pro Font Search Path  
with the screen font.

True Type font used in the Determines if a font used in the document is a TrueType font.
document.

Multiple Master font used in the Determines if a font used in the document is a Multiple 
document. Master font.

Screen font menu styled Finds text that has an “Outline” menu style applied to it.
as “outline.”

Screen font menu styled Finds text that has a “Shadow” menu style applied to it. 
as “shadow.”

No printer font exists for menu Finds menu styled fonts that do not have a corresponding 
style applied to screen font. printer font. For instance, if a bold screen font has been  

menu styled bold, Preflight Pro determines if it has a  
bold-bold printer font. If it doesn’t, this problem is reported.

Font sized too small. Flag fonts Finds text that has been sized smaller than the value 
sized below [specify] points entered in the Profile item.

Font sized below [specify] points, Finds text that has been sized smaller than the value 
and colored with [specify] entered in the Profile item, that is colored with  
or more printing inks the specified number of printing inks.

Font only used in an unused Finds fonts that are only used in an unused Style  
Style Definition. Definition – not used in any other part of the document.

Font used only on: [x] A Master Finds fonts that are only used on a Master page or the 
page [x] The pasteboard pasteboard – not in any other part of the document.

PageMaker Fonts profile items
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PageMaker Graphics Profile Section

Graphics profile items check for possible problems with graphics
created directly in the document and/or created in another applica-
tion before being placed in the document. Also checks for problems
related to missing disk files associated with placed graphics.

This profile item… Tests this condition…

Graphic has been modified after Finds graphics that have been modified  
the document was saved. on disk  after the document was saved.

Linked graphic is missing. Finds graphics that have been deleted or moved 
on disk after the document was saved.

Disk file for an embedded Looks for graphics that are embedded in the PageMaker
graphic is missing. document, but have but have a link to the disk file which is  

not where it was the last time the document was saved.

Vector graphic contains  Looks for the original disk file for a graphic 
an embedded graphic with embedded in a vector EPS. If it is not found with the 
missing disk file. EPS on disk, or in the place it was located when 

it was saved into the EPS, this problem is reported.

No disk file exists for graphic Determines when an embedded graphic does 
embedded in document. not have a disk file – such as a graphic that was  

pasted into a picture box, rather than being 
Placed into a picture frame from a file on disk.

A vector graphic contains a linked, Determines when a graphic was linked, instead 
not embedded, graphic. of embedded, in a vector graphic.

Multi-file DCS graphic is Looks for all five of the DCS graphic files (file, file.C, 
missing a plate file. file.M, file.Y, file.K) on disk to determine if one of 

them is missing. 

High-resolution OPI graphic Gets the path and name of the high resolution OPI 
is missing. graphic from looking inside the low resolution OPI graphic.

It  then looks for the high resolution graphic on disk. 
If it’s not there, this problem is reported.

Graphic is a low-resolution OPI Determines if a graphic is a low resolution OPI 
“layout” file. graphic created by OPI software—by looking for OPI 

version 1.3 or 2.0 comments inside the file.

Incorrect graphic file formats: Flags picture file formats that match what is enabled 
[x] PICT [x] TIFF [x] EPS  for this profile item.
[x] DCS [x] JPEG [x] Scitex CT
[x] GIF [x] BMP [x] WMP

Picture is compressed. [x] LZW com- Determines if a TIFF was saved with LZW compression,  
pressed TIFF [x] JPEG compressed or if an EPS or DCS picture was saved with 
EPS  [x] JPEG compressed DCS internal JPEG compression.

PageMaker Graphics profile items
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TIFF graphic saved with extra Determines if a TIFF graphic was saved with extra channels.
channels.

Graphic saved with custom Determines if a graphic was saved with a custom line screen
line screen. which will override the document line screen on output.

Graphic saved with a custom Determines if a graphic was saved with a custom.
transfer function. transfer function

Graphic clipping path flatness: Flags graphics which have clipping paths saved with a flatness
Less than [specify]  More than less or more than the value entered in the profile.
[specify]

Effective resolution of a color Calculates the effective resolution by finding the actual 
or grayscale graphic too low: graphic resolution the file was saved as, and how the
Less than [specify]  graphic is scaled on the page, then compares this value to the 
times the line screen minimum resolution set in the Profile. If the line screen method 
Less than [specify] pixels per inch is chosen, it will use the line screen set in the document Output 

Instruction in the Job Jacket to calculate the needed resolution.

Effective resolution of a color or Calculates the effective resolution by finding the actual 
grayscale graphic is too high: graphic resolution the file was saved as, and how the
More than [specify] times graphic is scaled on the page, then compares this value to the
the line screen minimum resolution set in the Profile. If the line screen method
More than [specify] pixels per inch is chosen, it will use the line screen set in the document Output

Instruction in the Job Jacket to calculate the needed resolution.

Effective resolution of a bitmap Calculates the effective resolution by finding the actual 
(1-bit) graphic is: More than graphic resolution the file was saved as, and how
[specify] times the line screen the graphic is scaled on the page, then compares
More than [specify] pixels per inch this value to the minimum resolution set in the Profile.

Disproportionately scaled graphic. Determines what the difference between the X and Y
Horizontal and Vertical scaling scaling of the graphic in the graphic frame is, and compares  
differs by [specify] percent. it to the percentage entered in the Profile.

EPS graphic is cropped Compares the bounding box of the graphic to the size of 
more than [specify] percent. the graphic frame or cropped graphic to determine how much 

of the picture is cropped, then compares this figure to the 
value entered in the Profile.

Graphic reflected horizontally Finds graphics that are reflected horizontally 
or vertically. or vertically on the page.

Graphic has been rotated or Finds graphics that have been rotated or .
skewed in the document. skewed in the document

Graphic is only used on [x] A Master Finds graphics that are only used on a Master page or  
page [x] The pasteboard. the pasteboard – not in any printing part of the document.

This profile item… Tests this condition…

PageMaker Graphics profile items  (continued)
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PageMaker Colors Profile Section

The Color profile checks for possible problems with colors applied
to graphics or text within PageMaker, or with the color mode of a
graphic—or text embedded in a graphic—that was created in
another application.

This profile item… Tests this condition…

Incorrect number of printing inks Determines the total number of printing inks (separations) the 
as compared to the document document will output, and compares it to the Output Instructions
Output Instructions. assigned to the document in the Job Jacket.

A color’s value in the document Finds spot colors used in EPS graphics that have been converted
does not match the colors’ value to process in the QuarkXPress document, then compares the
in a graphic. CMYK equivalent values for the color in the graphic and the same

color in the QuarkXPress document. If these values are different,
this profile item is flagged.

Spot colors with identical values Finds spot colors that exist in the color palette with different
have different names. names, but with the same CMYK equivalent color values. For in-

stance, it will flag PANTONE 123 CV and PANTONE 123 CVC,
which have the same CMYK equivalent in PageMaker.

Total ink coverage of a color is Adds the C, M, Y, and K percentages together to see if the total
greater than [specify] percent. exceeds the value entered in the Profile.

Multi-Ink (Hi-Fi) color used. Finds colors that are defined as “High-Fidelity” in the document.

The color “Registration” is used Finds elements that are colored with the “Registration” color.
in a printing element.

The color “Paper” is used in: Finds text and/or elements on the page colored with the
[x] Text  [x] Element “Paper” color.

RGB color mode graphic is used Finds graphics used in the document that are saved in the
in the document. RGB color mode.

CMYK color mode graphic is used Finds graphics used in the document that are saved in the
in the document. CMYK color mode.

Indexed color mode graphic is used Finds graphics used in the document that are saved in the
in the document. Indexed color mode.

Monotone, duotone, tritone, or Finds graphics used in the document that are saved in the
quadtone graphic is used in the monotone, duotone, tritone, or quadtone color mode.
document.

A TIFF graphic is colorized in the Finds TIFF graphics that have a color applied to them in the
document. document, instead of in the actual image.

Element contains a Pattern fill. Finds elements that have a Pattern fill applied to them through
the Element > Fill or Fill and Stroke menu.

PageMaker Colors profile items



PageMaker Trapping Profile Section

Trapping is the process of overlapping colors slightly, to solve the
problem of unsightly white areas in the printed piece when the
paper shifts on the press between printing one color and the next. 

Preflight Pro’s Trapping profile allows you to check and report
some of the common potential errors created when trapping is
done within a PageMaker document. Refer to the documentation
provided with your PageMaker application for detailed informa-
tion about automated trapping.
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This profile item… Tests this condition…

Rule or stroke sized below Finds rules or strokes in the PageMaker document that are
[specify] points used in document. sized smaller than the value specified in the Profile.

Rule or stroke sized below [specify] Finds rules or strokes in the PageMaker document that are
points, and colored with [specify] sized smaller than the value specified in the Profile and colored
printing inks. with the specified number of printing inks.

Rule or stroke sized below [specify] Finds rules or strokes in the PageMaker document that are
points, and set to Reverse. sized smaller than the value specified in the Profile and are

set to “Reverse” in the Element > Stroke menu.

PageMaker Colors profile items  (continued)

This profile item… Tests this condition…

PageMaker trapping has been enabled. Determines if the “Enable trapping for publication” option is enabled
in the Trapping Preferences dialog.

Trapping preference is set to trap Determines if the “Traps over imported objects ” option is enabled
over imported objects. in the Trapping Preferences dialog.

Color has a global overprint trap Determines if a color has the “Overprint ” option is enabled
setting enabled. in the Color Options dialog.

Trapping enabled with Trap Width Compares the “Trap width ” settings in the Trapping Preferences dialog
settings different than: to the values entered in the Profile.
Default: [specify] %  
Black Width: [specify] %

Trapping enabled with Trapping Compares the “Trap thresholds ” settings in the Trapping Preferences
Threshold settings different than: dialog to the values entered in the Profile.
Step Limit: [specify] %  
Centerline Threshold: [specify] %
Trap text above: [specify] %

Trapping enabled with Black Attribute Compares the “Black attribute ” settings in the Trapping Preferences 
settings different than: dialog to the values entered in the Profile.
Black Limit: [specify] %  
Auto-overprint black: [x] Text below 
[specify] points    [x] Strokes    [x] Fills

PageMaker Trapping profile items
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Creator2 Profiles

Creator2 Document Profile Section

Problem conditions in the Document profile items category affect
the whole document (such as page size, output set to reduce or
enlarge, etc.) as opposed to problem conditions which affect a
particular job element (such as Fonts,Graphics,Colors,
Trapping). 
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This profile item… Tests this condition…

Incorrect page size, as compared Compares the page size of the document to the trim size
to the trim size entered in the entered in the Job Jacket Output Instructions for the document.
Document Output Instructions.

Different size pages exist in Determines if the document has pages that are sized differently 
document. than each other, in the same document.

Document output is set to be Determines if the document Page Setup is set to output 
reduced or enlarged. at more or less than 100%.

Blank pages exist in the document. Finds pages that do not have elements on them.

Creator2 Document profile items
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Creator2 Fonts Profile Section

Most font problems occur when the document is moved to a
system with a different set of screen and printer fonts.

Some font types,such as TrueType and Multiple Master fonts,
and some style attributes,such as Outline and Shadow, while
printing properly to low and medium resolution Laser Printers,
will occasionally not output correctly to high resolution
imagesetters and other imaging equipment.

This profile item… Tests this condition…

Missing screen font. Lists fonts that are not available to the system or located in a
Preflight Pro Font Search Path.

Missing printer font. Lists printer fonts that are not found in the System Folder Fonts 
folder, or in a Preflight Pro Font Search Path with the screen font.

True Type font used in Determines if a font used in the document is a TrueType font.
the document.

Multiple Master font used in the Determines if a font used in the document is a Multiple 
document. Master font.

Screen font menu styled Finds text that has an “Outline” menu style applied to it.
as “Outline.”

Screen font menu styled Finds text that has a “Shadow” menu style applied to it. 
as “Shadow.”

No printer font exists for menu style Finds menu styled fonts that do not have a corresponding
applied to screen font. printer font. For instance, if a bold screen font has been menu 

styled bold, Preflight Pro determines if it has a bold-bold 
printer font. If it doesn’t, this problem is reported.

Font sized too small. Finds text that has been sized smaller than the value entered
Flag fonts sized below [specify] points in the Profile item.

Font sized below [specify] points, Finds text that has been sized smaller than the value  
and colored with [specify] entered in the Profile item, which is colored with the specified

or more printing inks number of printing inks.

Creator2 Fonts profile items
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Creator2 Graphics Profile Section

Graphics profile items check for possible problems with graphics
created directly in the document and/or created in another applica-
tion before being placed in the document. Also checks for problems
related to missing disk files associated with placed graphics.

This profile item… Tests this condition…

Graphic has been modified after the Finds graphics that have been modified on disk  
document was saved. after the document was saved.

Graphic is missing. Finds graphics that have been deleted or moved on disk
after the document was saved.

Vector graphic contains an  Looks for the original disk file for a graphic embedded in  
embedded graphic with missing a vector EPS. If it is not found with the EPS on disk,  place 
disk file. or in the it was located when it was saved into the EPS, 

this problem is reported.

No disk file exists for graphic Determines when an embedded graphic does not have 
embedded in document. a disk file – such as a graphic that was pasted onto the page. 

A vector graphic contains a linked, Determines when a graphic was linked, instead of embedded,
not embedded, graphic. in a vector graphic.

Multi-file DCS graphic is Looks for all five of the DCS 1.0 graphic files (file, file.C,  
missing a plate file. file.M, file.Y, file.K) on disk to determine if one of them is missing. 

High-resolution OPI graphic is Gets the path and name of the high resolution OPI graphic 
missing. from looking inside the low resolution OPI graphic. It then 

looks for the high resolution graphic on disk. If it’s not there, 
this problem is reported.

Graphic is an OPI layout file. Determines if a graphic is a low resolution OPI graphic 
created by OPI software—by looking for OPI version 1.3  
or 2.0 comments inside the file.

Incorrect graphic file formats: Flags graphic file formats that match what is enabled for 
[x] PICT [x] TIFF [x] EPS [x] DCS this profile item.
[x] JPEG [x] Photoshop [x] Other

Graphic is compressed. [x] LZW com- Determines if a TIFF was saved with LZW compression,  
pressed TIFF [x] JPEG compressed or if an EPS or DCS graphic was saved with internal 
EPS  [x] JPEG compressed DCS JPEG compression.

TIFF graphic saved with extra Determines if a TIFF graphic was saved with extra channels.
channels.

Graphic saved with custom Determines if a graphic was saved with a custom line 
line screen. screen which will override the document line screen on output.

Creator2 Graphics profile items
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Graphic saved with a custom Determines if a graphic was saved with a custom 
transfer function. transfer function.

Graphic clipping path flatness: Flags graphics which have clipping paths saved with 
Less than [specify]  a flatness or more than the value entered in the profile.
More than [specify]

Effective resolution of a color or Calculates the effective resolution by finding the actual 
grayscale graphic too low: graphic resolution the file was saved as, and how the graphic   
Less than [specify] times  is scaled on the page, then compares this value to the minimum
the line screen resolution set in the Profile. If the line screen method is 
Less than [specify] pixels per inch chosen, it will use the line screen set in the document Output 

Instruction in the Job Jacket to calculate the needed resolution.

Effective resolution of a color or Calculates the effective resolution by finding the actual 
grayscale graphic is too high: graphic resolution the file was saved as, and how the graphic  
More than [specify] times the is scaled on the page, then compares this value to the  
line screen minimum resolution set in the Profile. If the line screen method  
More than [specify] pixels per inch is chosen, it will use the line screen set in the document Output 

Instruction in the Job Jacket to calculate the needed resolution.

Effective resolution of a bitmap Calculates the effective resolution by finding the actual 
(1-bit)graphic is: More than [specify] graphic resolution the file was saved as, and how the graphic 
times the line screen is scaled on the page, then compares this value to the 
More than [specify] pixels per inch minimum resolution set in the Profile.

Disproportionately scaled graphic. Determines what the difference between the X and Y scaling 
Horizontal and Vertical scaling of the graphic in the graphic frame is, and compares it 
differs by [specify] percent. to the percentage entered in the Profile.

EPS graphic is cropped more Compares the bounding box of the graphic to the size of  
than [specify] percent. the graphic frame to determine how much of the graphic is crop- 

ped, then compares this figure to the value entered in the Profile.

Graphic has been flipped Finds graphics that are flipped horizontally or vertically 
horizontally or vertically. on the page.

Graphic has been rotated or Determines if a graphic has been rotated or skewed in 
skewed in the document. a graphic box, or if a graphic box been rotated or skewed.

Graphic box with a background Finds graphic frames with a background color applied 
color contains a TIFF graphic. to them,that also contain TIFF format graphics.

Graphic has a shadow defined. Finds graphics that have a shadow defined in the 
Graphic Info dialog.

Texture used in a Frame. Finds graphics that have a texture used in a Frame.

Texture used in Fill. Finds graphics that have a texture used in a Fill.

Texture used in Shadow. Finds graphics that have a texture used in a Shadow.

This profile item… Tests this condition…

Creator2 Graphics profile items (continued)
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Creator2 Colors Profile Section

The Color profile checks for possible problems with colors applied
to pictures or text within Creator2,or with the color mode of a
picture—or text embedded in a picture—that was created in
another application.

This profile item… Tests this condition…

Incorrect number of printing inks Determines the total number of printing inks (separations) the 
as compared to the document document will output, and compares it to the Output Instructions
Output Instructions. assigned to the document in the Job Jacket.

A color’s value in the document Finds spot colors used in EPS graphics that have been converted
does not match the colors’ value to process in the Creator2 document, then compares the
in a graphic. CMYK equivalent values for the color in the graphic and the same

color in the Creator2 document. If these values are different,
this profile item is flagged.

Spot colors with identical values Finds spot colors that exist in the color palette with different
have different names. names, but with the same CMYK equivalent color values. For in-

stance, it will flag PANTONE 123 CV and PANTONE 123 CVC,
which have the same CMYK equivalent in QuarkXPress.

Total ink coverage of a color is Adds the C, M, Y, and K percentages together to see if the total
greater than [specify] percent. exceeds the value entered in the Profile.

The color “Registration” is used Finds elements that are colored with the “Registration” color.
in a printing element.

RGB color mode graphic is used Finds graphics used in the document that are saved in the
in the document. RGB color mode.

CMYK color mode graphic is used Finds graphics used in the document that are saved in the
in the document. CMYK color mode.

Indexed color mode graphic is used Finds graphics used in the document that are saved in the
in the document. Indexed color mode.

Monotone, duotone, tritone, or Finds graphics used in the document that are saved in the
quadtone graphic is used in the monotone, duotone, tritone, or quadtone color mode.
document.

A TIFF graphic is colorized in the Finds TIFF graphics that have a color applied to them in the
document. document, instead of in the actual image.

Rule or frame pen weight sized below Finds rules or frames in the Creator2 document that are
[specify] points used in document. sized smaller than the value specified in the Profile.

Rule or frame pen weight Finds rules or frames in the Creator2 document that are
sized below [specify] points, sized smaller than the value specified in the Profile and colored
and colored with [specify] with the specified number of printing inks.
printing inks.

Multicolor gradient used. Finds elements with gradients that use more than two colors.

Creator2 Colors profile items
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Creator2 Trapping Profile Section

Trapping is the process of overlapping colors slightly, to solve the
problem of unsightly white areas in the printed piece when the
paper shifts on the press between printing one color and the next. 

Preflight Pro’s Trapping profile allows you to check and report
some of the common potential errors created when trapping is
done within a Creator2 document. Refer to the documentation
provided with your Creator2 application for detailed information
about automated trapping.

This profile item… Tests this condition…

Preference “New elements Determines the current state of the “New elements overprint
overprint Black by default” Black by default” preference in the General Preferences dialog.
is enabled/disabled.

Frame has a trap applied: Finds an element Frame that has one of the selected traps
[x] Overprint   [x] Knockout  applied to it in the Element Info dialog.
[x] Choke       [x] Spread

Fill has a trap applied: Finds an element Fill that has one of the selected traps
[x] Overprint   [x] Knockout  applied to it in the Element Info dialog.
[x] Choke       [x] Spread

Shadow has a trap applied: Finds an element Shadow that has one of the selected traps
[x] Overprint   [x] Knockout  applied to it in the Element Info dialog.
[x] Choke       [x] Spread

Creator2 Trapping profile items
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Graphic Application Profiles

Graphics Application Fonts Profile Section

Most font problems occur when the document is moved to a
system with a different set of screen and printer fonts.

Some font types,such as TrueType and Multiple Master fonts,
and some style attributes,such as Outline and Shadow, while
printing properly to low and medium resolution Laser Printers,
will occasionally not output correctly to high resolution imageset-
ters and other imaging equipment.

Graphics Application Colors Profile Section

Checks for possible problems with colors applied to pictures or text
within the document,or with the color mode of a graphic—or text
embedded in a graphic.

This profile item… Tests this condition…

Missing screen font. Lists fonts that are used in vector graphics and not available to  
the system or located in a Preflight Pro Font Search Path.

Missing printer font. Lists printer fonts, needed for a vector graphic, that are not found
in the System Folder Fonts folder, or in a Preflight Pro Font 
Search Path with the screen font.

True Type font used in the document. Determines if a font used in a vector graphic is a TrueType font.

Multiple Master font used in the Determines if a font used in a vector graphic is a Multiple
document. Master font.

Graphics Application Fonts profile items

This profile item… Tests this condition…

Incorrect number of printing inks Determines the total number of printing inks (separations) the 
as compared to the document graphic will output, and compares it to the Output Instructions
Output Instructions. assigned to the graphic in the Job Jacket.

Graphic saved in RGB color mode. Finds graphics that are saved in the RGB color mode.

Graphic saved in CMYK color mode. Finds graphics that are saved in the CMYK color mode.

Graphic saved in Indexed Finds graphics that are saved in the Indexed color mode.
color mode.

Graphic saved in Monotone, duotone, Finds graphics that are saved in the monotone, duotone, tritone,
tritone, or quadtone color mode or quadtone color mode.

Graphics Application Colors profile items
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Graphics Application Graphics Profile Section

Graphics profile items check for possible problems with graphics
created directly in the document and/or created in another applica-
tion before being placed in the document. Also checks for problems
related to missing disk files associated with placed graphics.

This profile item… Tests this condition…

Graphic document size does not Compares the size of the graphic to the trim size entered in the   
match paper trim size as set in the Job Jacket Output Instructions for the graphic.
Output Instructions.

Multi-file DCS graphic missing Looks for all five of the DCS graphic files (file, file.C, file.Y,
plate file. file.M, file.K) on disk to determine if one of them is missing. 

High-resolution OPI graphic is Gets the path and name of the high resolution OPI graphic from
missing. looking inside the low resolution OPI graphic. It then looks for 

the high resolution graphic on disk. If it’s not there, this 
problem is reported.

Graphic is a low-resolution OPI Determines if a graphic is a low resolution OPI graphic created
“layout” file. by OPI software—by looking for OPI version 1.3 or 2.0 comments

inside the file.

A vector graphic contains an Determines if a vector EPS contains an embedded graphic.
embedded graphic.

A vector graphic contains an Looks for the original disk file for a graphic embedded in a vector  
embedded graphic with missing EPS. If it is not found with the EPS on disk, or in the place it was
disk file. located when it was saved into the EPS, this problem is reported.

A vector graphic contains a linked, Determines when a graphic was linked, instead of embedded,
not embedded, graphic. in a graphic.

No disk file exists for embedded Determines when an embedded graphic (inside a vector
graphic. EPS graphic) does not have a disk file.

Incorrect graphic file formats: Flags graphic file formats that match what is enabled for this
[x] PICT [x] TIFF [x] EPS [x] DCS profile item.
[x] JPEG [x] Scitex CT [x] GIF 
[x] BMP [x] WMP [x] Illustrator [x] Other

EPS graphic created in an incorrect Determines if an EPS graphic was created by one of the specified
application: [x] Illustrator [x] Freehand applications.
[x] QuarkXPress [x] PageMaker 
[x] Creator2 [x] Photoshop
[x] Corel Draw [x] Other

Graphic is compressed. [x] LZW com- Determines if a TIFF was saved with LZW compression, or if an 
pressed TIFF [x] JPEG compressed EPS or DCS picture was saved with internal JPEG compression.
EPS  [x] JPEG compressed DCS

Graphics Application Graphics Profile items
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TIFF graphic saved with extra Determines if a TIFF graphic was saved with extra channels.
channels.

Graphic saved with custom Determines if a graphic was saved with a custom line screen. 
line screen.

Graphic saved with a custom Determines if a graphic was saved with a custom transfer
transfer function. function.

Graphic clipping path flatness: Flags graphics which have clipping paths saved with a flatness
Less than [specify] less or more than the value entered in the profile.
More than [specify]

Effective resolution of a color or Compares the graphic resolution to the minimum resolution set 
grayscale picture too low: Less in the profile. If the line screen method is chosen, it will use   
than [specify] times the line screen the line screen set in the document Output Instruction in the 
Less than [specify] pixels per inch Job Jacket to calculate the needed resolution.

Effective resolution of a color or Compares the graphic resolution to the maximum resolution
grayscale picture is too high: set in the profile. If the line screen method is chosen,
More than [specify] times it will use the line screen set in the document Output Instruction 
the line screen in the Job Jacket to calculate the needed resolution. 
More than [specify] pixels per inch

Effective resolution of a bitmap Compares the graphic resolution to the minimum and maximum 
(1-bit) picture is: More than resolutions set in the profile. 
[specify] times the line screen
More than [specify] pixels per inch

This profile item… Tests this condition…

Graphics Application Graphics profile items  (continued)
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Acrobat PDF Profiles

This section describes how Preflight Pro works with Acrobat
Exchange or Reader to find and report problem conditions for
Acrobat PDF documents.

This profile item… Tests this condition…

Incorrect page size, as compared
to the trim size entered in the
Document Output Instructions.

Document saved in version 
2.1/3.0 PDF compatibility.

Document uses Binary/ASCII 
format.

Document not saved with
“Optimized” enabled in the 
Save dialog.

Document is damaged and needs
repair on Open.

Document security Does/Does Not
allow printing.

Document security Does/Does Not
allow editing.

Incorrect number of pages.

Document has different size
pages.

Blank pages exist in the docu-
ment.

Document created with the Adobe
PDFWriter print driver.

Document description 
contains PostScript code.

Compares the page size of the PDF to the page size entered in
the Job Jacket Output Instructions for the document.

Compares the PDF compatibility to the compatibility chosen in the
profile.

Compares the document format (ASCII or Binary) to this profile
item.

Determines if the document was saved as “Optimized” in the Save
dialog.

Determines if the document is damaged and needs repair.

Determines if the document was saved with a password, to pro-
hibit printing.

Determines if the document was saved with a password, to pro-
hibit editing.

Determines how many pages are in the PDF and compares it to
the setting in the profile.

Compares the page size of each page in the PDF to see if any dif-
fer.

Determines if the PDF has any blank pages in it.

Determines if the PDF was created with the Adobe PDFWriter
print driver.

Determines if the PDF contains PostScript code.

Acrobat PDF Document profile items
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This profile item… Tests this condition…

Font is not embedded in the docu-
ment. (excludes base 14 fonts)

Embedded font is/is not subsetted.

TrueType font is used in the 
document.

Multiple Master font is used in the
document.

Font has “Bold” menu style
applied.

Font has “Italic” menu style
applied.

Font has “Outline” menu style
applied.

Type 3 font is used in the 
document.

Font sized too small.

Font sized below X points, and
colored with X or more printing
inks.

“Courier” font is used in the 
document.

Determines if a font used in the PDF was not embedded in the
PDF. This excludes the base 14 fonts, which are not embedded by
Distiller.

Determines if a font used in the PDF is or is not subsetted.

Determines if a font is a TrueType font.

Determines if a font is a Multiple Master font.

Determines if a font has a “Bold” menu style applied.

Determines if a font has a “Italic” menu style applied.

Determines if a font has a “Outline” menu style applied.

Determines if a font is a Type 3 fonts.

Finds fonts sized below the size entered in the profile.

Finds fonts sized below the size entered in the profile, colored
with the number of printing inks entered in the profile.

Determines if the font named “Courier” is used in the document.

Acrobat PDF Font profile items
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This profile item… Tests this condition…

Effective resolution of a color or
grayscale picture too low.

Effective resolution of a color or
grayscale picture too high.

Effective resolution of a bitmap 
(1-bit) picture is too low, or too
high.

Picture is a low-resolution OPI 
layout file.

High-resolution OPI picture is
missing.

Picture has been rotated or
skewed in the document.

Text and Line Art is
compressed/not compressed.

Incorrect Color or Grayscale
image compression scheme used. 

Incorrect Monochrome Bitmap
image compression scheme used.

Calculates the effective resolution by finding the actual graphic
resolution the file was saved as, and how the graphic is scaled on
the page, then compares this value to the minimum resolution set
in the Profile. If the line screen method is chosen, it will use the
line screen set in the document Output Instructions in the Job
Jacket to calculate the needed resolution.

Calculates the effective resolution by finding the actual graphic
resolution the file was saved as, and how the graphic is scaled on
the page, then compares this value to the minimum resolution set
in the Profile. If the line screen method is chosen, it will use the
line screen set in the document Output Instructions in the Job
Jacket to calculate the needed resolution.

Calculates the effective resolution by finding the actual graphic
resolution the file was saved as, and how the graphic is scaled on
the page, then compares this value to the minimum resolution set
in the Profile.

Determines if a graphic is a low resolution OPI graphic created by
OPI software—by looking for OPI version 1.3 or 2.0 comments
inside the file.

Gets the path and name of the high resolution OPI graphic from
looking inside the low resolution OPI graphic. It then looks for the
high resolution graphic on disk. If it’s not there, this problem is
reported.

Finds graphics that have been rotated or skewed in the document

Determines if text and line art are compressed in the PDF.

Determines if a color or grayscale image was compressed with
JPEG or ZIP/LZW compression. Note: The level of compression
can not be reported because it is not saved in the PDF file.

Determines if a Monochrome Bitmap image was compressed with
CCITT Group 3, CCITT Group 4, ZIP/LZW, or Run Length com-
pression.

Acrobat PDF Graphic profile items
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This profile item… Tests this condition…

Incorrect number of printing inks
as compared to the Document
Output Instructions.

RGB color mode picture used in
the document.

Indexed color mode picture used
in the document.

CMYK color mode picture used in
e document.

The color “Registration” is used in
a printing element.

Total ink coverage of a color is
greater than X percent.

Rule or frame sized below X
points, is used in the document.

Rule or frame sized below X
points, and colored with X or 
more printing inks.

Determines the total number of printing inks (separations) the doc-
ument will output, and compares it to the Output Instructions
assigned to the document in the Job Jacket.

Finds graphics used in the document that are saved in the RGB
color mode.

Finds graphics used in the document that are saved in the
Indexed color mode.

Finds graphics used in the document that are saved in the CMYK
color mode.

Finds elements that are colored with the “Registration” color.

Adds the C, M, Y, and K percentages of a process color together
to see if the total exceeds the value entered in the Profile.

Finds rules or strokes in the PageMaker document that are sized
smaller than the value specified in the Profile.

Finds rules or strokes in the PageMaker document that are sized
smaller than the value specified in the Profile and colored with the
specified number of printing inks.

Acrobat PDF Color profile items
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Appendix B—Problems/Solutions

This appendix provides a quick reference source for all the
QuarkXPress, PageMaker, Creator2, Graphics, and Acrobat PDF
problem items, descriptions, and solutions found in Preflight Pro.
Each Problem Item listed here is a Profile item available on the
indicated Section tab in the Profile dialog. Just refer to the appro-
priate Problem Item when looking for help with document prob-
lems. (See the User Guide PDF on the Extensis CD for Creator2
and Graphic Problems/Solutions.)

Tip

You can copy these pages and use
them to create templates for Profiles
as you design and configure them.

The page size of the document may be larger or smaller than expected.
This item compares the document page size to the trim size you specify
for the document in the Job Jacket Output Instructions. If necessary,
change the page size in the document to match the job trim size. Another
option might be to print the document at a reduced or enlarged size.

This document was not saved in a Macintosh version of QuarkXPress.
There may be conversions taking place that will cause text and pictures to
reflow on the pages. Proof each page to make sure everything is as
expected.

The document will output smaller or larger than the document page size if
the “Scale” value in the Page Setup dialog is not set to 100%.  If this job
is not being output reduced or enlarged, the proof may have been output
at an incorrect size. If the proof will be used for determining scaling for
scanning, output a new proof at the correct size.

If “low resolution” is chosen in the Print dialog, QuarkXPress will only out-
put the previews of the pictures in the document. Bitmap EPS pictures
can show transparency that will not exist when output is set to normal.
Some grayscale and CMYK EPS files may also exhibit this effect. To out-
put the high-resolution pictures, change the Output pop-up in the Print
dialog to "Normal."

If “rough” is chosen in the Print dialog, QuarkXPress will not output the
pictures in the document. To output the high-resolution pictures, change
the Output pop-up in the Print dialog to "Normal."

An element is set to “Suppress Printout”. The element will not be printed.
Verify that this element should not be printed. If it does, enable the printing
of this element by selecting the element on the page, choosing "Modify"
from the Item menu, and unchecking the "Suppress Printout" checkbox.

Blank pages in the document will be output if the “Include Blank Pages”
checkbox is checked in the Print dialog. For film, this is unnecessary. For
press impositions, it is preferred if the job actually has blank pages. If you
do not need blank placeholders in the digital file, uncheck the “Include
Blank Pages” checkbox in the Print dialog.

Overflowed text boxes contain type that disappears at the bottom of a text
box. Some text may not be printed.

Page size does not match
paper trim size set in docu-
ment Output Instructions.

Document not saved in a
Macintosh version of
QuarkXPress.

Document output is set to
be reduced or enlarged.

Document output is set for: 

Item on page is set to
suppress on printout.

Blank pages exist in the
document.

Overflowed text box exists.

QuarkXPress Document profile items
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Low Resolution

Rough



QuarkXPress Fonts profile items

If a screen font is not available to the system, text in the document may
reflow and print incorrectly. To ensure accuracy and reduce the chance of
reflow, locate and activate the font used to create the document. Configur-
ing a Preflight Pro Font Search Path may find the screen font, but it won't
activate it. Be sure to activate the font before printing the document.

A missing printer font may be substituted as Courier, or as a bitmap
(jagged) version of the font. If a font with the same name is present on the
RIP, that font will be used. Customized characters in the original font may
not be in the version of the font located on the RIP and will be missing in
the final output. To ensure proper output, use the copy of the font that was
used to create the document.

A TrueType font does not print to a “PostScript Only” output device such
as an imagesetter RIP. Choose “include all fonts” in the Print dialog when
printing. Also be sure to choose the correct PPD for your output device. If
the TrueType font is “included” in the PostScript print stream, or file, the
LaserWriter printer driver converts it to usable PostScript outlines that
image correctly. As a policy, test this process through your workflow.

Multiple Master fonts can cause an output error on output devices that
cannot handle fonts larger than 300K. Use updated font management
tools and choose “include all fonts” in the Print dialog when printing the
file. As a policy, test this process through your workflow.

An “Outline” styled font prints well to a laser printer, but on a high resolu-
tion device the outlines may become much thinner. The style may look
even thinner if Computer-to-Plate processing is used. Choose a font that
has a true outline style, or convert the font to a graphic in a vector draw-
ing program and apply a stroke of a specific width.

A high resolution device may output “Shadow” styled fonts much lighter
than a low resolution device, such as a laser printer. Duplicate the affect-
ed characters in QuarkXPress, offset them, and apply a specific screen
value. This will result in controllable screen values.

No printer font exists for this menu-styled font. A menu styled font is one
that is bolded or italicized from a style menu. On screen it may appear
with the menu style, but the actual screen font may call to a printer font
that does not reflect this same style. e.g. Helvetica Black bolded will be
output as Helvetica Black without the bold style applied because there is
not a bold version of Helvetica Black. Possibly substitute a font that
appears to be the same, without any menu style applied to it.

A small point sized font may reproduce badly on press and be difficult to
read. Increase the point size of the font, if possible.

Missing screen font.

Missing printer font.

TrueType font used in the
document.

Multiple Master font used in
the document.

Screen font menu styled as
“Outline.”

Screen font menu styled as
“Shadow.”

No printer font exists for
menu style applied to
screen font.

Font sized too small. 

Flag fonts sized below: 
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A small point sized font, colored with screen tints, may reproduce badly
on press and be difficult to read. Color the font with a Printing Ink (spot
color), or increase the point size of the font, if possible.

If a font is only used in a Style Sheet, it will have no impact on printability
of the job. Any warning about this font, if missing, can be ignored, or the
Style Sheet can be deleted so others won't think a font is missing if it is
not delivered with the document.

Master page: When opening a QuarkXPress document, the application
will list all missing fonts - even fonts that are only used on a Master page.
The Font Usage dialog will not report these fonts as being needed, so it
can be confusing as to what is needed to output the job. If a font is only
used on a Master page, it will have no impact on the printability of the job.
Any warning about this font, when missing, can be ignored, or the use of
this font can be deleted so others won't think a font is missing if it is not
delivered with the document.

Pasteboard: If a font is only used on the pasteboard, it will have no impact
on the printability of the job. Any warning about this font, when missing,
can be ignored, or the use of this font can be deleted so others won't
think a font is missing if it is not delivered with the document.

Font sized below 

is colored with

Font only used in an
unused Style Sheet.

Font only used on: 
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QuarkXPress Pictures profile items

A modified picture is a picture that has been edited after it was placed
in the document. The picture may output in a different position inside
the picture box due to the picture not being updated in the document.
To update the picture in the document, choose the picture in the
Picture Usage dialog, and click the Update button.

A missing picture is a picture that has been moved or renamed on disk
after it was placed in the document. Missing pictures will cause
QuarkXPress to print the low resolution previews of the pictures, instead
of the high resolution pictures. To relink the missing picture to the docu-
ment, choose the picture in the Picture Usage dialog, click the Update
button, and select the picture in its new location. If the picture's name was
changed, it will either have to changed back to its original name, or
imported into the picture box again.

If the original disk file for an embedded picture is missing on disk,
changes can not be made to the picture. These are commonly PICT
screen captures that were pasted onto the page before the EPS was cre-
ated and may also be in RGB color mode. If the embedded picture is
acceptable for proper output (proper color mode, resolution, etc.), there
will not be a need to edit the original, so this problem may be ignored.

This picture does not have an original disk file located on disk. This
means the picture was either pasted into the picture box or dragged-and-
dropped onto the page from another application. It will be output as a
PICT format picture, which can not be in CMYK color mode. It is common-
ly in RGB color mode, and low resolution.  Low resolution pictures will
give you poor output, and RGB color mode pictures will not separate
properly. To get these pictures to separate properly, they can be opened
in an image-editing application, saved as CMYK, and imported into the
picture box. The resolution of these pictures can only be increased by res-
canning the image, or adjusting it in an image-editing application.

If a vector graphic contains a linked, not embedded, graphic, it will not be
found by QuarkXPress when output. In such cases, QuarkXPress will
print a low-resolution preview of the picture. When saving files in a vector
drawing program, there is an option to store a placed picture in the EPS.
If this is not done, the graphic is often lost or not sent with the job. In
Adobe Illustrator, the option to embed is available when the file is saved
or exported. In Macromedia FreeHand, the graphic can be embedded
based on preferences when the graphic is imported or placed. To avoid
missing graphics or graphics not printing, embedding is recommended.
Also be sure to have the colors in the graphic properly defined as spot or
process before saving the file, or the output provider may have problems
getting the colors to print.

DCS files consist of a preview and multiple plate files (usually CMYK). All
these plate files are necessary for successful separation. When printed
composite, the preview file is sent to the output device. If any of the other
files are missing, they must be located and placed in the same folder as
the preview file to output properly.

Picture has been modified
after the document was
saved.

Picture is missing.

Vector picture contains an
embedded picture with
missing disk file.

No disk file exists for
picture embedded in
document.

A vector picture contains
a linked, not embedded,
picture.

Multi-file DCS picture is
missing a plate file.
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The high resolution version of an OPI picture can not be found. This may
be because the volume it exists on is not currently available to this
machine, or it may in fact be missing. If it is missing, it may not be output
when the document is printed. If the high resolution location/volume
becomes available, reinspect the document so the high resolution picture
data can be inspected for any printing problems. The name and location of
the high resolution picture is obtained by looking at the OPI "comments"
inside the low resolution OPI "layout" picture used in the document. 

This is a low resolution picture created by an OPI picture replacement
program. Preflight Pro does not check resolution, color or image quality in
this file. It will attempt to find the high resolution version of the picture and
report problems, if they exist, for that picture. You should replace this pic-
ture with the high resolution version, if you are not printing to an OPI serv-
er and want high resolution output.

PICT: PICT pictures originate primarily from 72 DPI screen captures and
are usually in RGB color mode. If left RGB they may output as grayscale
on all plates or may print on only one plate. If sent to a composite color
RIP, the picture is converted at the default settings in the RIP. On rare
occasions, PICT files are encountered that have vector and raster data.
These cause output errors on some RIPs. If screen captures are to be
printed in color, convert them to CMYK in an image-editing application,
and save them as a TIFF or EPS. Tip: Test separating with Maximum
GCR. This will remove C,M,Y from under pure black areas and make
these pictures easier to register on press.

TIFF: If you turn on this alert, there must be some issue in your process
that causes this picture format to be a problem. In general it is one of the
best formats to save a file in. There is NO final image quality difference
between a TIFF and an EPS. The previews differ and the EPS has some
features not available in TIFFs.

EPS: If you turn on this alert, there must be some issue in your
process that causes this picture format to be a problem. In general it is
one of the best formats to save a file in. There is NO final image quali-
ty difference between an EPS and a TIFF. The previews differ and the
EPS has some features not available in TIFFs.

DCS: If you turn on this alert, there must be some issue in your process
that causes this picture format to be a problem. In general, it is a widely
used format. This format allows documents to be proofed quickly to a
laser printer because most of this type of proofing is done composite and
the low resolution file is used. 

JPEG: If you turn on this alert, there must be some issue in your process
that causes JPEG pictures to be a problem. A solution may be to open the
picture in an image-editing application and save it in a different file format
that works for your workflow.

SCITEX CT: If you turn on this alert, there must be some issue in your
process that causes this picture format to be a problem. In general, it is
widely used and works with most postscript devices. This file type is in
Handshake format on the map and performs like a TIFF. A solution may
be to open the picture in an image-editing application and save it in a dif-
ferent file format that works for your workflow.

OTHER: Means that this picture is not one of the common file formats
used in desktop publishing and is likely to cause an output problem. 

High-resolution OPI picture
is missing.

Picture is a low-resolution
OPI “layout” file.

Incorrect picture file
formats: PICT, TIFF, EPS,
DCS, JPEG, Scitex CT,
Other
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A picture in the document needs a Quark XTension installed to be output
properly. These pictures may be output as low resolution PICT images,
without the XTension installed. The Photoshop Import XTension is the
most common example of this problem -if it's not installed, Photoshop pic-
tures can not be output properly.

A compressed picture can be problematic on a PostScript RIP.

LZW TIFF: LZW decompression can cause delays on Level 1 PostScript
output devices, but work fine on PostScript Level 2 devices. If output
problems are encountered with this picture, resave the picture without
compression.

JPEG EPS: EPS pictures with JPEG compression can cause Level 1
devices to fail. If a picture has been JPEG compressed more than once, it
may lose noticeable picture detail. If the quality has become poor, only
rescanning will fix it. It the picture looks good on proofs and it is being
sent to a Level 2 output device, it should print fine.

JPEG DCS: DCS pictures with JPEG compression can cause Level 1
devices to fail. If a picture has been JPEG compressed more than once, it
may lose noticeable picture detail. If the quality has become poor, only
rescanning will fix it. It the picture looks good on proofs and it is being
sent to a Level 2 output device, it should print fine.

A TIFF picture with extra channels will cause some output device RIPS to
fail. These pictures can be resaved in an image-editing application without
the extra channels to output properly. In general, document originators
should remove all extra data from pictures that are ready for output.

If a picture is saved with a custom line screen, it will be imaged at that line
screen. This may result in a picture that prints differently than other pic-
tures in the same document. Custom curves are ignored if the image is
sent to a composite color RIP. Two different screens cannot be applied on
composite color RIPs.

Pictures saved with custom functions may not output correctly. The curve
may cause the picture to print differently than it appears on-screen, or the
curve may be ignored if sent to a composite color RIP. For composite
color RIPs the curve should be applied to the picture in an image-editing
application prior to placing the picture in the document for output.

Too low of a flatness setting for a path may create an excessive amount of
points on the clipping path, slowing down output time and sometimes fail-
ing to RIP. Most Level 2 RIPs have made flatness setting unnecessary.
increase flatness of path in an image-editing application, if needed.Too
high of a flatness setting may cause a graphic to print with edges that are
flat or angular, instead of rounded. The formula for flatness is the setting in
device pixels divided by output device resolution. The result is the amount
of flatness that will occur. e.g. 8 (setting)/300 (Output device res) = .026 or
almost 2 points of flatness. This would be very noticeable on a laser print-
er. On an imagesetter, the same number 8/2400 = .003 which is fine.

Import XTension for a
picture is not available.

Picture is compressed:
LZW compressed TIFF 
JPEG compressed EPS
JPEG compressed DCS

TIFF picture saved with
extra channels.

Picture saved with custom
line screen.

Picture is saved with a
custom transfer function.

Picture clipping path
flatness: 

QuarkXPress Pictures profile items  (continued)
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This picture will be output with a QuarkXPress clipping path created from
“Non-White Pixels.” The quality of these paths is not as good as an em-
bedded path. We recommend using an image-editing application to create
an embedded path in the picture. If this is done, you will need to specify
“Embedded Path” for the picture in the QuarkXPress Clipping dialog.

If the resolution of a color or grayscale graphic after scaling in
QuarkXPress is too low, pixels may be prominent on output and the pic-
ture will appear jagged. Rescan the image at a higher resolution, or
decrease the scaling of the graphic on the page to increase the resolu-
tion. The correct resolution is 1.5 to 2  times the output line screen at the
final image size after scaling it on the page.

If the resolution of a color or grayscale graphic after scaling in Quark-
XPress is too high, it will take longer to output than necessary. Excess
resolution does not result in an improvement in quality. If there are many
of these or if the excess resolution is significant, investigate sampling the
data down in an image-editing application. The correct resolution is 1.5 to
2 times the output line screen at the final image size after scaling in a
page layout program.

If the effective resolution of a bitmap graphic after scaling in QuarkXPress
is too low, the graphic may appear jagged.  Each shop or customer may
have their own acceptable range.  A general minimum is 300 DPI. The
maximum is usually around 2400 DPI (or the writing engine resolution).
The most common range is between 800 and 1200 DPI. Rescan the
image at a higher resolution, or decrease the scaling of the graphic on the
page to increase the resolution.

If the effective resolution of a bitmap graphic after scaling in QuarkXPress
is too high, the file will take longer than necessary to output.  Each shop
or customer may have their own acceptable range.  A general minimum is
300 DPI. The maximum is usually around 2400 DPI (or the writing engine
resolution). The most common range is between 800 and 1200 DPI. If
many images are above final imagesetter resolution they can be reduced
in resolution in an image-editing application. 

A picture has been scaled more in one direction than the other.
Sometimes this is accidental and the document author would like to be
notified of this condition. Other times this is done to correct the fit of a pic-
ture if it falls short in one direction. There is no issue with reproducing
these images. Note that depending on the amount of disproportionate
scaling that has been done, the resolution on one direction may fall below
the recommended minimum.

Clipping path created from
non-white pixels of picture,
not embedded path.
(XPress 4.0)

Effective resolution of a
color of grayscale picture
too Low. Less than:

Effective resolution of a
color of grayscale picture
too High. More than:

Effective resolution of a
bitmap (1-bit) picture is:

Disproportionately scaled
picture. Horizontal and
Vertical scaling differs by:
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EPS files with raster data can be very large. When processed through a
page layout program, all EPS data is preserved in the file even if only a
small portion is visible through a picture box. This results in much more
data being included in the print stream or PostScript file. If a clipping path
or other EPS-specific effect is not needed, a TIFF file format may be a
better choice because TIFFs are actually cropped prior to the data being
written into the print stream.

While flipping a picture is fine with QuarkXPress, some OPI servers will
not handle it correctly. The high resolution picture may not be flipped
when the low resolution “for placement only” picture has been flipped in
the picture box. It is preferable to flip the original picture in an image-edit-
ing application before bringing it into the picture box.

Rotated or skewed picture can increase the output time of the document
and occasionally activate bugs in OPI servers or imposition programs -
which will cause items not to print or move out of position at print time.

Style settings applied to pictures in QuarkXPress are not always
processed correctly when sent to a composite color output device. These
effects should be applied to the picture in an image-editing program prior
to placing the picture in the document for output.

Applying a color to a picture box behind a TIFF picture can cause some
OPI servers and RIPs to fail. Other output devices may print the job in two
colors but without a trap needed for a good fit on press. It’s best to set the
picture box background color to White or 0% Black.

Pixels with a value of 0% in these pictures may cause pixelated edges on
output if the background of the picture box is colored "None." This pixela-
tion is particularly noticeable in the diagonal elements in a picture.
Changing the picture box background color to White or 0% of a color will
fix this problem. If the picture is over a colored background, a clipping
path must be created and the image saved as an EPS. 

When the color of a picture box is set to “None” in QuarkXPress, the mon-
itor may display parts of the picture as being transparent. These parts will
not print transparently unless the bitmap (1-bit) EPS is saved with
Transparent Whites in an image editing application.

A picture that is only located on a Master page will not print. However, it
will be reported in the Picture Usage dialog just as any other picture. It
can add colors to the document color palette that may not be used.  And
it will be collected with the job, even though it is not needed for proper
output.

A picture located on the pasteboard will be listed in the Picture Usage dia-
log even though it is not used on any printed page. It can add colors to
the document color palette that may not be used. And it will be collected
with the job, even though it is not needed for proper output.

EPS picture is cropped
More than:

Picture has been flipped
horizontally or vertically.

Picture has been rotated or
skewed in the document.

Style or contrast has been
applied to a picture in the
document.

Picture box with a
background color contains
a TIFF picture.

Picture box with background
“None” contains specified
color or grayscale TIFF
picture or raster EPS
without a clipping path. 

Picture box with background
“None” contains a bitmap
(1-bit) EPS picture saved
without transparent whites.

Picture is only used on:
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An incorrect number of printing inks will result in the output of extra plates
when printing separations. This item compares the number and type of
colors the document will output to the colors specified in the Job Jacket
Output Instructions for the document. Unneeded spot colors should be
converted to process. To do this, select each spot color in the Color dia-
log, click the Edit button, and check the "Process Separation"
(QuarkXPress 3.3) or "Spot Color" (QuarkXPress 4) checkbox.

Colors that have the same name, but different CMYK definitions, may
appear different on output. This occurs when a spot color defined in an
EPS picture is redefined in the QuarkXPress document as process, and
its CMYK values are changed.  This type of color value change will only
affect the color used in the document -not the EPS picture -which means
the colors won't match when they are output.  To ensure a proper color
match, change the color values of the color in the document, or EPS pic-
ture to match.

Two spot colors in this document have the same color values.  When
color naming conventions are different in applications that create EPS pic-
tures, colors can be imported into the QuarkXPress color palette with a
different name, but with the same color values as an existing color. This
will cause what should be a single color to be output on two separate
plates. To fix this, the name of the color in the QuarkXPress document
can be changed to match the name of the color defined in the graphic.

The total ink coverage of this color is too high. Certain printing conditions
can only support so much ink on paper. If too much ink is placed, it caus-
es problems. Adjustments must be made to the color's total ink usage to
be printed properly.

This color is defined as a Multi-Ink color. This means it is a process color
which will be separated into more than the standard CMYK printing ink
plates. To get a list of the other printing inks used in this color, double-
click the name in the Preflight Pro Consolidated Report or Color Tab, or
view the color settings of the color in the QuarkXPress Edit Color dialog.

The color “Registration” is meant to be used for items that need to print
on all plates. Usually, this is used for registration marks. It is sometimes
mistaken as the color Black in the color palette. If this is the case, replace
each occurrence with the proper color.

RGB color mode pictures must be converted to CMYK color mode before
they are able to separate properly on output. Some RIPs can make the
conversion, but the results may not be acceptable. It is best if this is done
in an image-editing application, such as Adobe Photoshop. 

This picture was saved in the CMYK color mode. If your workflow does
not require CMYK color mode pictures, you may choose to change the
color mode of the picture in an image-editing application. If this is done,
be sure to also update its reference in the document by choosing
"Update" in the Picture Usage dialog.

Incorrect number of printing
inks as compared to the
document Output
Instructions.

A color’s value in the docu-
ment does not match the
color’s value in a picture.

Spot colors with identical
values have different
names.

Total ink coverage of a
color is greater than:

Multi-Ink (Hi-Fi) color used.

The color “Registration” is
used in a printing element.

RGB color mode picture is
used in the document.

CMYK color mode picture
is used in the document.
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Indexed color pictures usually come from the Internet and have a severely
reduced color palette. They will print with reduced colors even if they are
converted to CMYK. Colors eliminated in the original conversion cannot
be restored. Rescan the picture, if possible, or print a color proof to see
how it looks on output.

Pictures saved in this color mode can print as grayscale, or fail to print on
some composite RIPs. If this is the case for your system, convert the pic-
ture to multichannel or CMYK in an image-editing application before send-
ing it to a composite RIP.

Applying a color to a bitmap (1-bit) or grayscale color mode TIFF picture
can cause some OPI servers and RIPs to fail, or on some systems, the
picture will not be colorized on output. If this is the case with your system,
applying the color to the picture in an image-editing application before it is
used in the document will allow the picture to be output properly.

A rule or frame width is sized too small for printing clearly. Increasing the
size of the rule or frame will allow it to be printed clearly.

A rule or frame width is sized too small for printing clearly. This happens
most commonly when a rule or frame is colored with a process color.  If
the registration during printing is off, the colors won’t overlap and will
appear distorted. Increasing the size of the rule or frame, or changing the
color to a single color will allow it to be printed clearly.

Indexed color mode picture
is used in the document.

Monotone, duotone, tritone
or quadtone picture is used
in this document.

A TIFF picture is colorized
in the document.

Rule or frame sized Below
specified size is used in the
document.

Rule or frame sized Below
specified points, and
colored with specified
number of printing inks.
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OVERPRINT: This element has a user-defined Overprint trap applied. If
you wish to remove or change the trap, select the element with the Show
button in the Pilot palette, choose "Show Trap Information" from the View
menu, and change the values on the Trap Information palette.

KNOCKOUT: This element has a user-defined Knockout trap applied. If
you wish to remove or change the trap, select the element with the Show
button in the Pilot palette, choose "Show Trap Information" from the View
menu, and change the values on the Trap Information palette.

AUTO AMOUNT (+): This element has a user-defined Auto Amount (+)
trap applied. If you wish to remove or change the trap, selecting the ele-
ment with the Show button in the Pilot palette, choose "Show Trap
Information" from the View menu, and change the values on the Trap
Information palette.

AUTO AMOUNT (-): This element has a user-defined Auto Amount (-) trap
applied. If you wish to remove or change the trap, select the element with
the Show button in the Pilot palette, choose "Show Trap Information" from
the View menu, and change the values on the Trap Information palette.

CUSTOM: This element has a user-defined Custom trap applied. If you
wish to remove or change the trap, select the element with the Show but-
ton in the Pilot palette, choose "Show Trap Information" from the View
menu, and change the values on the Trap Information palette.

This color has a custom trap pair setting configured in the Trap
Specifications dialog which will override the built-in trapping in
QuarkXPress. The color has a predetermined trapping relationship with
one or more other colors. It can be viewed and/or edited in the Trap
Specifications dialog found in the Define Colors dialog.

The Auto Amount trap preference can be changed in the QuarkXPress
Trapping Preferences dialog to match your preferred value. The Auto
Amount trap preference is the trap width QuarkXPress applies, and the
default is commonly too narrow for most offset printing processes.

The Auto Method trap preference can be changed in the QuarkXPress
Trapping Preferences dialog to match either Absolute or Proportional.

When the Ignore White trapping feature is not enabled, White is treated
as a unique color. When trapping items, it may not be possible to get the
trap value desired when overprinting White. This feature can be enabled
in the Trapping Preferences dialog.

The Overprint Limit trap preference can be changed in the QuarkXPress
Trapping Preferences dialog to match your preferred value. The Overprint
Limit preference controls the percentage at or above that a color will over-
print. The default value is most commonly the preferred value -95 percent.

When the Process Trap is disabled, the color of some trapping lines can
be too dark, and will call attention to the traps. The common preference is
to leave this enabled. If it is enabled, objects colored with process printing
inks are trapped on a plate-by-plate basis, which can result in more
attractive colors of traps.

A page element has one of
the following trapping types
applied:

Color is saved with a
custom trap pair.

“Auto Amount” trap
preference is not: 

“Auto Method” trap
preference is not set to: 

“Ignore White” trap
preference is not enabled.

“Overprint Limit” trap
preference is not:

“Process Trap” preference
is not enabled.
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Custom

Overprint

Knockout
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The page size of the document may be larger or smaller than expected.
This item compares the document page size to the trim size you specify
for the document in the Job Jacket Output Instructions. If necessary,
change the page size in the document to match the job trim size. Another
option might be to print the document at a reduced or enlarged size.

This document was not saved in a Macintosh version of PageMaker.
There may be conversions taking place that will cause text and pictures to
reflow on the pages. Proof each page to make sure everything is as
expected.

The document will output smaller or larger than the document page size if
the “Scale” value in the Print dialog is not set to 100%.  If this job is not
being output reduced or enlarged, the proof may have been output at an
incorrect size. If the proof will be used for determining scaling for scan-
ning, output a new proof at the correct size.

If the "Send Image Data" pop-up menu in the Print Options dialog is set to
"Normal" PageMaker sends the graphic data to the printer at the maxi-
mum available resolution. This may be more information than is needed
for some output devices. Other options, such as Optimized Subsampling,
can send the printer only the data that is needed by the printer to render
the image.

If "Proof" is chosen in the Print dialog, PageMaker will omit all imported
graphics, and print rectangles with a X in them to match the dimensions
of the graphics. This can drastically reduce the print time for checking
sizes and positioning, but for professional output it should be disabled.

If the "Ignore Non-Printing setting" checkbox in the Print dialog is enabled,
elements set to "Non-Printing" (in the Elements menu) will actually print.
To disable this setting so elements set to "Non-Printing" will not be print-
ed, disable the checkbox in the Print dialog.

When "Display Master Items" is enabled in the View menu for a page, the
Master page elements located on the page will not be printed. If these
elements need to be printed, go to the page, and enable the menu item
by choosing "Display Master Items" in the View menu.

Blank pages in the document will be output if the “Print blank pages”
checkbox is checked in the Print dialog. For film, this is unnecessary. For
press impositions, it is preferred if the job actually has blank pages. If you
do not need blank placeholders in the digital file, uncheck the “Print blank
pages” checkbox in the Print dialog. 

Overflowed text frames contain type that disappears at the bottom of a
text frame. Some text may not be printed. This problem can be caused by
using a different version of a font, a missing font, a text edit, a moved ele-
ment or by bad layout habits. If the correct font is in use, locate the text
frame to determine if the overflow is caused by non-printing characters.

Page size does not match
paper trim size set in
document Output
Instructions.

Document not saved in a
Macintosh version of
PageMaker.

Document output is set to
be reduced or enlarged.

“Send Image Data” print
setting set to:

Document output is set for
“Proof.”

“Ignore non-printing” setting
is enabled.

Page set to not output
Master page items.

Blank pages exist in
document.

Overflowed text frame
exists.

PageMaker Document profile items
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Low Resolution

Omit Images

Normal

Optimized Subsampling
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PageMaker Fonts profile items

If a screen font is not available to the system, text in the document may
reflow and print incorrectly. To ensure accuracy and reduce the chance of
reflow, locate and activate the font used to create the document. Configur-
ing a Preflight Pro Font Search Path may find the screen font, but it won't
activate it. Be sure to activate the font before printing the document.

A missing printer font may be substituted as Courier, or as a bitmap
(jagged) version of the font. If a font with the same name is present on the
RIP, that font will be used. Customized characters in the original font may
not be in the version of the font located on the RIP and will be missing in
the final output. To ensure proper output, use the copy of the font that was
used to create the document.

A TrueType font does not print to a “PostScript Only” output device
such as an imagesetter RIP. In the "Download fonts" pop-up located in
the Print dialog, choose “PostScript and TrueType” when printing. Also
be sure to choose the correct PPD for your output device. If the
TrueType font is “included” in the PostScript print stream, or file, the
LaserWriter printer driver converts it to usable PostScript outlines that
image correctly. As a policy, test this process through your workflow.

Multiple Master fonts can cause an output error on output devices that
cannot handle fonts larger than 300K. Use updated font management
tools and in the "Download fonts" pop-up located in the Print dialog,
choose “PostScript and TrueType” when printing.

An “Outline” styled font prints well to a laser printer, but on a high resolu-
tion device the outlines may become much thinner. The style may look
even thinner if Computer-to-Plate processing is used. Choose a font that
has a true outline style, or convert the font to a graphic in a vector draw-
ing program and apply a stroke of a specific width.

A high resolution device may output “Shadow” styled fonts much lighter
than a low resolution device, such as a laser printer. Duplicate the affect-
ed characters in PageMaker, offset them, and apply a specific screen
value. This will result in controllable screen values.

No printer font exists for this menu-styled font. A menu styled font is one
that is bolded or italicized from a style menu. On screen it may appear
with the menu style, but the actual screen font may call to a printer font
that does not reflect this same style. e.g. Helvetica Black bolded will be
output as Helvetica Black without the bold style applied because there is
not a bold version of Helvetica Black. Possibly substitute a font that
appears to be the same, without any menu style applied to it.

A small point sized font may reproduce badly on press and be difficult to
read. Increase the point size of the font, if possible.

Missing screen font.

Missing printer font.

TrueType font used in the
document.

Multiple Master font used in
the document.

Screen font menu styled as
“Outline.”

Screen font menu styled as
“Shadow.”

No printer font exists for
menu style applied to
screen font.

Font sized too small. 
Flag fonts sized below: 

Problem Item Description / SolutionFlag
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o
o
o

o
o
o

points
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A small point sized font, colored with screen tints, may reproduce badly
on press and be difficult to read. Color the font with a Printing Ink (spot
color), or increase the point size of the font, if possible.

If a font is only used in a Style Definition, it will have no impact on the
printability of the job. Any warning about this font, when missing, can be
ignored, or the Style Definition can be deleted so other won't think a font
is missing if it is not delivered with the document.

MASTER PAGE: When opening a PageMaker document, the application
will list all missing fonts—even fonts that are only used on a Master page.
If a font is only used on a Master page, it will have no impact on the print-
ability of the job. Any warning about this font, when missing, can be
ignored, or the use of this font can be deleted so others won't think a font
is missing if it is not delivered with the document.

PASTEBOARD: If a font is only used on the pasteboard, it will have no
impact on the printability of the job. Any warning about this font, when
missing, can be ignored, or the use of this font can be deleted so others
won't think a font is missing if it is not delivered with the document.

Font sized below: 

is colored with:

Font only used in an
unused Style Definition.

Font only used on: 

Problem Item Description / SolutionFlag

o
o
o

PageMaker Fonts profile items  (continued)

o
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points

or more printing inks

A Master page

Pasteboard
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PageMaker Graphics profile items

A modified graphic is a graphic that has been edited after it was placed
in the document. The graphic may output in a different position on the
page due to the graphic not being updated in the document. To update
the graphic in the document, open the document—it will update auto-
matically.

A missing graphic is a graphic that has been moved or renamed on disk
after it was placed in the document. Missing graphics will cause
PageMaker to print the low resolution previews of the graphics, instead of
the high resolution graphics. To relink the missing graphic to the docu-
ment, choose the graphic in the Links Manager dialog, click the Info but-
ton, select the graphic (either in its new location, or with its new name),
and click the Link button.

The original disk file for this embedded graphic is missing on disk, which
means it can not be edited, if needed. These graphics can be dragged-
and-dropped from PageMaker into Illustrator or Photoshop, but it will use
the PageMaker 72 dpi screen preview of the picture -not the high resolu-
tion graphic data found in the disk file. If the embedded picture is accept-
able for proper output (proper color mode, resolution, etc.), there will not
be a need to edit the original, so this problem may be ignored.

If the original disk file for an embedded graphic is missing on disk,
changes can not be made to the graphic. These are commonly PICT
screen captures that were pasted onto the page before the EPS was cre-
ated and may also be in RGB color mode. If the embedded graphic is
acceptable for proper output (proper color mode, resolution, etc.), there
will not be a need to edit the original, so this problem may be ignored.

This graphic does not have an original disk file located on disk. This
means the graphic was either pasted or dragged-and-dropped onto the
page from another application. If the graphic is a screen capture, it will be
output as a PICT format graphic, which can not be in CMYK color mode,
and will not separate properly. Screen captures are also commonly low
resolution, which will give you poor output. If the graphic was dragged-
and-dropped from Illustrator or Photoshop into PageMaker, it is converted
to an embedded raster EPS graphic and can be output properly. However,
if these graphics are dragged-and-dropped back into Illustrator of
Photoshop for editing purposes, it will only use the PageMaker 72 dpi
screen preview. To ensure proper output, place the graphic in the docu-
ment from an original disk file that has the proper resolution, color mode,
etc. for proper output. These graphics can also be edited later, if needed.

If a vector graphic contains a linked (not embedded) graphic, it will not be
found by PageMaker when output. In such cases, PageMaker will print a
low-resolution preview of the picture. When saving files in a vector draw-
ing program, there is an option to store a placed picture in the EPS. If this
is not done, the graphic is often lost or not sent with the job. In Adobe
Illustrator, the option to embed is available when the file is saved or
exported. In Macromedia FreeHand, the graphic can be embedded based
on preferences when the graphic is imported or placed. To avoid missing
graphics or graphics not printing, embedding is recommended. Also be
sure to have the colors in the graphic properly defined as spot or process
before saving the file, or the output provider may have problems getting
the colors to print.

Graphic has been modified
after the document was
saved.

Linked graphic is missing.

Disk file for embedded
graphic is missing.

Vector graphic contains an
embedded graphic with
missing disk file.

No disk file exists for
graphic embedded in
document.

A vector graphic contains a
linked, not embedded,
graphic.

Problem Item Description / SolutionFlag
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DCS files consist of a preview and multiple plate files (usually CMYK). All
these plate files are necessary for successful separation. When printed
composite, the preview file is sent to the output device. If any of the other
files are missing, they must be located and placed in the same folder as
the preview file to output properly.

The high resolution version of an OPI graphic can not be found. This
may be because the volume it exists on is not currently available to this
machine, or it may in fact be missing. If it is missing, it may not be output
when the document is printed. If the high resolution location/volume
becomes available, reinspect the document so the high resolution
graphic data can be inspected for any printing problems. The name and
location of the high resolution graphic is obtained by looking at the OPI
"comments" inside the low resolution OPI "layout" graphic used in the
document. 

This is a low resolution graphic created by an OPI graphic replacement
program. Preflight Pro does not check resolution, color or image quality in
this file. It will attempt to find the high resolution version of the graphic and
report problems, if they exist, for that graphic. You should replace this
graphic with the high resolution version, if you are not printing to an OPI
server and want high resolution output.

PICT: PICT graphics originate primarily from 72 DPI screen captures and
are usually in RGB color mode. If left RGB they may output as grayscale
on all plates or may print on only one plate. If sent to a composite color
RIP, the graphic is converted at the default settings in the RIP. On rare
occasions, PICT files are encountered that have vector and raster data.
These cause output errors on some RIPs. If screen captures are to be
printed in color, convert them to CMYK in an image-editing application,
and save them as a TIFF or EPS. Tip: Test separating with Maximum
GCR. This will remove C,M,Y from under pure black areas and make
these graphics easier to register on press.

TIFF: If you turn on this alert, there must be some issue in your process
that causes this graphic format to be a problem. In general it is one of the
best formats to save a file in. There is NO final image quality difference
between a TIFF and an EPS. The previews differ and the EPS has some
features not available in TIFFs.

EPS: If you turn on this alert, there must be some issue in your process
that causes this graphic format to be a problem. In general it is one of the
best formats to save a file in. There is NO final image quality difference
between an EPS and a TIFF. The previews differ and the EPS has some
features not available in TIFFs.

DCS: If you turn on this alert, there must be some issue in your process
that causes this graphic format to be a problem. In general, it is a widely
used format. This format allows documents to be proofed quickly to a
laser printer because most of this type of proofing is done composite and
the low resolution file is used. When this format is output at a film or plate
provider, the print driver gets the plate files and sends these in the
PostScript file. If the file needs to be printed on a composite color device
or rasterized on a composite color RIP, an extension must be used to
recombine the plate files into one file. It is also possible to resave them as
a composite file in an image-editing application. 

Multi-file DCS graphic is
missing a plate file.

High-resolution OPI graphic
is missing.

Graphic is a low-resolution
OPI “layout” file.

Incorrect graphics file
formats: 

Problem Item Description / SolutionFlag
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PageMaker Graphics profile items (continued)
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DCS

Scitex CT

JPEG

GIF

WMP

BMP

Other

PICT

TIFF
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JPEG: If you turn on this alert, there must be some issue in your process
that causes JPEG graphics to be a problem. A solution may be to open
the graphic in an image-editing application and save it in a different file
format that works for your workflow.

SCITEX CT: In general, Scitex CT is widely used and works with most post-
script devices. This file type is in Handshake format on the map and per-
forms like a TIFF. A solution may be to open the graphic in an image-editing
application and save it in a different file format that works for your workflow.

GIF/BMP/WMF: If you turn on any of these alerts, there must be some
issue in your process that causes this graphic format to be a problem. A
solution may be to open the graphic in an image-editing application and
save it in a different file format that works for your workflow. 

OTHER: This graphic is not one of the common file formats used in desk-
top publishing and is likely to cause an output problem. A solution may be
to open the graphic in an image-editing application and save it in a differ-
ent file format that works for your workflow.

A compressed picture can be problematic on a PostScript RIP.

LZW TIFF: LZW decompression can cause delays on Level 1 PostScript
output devices, but work fine on PostScript Level 2 devices. If output
problems are encountered with this picture, resave the picture without
compression.

JPEG EPS: EPS pictures with JPEG compression can cause Level 1
devices to fail. If a picture has been JPEG compressed more than once, it
may lose noticeable picture detail. If the quality has become poor, only
rescanning will fix it. It the picture looks good on proofs and it is being
sent to a Level 2 output device, it should print fine.

JPEG DCS: DCS pictures with JPEG compression can cause Level 1
devices to fail. If a picture has been JPEG compressed more than once, it
may lose noticeable picture detail. If the quality has become poor, only
rescanning will fix it. It the picture looks good on proofs and it is being
sent to a Level 2 output device, it should print fine.

A TIFF graphic with extra channels will cause some output device RIPS to
fail. These graphics can be resaved in an image-editing application with-
out the extra channels to output properly. In general, document originators
should remove all extra data from graphics that are ready for output.

If a graphic is saved with a custom line screen, it will be imaged at that
line screen. This may result in a graphic that prints differently than other
pictures in the same document. Custom curves are ignored if the image is
sent to a composite color RIP. Two different screens cannot be applied on
composite color RIPs.

Incorrect graphics file
formats (continued).

Picture is compressed:

TIFF graphic saved with
extra channels.

Graphic saved with custom
line screen.

PageMaker Graphics profile items  (continued)

Problem Item Description / SolutionFlag
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LZW TIFF

JPEG EPS

JPEG DCS



180

Graphics saved with custom functions may not output correctly. The curve
may cause the picture to print differently than it appears on-screen, or the
curve may be ignored if sent to a composite color RIP. For composite
color RIPs the curve should be applied to the picture in an image-editing
application prior to placing the picture in the document for output.

Too low of a flatness setting for a path may create an excessive amount
of points on the clipping path. This can slow down output time and some-
times fail to RIP. Most Level 2 RIPs have made flatness setting unneces-
sary. Increase the flatness of the path in an image-editing application, if
needed.

Too high of a flatness setting for a path may cause a graphic to print with
edges that are flat or angular on output, instead of rounded. The formula
for flatness is the setting in device pixels divided by output device resolu-
tion. The result is the amount of flatness that will occur. e.g. 8 (set-
ting)/300 (Output device res) = .026 or almost 2 points of flatness. This
would be very noticeable on a laser printer. On an imagesetter, the same
number 8/2400 = .003 which is fine.

If the resolution of a color or grayscale graphic after scaling in PageMaker
is too low, pixels may be prominent on output and the picture will appear
jagged. Rescan the image at a higher resolution, or decrease the scaling
of the graphic on the page to increase the resolution. The correct resolu-
tion is 1.5 to 2  times the output line screen at the final image size after
scaling it on the page.

If the resolution of a color or grayscale graphic after scaling in PageMaker
is too high, it will take longer to output than necessary. Excess resolution
does not result in an improvement in quality. If there are many of these or
if the excess resolution is significant, investigate sampling the data down
in an image-editing application. The correct resolution is 1.5 to 2 times the
output line screen at the final image size after scaling in a page layout
program.

If the effective resolution of a bitmap graphic after scaling in PageMaker is
too low, the graphic may appear jagged.  Each shop or customer may
have their own acceptable range.  A general minimum is 300 DPI. The
maximum is usually around 2400 DPI (or the writing engine resolution).
The most common range is between 800 and 1200 DPI. Rescan the
image at a higher resolution, or decrease the scaling of the graphic on the
page to increase the resolution.

If the effective resolution of a bitmap graphic after scaling in PageMaker is
too high, the file will take longer than necessary to output.  Each shop or
customer may have their own acceptable range.  A general minimum is
300 DPI. The maximum is usually around 2400 DPI (or the writing engine
resolution). The most common range is between 800 and 1200 DPI. If
many images are above final imagesetter resolution they can be reduced
in resolution in an image-editing application. 

Graphic saved with custom
transfer function.

Picture clipping path
flatness: 

Effective resolution of a
color of grayscale picture
too Low. Less than:

Effective resolution of a
color of grayscale picture
too High. More than:

Effective resolution of a
bitmap (1-bit) picture is:

Problem Item Description / SolutionFlag
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o
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PageMaker Graphics profile items  (continued)
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Less than
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o
o
o

A graphic has been scaled more in one direction than the other.
Sometimes this is accidental and the document author would like to be
notified of this condition. Other times this is done to correct the fit of a pic-
ture if it falls short in one direction. There is no issue with reproducing
these images. Note that depending on the amount of disproportionate
scaling that has been done, the resolution on one direction may fall below
the recommended minimum.

EPS files with raster data can be very large. When processed through a
page layout program, all EPS data is preserved in the file even if only a
small portion is visible through a picture frame. This results in much more
data being included in the print stream or PostScript file. If a clipping path
or other EPS-specific effect is not needed, a TIFF file format may be a
better choice because TIFFs are actually cropped prior to the data being
written into the print stream.

While reflecting a graphic is fine with PageMaker, some OPI servers will
not handle it correctly. The high resolution graphic may not be reflected
when the low resolution “for placement only” graphic has been reflected in
the picture frame. It is preferable to reflect the original picture in an image
– editing application before placing it on the page.

Rotated or skewed graphics can increase the output time of the document
and occasionally activate bugs in OPI servers or imposition programs –
which will cause items not to print or move out of position at print time.

MASTER PAGE: A graphic that is only located on a Master page will not
print. However, it will be reported in the Links dialog just as any other
graphic. It can add colors to the document color palette that may not be
used.  And it will be collected with the job, even though it is not needed
for proper output.

PASTEBOARD: A graphic located on the pasteboard will be listed in the
Links dialog even though it is not used on any printed page. It can add
colors to the document color palette that may not be used. And it will be
collected with the job, even though it is not needed for proper output.

Disproportionately scaled
graphic. Horizontal and
Vertical scaling differs by:

EPS picture is cropped
More than:

Graphic reflected
horizontally or vertically.

Graphic has been rotated
or skewed in the document.

Graphic is only used on:

o
o
o

o
o
o

o
o
o

o
o
o

%

%

A Master page

Pasteboard

Problem Item Description / SolutionFlag

PageMaker Graphics profile items  (continued)
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An incorrect number of printing inks will result in the output of extra plates
when printing separations. This item compares the number and type of
colors the document will output to the colors specified in the Job Jacket
Output Instructions for the document. Unneeded spot colors should be
converted to process. To do this, select each spot color in the Color
palette, choose "Color Options..." from the pop-out on the palette, then
change the Type pop-up to "Process."

Colors that have the same name, but different CMYK definitions, may
appear different on output. This occurs when a spot color defined in an
EPS graphic is redefined in the PageMaker document as process, and its
CMYK values are changed.  This type of color value change will only
affect the color used in the document -not the EPS graphic -which means
the colors won't match when they are output.  To ensure a proper color
match, change the color values of the color in the document, or EPS
graphic to match.

Two spot colors in this document have the same color values.  When
color naming conventions are different in applications that create EPS
graphics, colors can be imported into the PageMaker color palette with a
different name, but with the same color values as an existing color. This
will cause what should be a single color to be output on two separate
plates. To fix this, the name of the color in the PageMaker document can
be changed to match the name of the color defined in the graphic.

The total ink coverage of this color is too high. Certain printing conditions
can only support so much ink on paper. If too much ink is placed, it caus-
es problems. Adjustments must be made to the color's total ink usage to
be printed properly.

This color is defined as a Multi-Ink color. This means it is a process color
which will be separated into more than the standard CMYK printing ink
plates. To get a list of the other printing inks used in this color, double-
click the name in the Preflight Pro Consolidated Report or Color Tab
pane, or select the color in the PageMaker color palette and choose
"Color Options" from the palette's pop-out menu.

The color “Registration” is meant to be used for items that need to print
on all plates. Usually, this is used for registration marks. It is sometimes
mistaken as the color Black in the color palette. If this is the case, replace
each occurrence with the proper color.

Text colored with the "Paper" color was found in the document. The color
Paper is meant to be used to specify no ink or knockout. It is sometimes
mistaken as the color White in the color palette. If this is the case, replace
each occurrence with the White color. Additionally, the color Paper has
also been known to be misinterpreted by some RIPs.

RGB color mode graphics must be converted to CMYK color mode before
they are able to separate properly on output. Some RIPs can make the
conversion, but the results may not be acceptable. It is best if this is done
in an image-editing application, such as Adobe Photoshop. 

Incorrect number of printing
inks as compared to the
document Output
Instructions.

A color’s value in the docu-
ment does not match the
color’s value in a graphic.

Spot colors with identical
values have different
names.

Total ink coverage of a
color is greater than:

Multi-Ink (Hi-Fi) color used.

The color “Registration” is
used in a printing element.

The color “Paper” is used in:

RGB color mode picture is
used in the document.

Problem Item Description / SolutionFlag
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PageMaker Colors profile items
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This graphic was saved in the CMYK color mode. If your workflow does
not require CMYK color mode graphics, you may choose to change the
color mode of the graphic in an image-editing application. If this is done,
be sure to also update its reference in the document by choosing
"Update" in the Links Manager dialog.

Indexed color graphics usually come from the Internet and have a severe-
ly reduced color palette. They will print with reduced colors -even if they
are converted to CMYK. Colors eliminated in the original conversion can-
not be restored. Rescan the picture, if possible, or print a color proof to
see how it looks on output.

Graphics saved in this color mode can print as grayscale, or fail to print
on some composite RIPs. If this is the case for your system, convert the
graphic to multichannel or CMYK in an image-editing application before
sending it to a composite RIP.

Applying a color to a bitmap (1-bit) or grayscale color mode TIFF graphic
can cause some OPI servers and RIPs to fail, or on some systems, the
graphic will not be colorized on output. If this is the case with your system,
applying the color to the graphic in an image-editing application before it is
used in the document will allow the graphic to be output properly.

A Pattern fill is assigned to this element. Pattern fills may not appear on
output as they appear on-screen. They are resolution-dependent graphic
elements – not PostScript elements that look the same at any resolution.
If they are printed at high resolution, they will appear much smaller than
they do on-screen. Creating an image that represents the pattern in an
image-editing application and placing it onto the page will ensure that it
outputs as it appears on-screen.

A rule or stroke width is sized too small for printing clearly. Increasing the
size of the rule or frame will allow it to be printed clearly.

A rule or stroke width is sized too small for printing correctly. This happens
most commonly when a rule or stroke is colored with a process color.  If
the registration during printing is off, the colors won’t overlap and will
appear distorted. Increasing the size of the rule or stroke, or changing the
color to a single color will allow it to be printed clearly.

If a stroke is set to Reverse, it may be reversing out of a darker area
underneath it. In this case, it will need to be sized thick enough so that it
does not fill in on press.

CMYK color mode graphic
is used in the document.

Indexed color mode graphic
is used in the document.

Monotone, duotone, tritone
or quadtone graphic is used
in this document.

A TIFF picture is colorized
in the document.

Element contains a Pattern
fill.

Rule or stroke sized below
specified points is used in
the document.

Rule or stroke sized below
specified points, and
colored with specified
printing inks.

Rule or stroke sized below
specified points, and set to
Reverse.

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

Printing inks

Below              points

Below              points

Below              points

o
o
o
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PageMaker trapping is enabled for this publication in the Trapping
Preferences dialog. If you use a separate trapping program, such as
TrapWise®, you will not need this preference enabled. PageMaker trap-
ping does not trap imported graphics.

This option should almost always be disabled. If a foreground object gen-
erated by PageMaker overlaps an imported graphic, chances are that you
do not want to trap it, since the object will trap not to the graphic, but to
any PageMaker-drawn object underneath it, creating undesirable effects.
Trapping over imported objects would be desirable only if the PageMaker
element overlapped an evenly-colored area in the imported graphic and
the PageMaker drawn object beneath the imported object had a matching
color applied to it.

This color has a global Overprint trap setting enabled in the Color Options
dialog. All objects – imported images, lines, ellipses, polygons, rectangles,
even text – to which this color is applied will overprint.

DEFAULT: This preference is the trap width PageMaker applies to all col-
ors except those involving solid Black.

BLACK WIDTH: Trap width PageMaker applies to colors next to or under
solid Blacks. Typically, the Black width is set 1.5 to 2 times the value of
the "Default" trap width.

STEP LIMIT: Defines when PageMaker should make a trap. If the colors
vary by more than the amount entered, the program will create a trap.
The default value is usually the preferred value.

CENTERLINE THRESHOLD: Determines when PageMaker will create a
centerline trap instead of a full spread or choke. A 100% setting will not
do any centerline trapping, while 0% will make all traps centerline. If the
threshold is 70%, it will try to build a centerline trap for any abutting col-
ors that are 30% or less apart in neutral density values. The default
value is usually the preferred value.

TRAP ABOVE: PageMaker will automatically overprint text that is smaller
than the value entered, and text larger than the value will be trapped. If
the value is too large, large text will overprint, and colors may be notice-
able under it. If the value is too small, text could become hard to read
because trapping will be applied. Usually left at the default value.

The “Black Limit” defines what is considered to be Black for trapping pur-
poses. By decreasing this value from its default of 100%, you can com-
pensate for dot gain and ensure PageMaker will apply the proper trap
width and placement to black-colored objects.

AUTO-OVERPRINT BLACK BELOW specified POINTS : This PageMaker
setting specifies when Black text, sized below the defined point size, will
have an overprint trap applied.

AUTO-OVERPRINT BLACK STROKES : This preference will automatical-
ly overprint the strokes of PageMaker frames, rectangles, polygons,
ellipses, and strokes that are black, and not trap them.

AUTO-OVERPRINT BLACK FILLS: This setting will automatically over-
print the fills of PageMaker elements that are black and not trap them.

PageMaker trapping has
been enabled.

Trapping preference is set
to “Trap Over” imported
objects.

Color has a global overprint
trap setting enabled.

Trapping enabled with Trap
Width settings different than:

Trapping enabled, with
Trapping Threshold settings
different than:

Trapping enabled with
Black Attribute settings
different than:

Auto-overprint Black: 

Problem Item Description / SolutionFlag
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PageMaker Trapping profile items
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Default

Black Width

Strokes

Fills

Step Limit

Trap text above             points

Text below              points

Black Limit             %

Centerline Threshold
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The page size of the document may be larger or smaller than expected.
This item compares the document page size to the trim size you specify
for the document in the Job Jacket Output Instructions. If necessary,
change the page size in the document to match the job trim size. Another
option might be to print the document at a reduced or enlarged size.

Different size pages exist in this document. This may not be as expected,
or the file may need special attention in order to output each page proper-
ly. The size of each page can be adjusted in the Page Manager dialog
available in the Document menu.

The document will output smaller or larger than the document page size if
the "Scale" value in the Page Setup dialog is not set to 100%.  If this job
is not being output reduced or enlarged, the proof may have been output
at an incorrect size. If the proof will be used for determining scaling for
scanning, output a new proof at the correct size.

If blank pages exist in the document, they will produce blank pages on
output. For film, this is unnecessary. For press impositions, it is preferred
if the job actually has blank pages. If you do not need blank placeholders
in the digital file, you can remove pages by clicking the Delete Pages...
button in the Page Manager dialog available in the Document menu. 

Incorrect page size, as
compared to the trim size
entered in the document
Output Instructions.

Different size pages exist in
document.

Document output is set to
be reduced or enlarged.

Blank pages exist in docu-
ment.

Creator2 Document profile items

Problem Item Description / SolutionFlag
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Creator2 Fonts profile items

If a screen font is not available to the system, text in the document may
reflow and print incorrectly. To ensure accuracy and reduce the chance of
reflow, locate and activate the font that was used to create the document.
Configuring a Preflight Pro Font Search Path may find the screen font,
but it won't activate it. Be sure to activate the font before printing the
document.

A missing printer font may be substituted as Courier, or as a bitmap
(jagged) version of the font. If a font with the same name is present on
the RIP, that font will be used. Customized characters in the original font
may not be in the version of the font located on the RIP and will be
missing in the final output. To ensure proper output, use the copy of the
font that was used to create the document.

A TrueType font does not print to a "PostScript Only" output device such
as an imagesetter RIP. Choose "include all fonts" in the Print dialog when
printing. Also be sure to choose the correct PPD for your output device. If
the TrueType font is "included" in the PostScript print stream, or file, the
LaserWriter printer driver converts it to usable PostScript outlines that
image correctly. As a policy, test this process through your workflow.

Multiple Master fonts can cause an output error on output devices that
cannot handle fonts larger than 300K. Use updated font management
tools and choose "include all fonts" in the Print dialog when printing the
file. As a policy, test this process through your workflow.

An "Outline" styled font prints well to a laser printer, but on a high resolu-
tion device the outlines may become much thinner. The style may look
even thinner if Computer-to-Plate processing is used. Choose a font that
has a true outline style, or convert the font to a graphic in a vector draw-
ing program and apply a stroke of a specific width.

A high resolution device may output "Shadow" styled fonts much lighter
than a low resolution device, such as a laser printer. Duplicate the affect-
ed characters in Creator2, offset them, and apply a specific screen value.
This will result in controllable screen values.

No printer font exists for this menu-styled font. A menu styled font is one
that is bolded or italicized from a style menu. On screen it may appear
with the menu style, but the actual screen font may call to a printer font
that does not reflect this same style. e.g. Helvetica Black bolded will be
output as Helvetica Black without the bold style applied because there is
not a bold version of Helvetica Black. Possibly substitute a font that
appears to be the same, without any menu style applied to it.

A small point sized font may reproduce badly on press and be difficult to
read. Increase the point size of the font, if possible.

A small point sized font, colored with screen tints, may reproduce badly
on press and be difficult to read. Color the font with a Printing Ink (spot
color), or increase the point size of the font, if possible.

Missing Screen font.

Missing Printer font.

TrueType font used in the
document.

Multiple Master font used in
the document.

Screen font menu styled as
“Outline”.

Screen font menu styled as
“Shadow”.

No printer font exists for
menu style applied to
screen font.

Fond sized too small. 

Flag fonts sized below:

Font sized below: 

is colored with:

Problem Item Description / SolutionFlag
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points
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points

or more printing inks
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Creator2 Graphics profile items

A modified picture is a picture that has been edited after it was placed in
the document. The picture may output in a different position inside the
document due to the picture not being updated in the document. To
update the picture in the document, simply open the document.
Reinspecting the document will also update its reference.

A missing picture is a picture that has been moved or renamed on disk
after it was placed in the document. Creator2 can not print an image
when the original disk file has been moved from its original location. To
relink the missing picture to the document, choose the picture in the File
Utilities dialog, click the Find button, and select the picture in its new loca-
tion. If the picture's name was changed, check the "Let me pick a different
file" checkbox in the Find dialog to select the picture with the new name.

If the original disk file for an embedded picture is missing on disk,
changes can not be made to the picture. These are commonly PICT
screen captures that were pasted onto the page before the EPS was cre-
ated and may also be in RGB color mode. If the embedded picture is
acceptable for proper output (proper color mode, resolution, etc.), there
will not be a need to edit the original, so this problem may be ignored.

This picture does not have an original disk file located on disk. This
means the picture was either pasted into the picture box or dragged-and-
dropped onto the page from another application. It will be output as a
PICT format picture, which can not be in CMYK color mode. It is common-
ly in RGB color mode, and low resolution.  Low resolution pictures will
give you poor output, and RGB color mode pictures will not separate
properly. To get these pictures to separate properly, they can be opened
in an image-editing application, saved as CMYK, and imported into the
picture box. The resolution of these pictures can only be increased by res-
canning the image, or adjusting it in an image-editing application.

If a vector graphic contains a linked (not embedded) graphic, it will not be
found by Creator2 when output. In such cases, Creator2 will print a low-
resolution preview of the picture. When saving files in a vector drawing
program, there is an option to store a placed picture in the EPS. If this is
not done, the graphic is often lost or not sent with the job. In Adobe
Illustrator, the option to embed is available when the file is saved or
exported. In Macromedia FreeHand, the graphic can be embedded based
on preferences when the graphic is imported or placed. To avoid missing
graphics or graphics not printing, embedding is recommended. Also be
sure to have the colors in the graphic properly defined as spot or process
before saving the file, or the output provider may have problems getting
the colors to print.

DCS files consist of a preview and multiple plate files (usually CMYK). All
these plate files are necessary for successful separation. When printed
composite, the preview file is sent to the output device. If any of the other
files are missing, they must be located and placed in the same folder as
the preview file to output properly.

Graphic has been modified
after the document was
saved.

Graphic is missing.

Vector graphic contains an
embedded graphic with
missing disk file.

No disk file exists for pic-
ture embedded in docu-
ment.

A vector graphic contains a
linked, not embedded,
graphic.

Multi-file DCS image is
missing a plate file.

Problem Item Description / SolutionFlag
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The high resolution version of an OPI picture can not be found. This may
be because the volume it exists on is not currently available to this
machine, or it may in fact be missing. If it is missing, it may not be output
when the document is printed. If the high resolution location/volume
becomes available, reinspect the document so the high resolution picture
data can be inspected for any printing problems. The name and location
of the high resolution picture is obtained by looking at the OPI
"comments" inside the low resolution OPI "layout" picture used in the
document. 

This is a low resolution picture created by an OPI picture replacement
program. Preflight Pro does not check resolution, color or image quality in
this file. It will attempt to find the high resolution version of the picture and
report problems, if they exist, for that picture. You should replace this
picture with the high resolution version, if you are not printing to an OPI
server and want high resolution output.

Some picture file formats can cause problems on output. Select the pic-
ture file formats you would like to be notified of when used in the docu-
ment.

A compressed picture can be problematic on a PostScript RIP. LZW
decompression can cause delays on Level 1 PostScript output devices,
but work fine on PostScript Level 2 devices. EPS/DCS pictures with JPEG
compression can cause Level 1 devices to fail.

A TIFF picture with extra channels will cause some output device RIPS to
fail. These pictures can be resaved in an image-editing application without
the extra channels to output properly. In general, document originators
should remove all extra data from pictures that are ready for output.

If a graphic is saved with a custom line screen, it will be imaged at that
line screen. This may result in a graphic that prints differently than other
pictures in the same document. Custom curves are ignored if the image is
sent to a composite color RIP. Two different screens cannot be applied on
composite color RIPs.

Pictures saved with custom functions may not output correctly. The curve
may cause the picture to print differently than it appears on-screen, or the
curve may be ignored if sent to a composite color RIP. For composite
color RIPs the curve should be applied to the picture in an image-editing
application prior to placing the picture in the document for output.

High-resolution OPI graphic
is missing.

Graphic is an OPI layout
file.

Incorrect graphic file formats:

Graphic is compressed.

TIFF graphic saved with
extra channels.

Graphic saved with custom
line screen.

Graphic is saved with a
custom transfer function.

Problem Item Description / SolutionFlag
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o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

EPS

DCS

Photoshop

JPEG

Other

PICT

TIFF

LZW TIFF

JPEG EPS

JPEG DCS
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Too low of a flatness setting for a path may create an excessive amount
of points on the clipping path, while too high of a flatness setting may
cause a graphic to print with edges that are flat or angular on output,
instead of rounded. 

If the resolution of a color or grayscale graphic after scaling in Creator2 is
too low, pixels may be prominent on output and the picture will appear
jagged. Rescan the image at a higher resolution, or decrease the scaling
of the graphic on the page to increase the resolution. The correct resolu-
tion is 1.5 to 2  times the output line screen at the final image size after
scaling it on the page.

If the resolution of a color or grayscale graphic after scaling in Creator2 is
too high, it will take longer to output than necessary.  Excess resolution
does not result in an improvement in quality. If there are many of these or
if the excess resolution is significant, investigate sampling the data down
in an image-editing application. The correct resolution is 1.5 to 2 times the
output line screen at the final image size after scaling in a page layout
program.

If the effective resolution of a bitmap (1-bit) graphic after scaling in
Creator2 is too low, the graphic may appear jagged.  If it is too high, the
file will take longer than necessary to output.

A picture has been scaled more in one direction than the other.
Sometimes this is accidental and the document author would like to be
notified of this condition. Other times this is done to correct the fit of a pic-
ture if it falls short in one direction. There is no issue with reproducing
these images. Note that depending on the amount of disproportionate
scaling that has been done, the resolution on one direction may fall below
the recommended minimum.

EPS files with raster data can be very large. When processed through a
page layout program, all EPS data is preserved in the file even if only a
small portion is visible through a picture box. This results in much more
data being included in the print stream or PostScript file. If a clipping path
or other EPS-specific effect is not needed, a TIFF file format may be a
better choice because TIFFs are actually cropped prior to the data being
written into the print stream.

Graphic clipping path
flatness:

Effective resolution of a
color or grayscale graphic
too low. Less than: 

Effective resolution of a
color or grayscale graphic
too high. More than:

Effective resolution of a
bitmap (1-bit) graphic is:

Disproportionately scaled
graphic. Horizontal and
Vertical scaling differs by:

EPS graphic is cropped
more than :

Creator2 Graphics profile items  (continued)
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Less than

More than

Less than ppi

More than ppi

x Line Screen

Pixels per inch

x Line Screen

Pixels per inch
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While flipping a picture is fine with Creator2, some OPI servers will not
handle it correctly. The high resolution picture may not be flipped when
the low resolution "for placement only" picture has been flipped in the pic-
ture box. It is preferable to flip the original picture in an image-editing
application before bringing it into the picture box.

Rotated or skewed picture can increase the output time of the document
and occasionally activate bugs in OPI servers or imposition programs -
which will cause items not to print or move out of position at print time.

Applying a color to a picture box behind a TIFF picture can cause some
OPI servers and RIPs to fail. Other output devices may print the job in two
colors but without a trap needed for a good fit on press. It's best to set the
picture box background color to White.

A picture has a shadow defined. This can cause unexpected results on
output. Shadows may be created from an incorrect picture file format
which will not separate properly.

Textures used in frames may cause unexpected results on output. Frame
textures may be created from an incorrect picture file format which will not
separate properly on output. Some frames may not be large enough to
show decent results on output.

A texture is used in a fill. This can cause unexpected results on output. Fill
textures may be created from an incorrect picture file format which will not
separate properly.

A texture is used in a shadow. This can cause unexpected results on out-
put. Shadow textures may be created from an incorrect picture file format
which will not separate properly.

Graphic is flipped horizon-
tally or vertically.

Graphic has been rotated
or skewed in the document.

Graphic box with a back-
ground color contains a
TIFF graphic.

Graphic has a shadow
defined.

Texture used in Frame.

Texture used in Fill.

Texture used in Shadow.

Problem Item Description / SolutionFlag
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o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o



191

An incorrect number of printing inks will result in the output of extra plates
when printing separations. This item compares the number and type of
colors the document will output to the colors specified in the Job Jacket
Output Instructions for the document. Unneeded spot colors should be
converted to process. To do this, select "Colors..." from the "Document"
menu, choose the spot color you wish to convert to process, click the
"Edit..." button, and choose the "Process" radio button.

Colors that have the same name, but different CMYK definitions, may
appear different on output. This occurs when a spot color defined in an
EPS picture is redefined in the Creator2 document as process, and its
CMYK values are changed.  This type of color value change will only
affect the color used in the document -not the EPS picture - which means
the colors won't match when they are output.  To ensure a proper color
match, change the color values of the color in the document, or EPS pic-
ture to match.

Two spot colors in this document have the same color values.  When
color naming conventions are different in applications that create EPS pic-
tures, colors can be imported into the Creator2 color palette with a differ-
ent name, but with the same color values as an existing color. This will
cause what should be a single color to be output on two separate plates.
To fix this, the name of the color in the Creator2 document can be
changed to match the name of the color defined in the graphic.

The total ink coverage of this color is too high. Certain printing conditions
can only support so much ink on paper. If too much ink is placed, it caus-
es problems. Adjustments must be made to the color's total ink usage to
be printed properly.

The color "Registration" is meant to be used for items that need to print
on all plates. Usually, this is used for registration marks. It is sometimes
mistaken as the color Black in the color palette. If this is the case, replace
each occurrence with the proper color.

RGB color mode pictures must be converted to CMYK color mode before
they are able to separate properly on output. Some RIPs can make the
conversion, but the results may not be acceptable. It is best if this is done
in an image-editing application, such as Adobe Photoshop. 

This picture was saved in the CMYK color mode. If your workflow does
not require CMYK color mode pictures, you may choose to change the
color mode of the picture in an image-editing application. 

Indexed color pictures usually come from the Internet and have a severe-
ly reduced color palette. They will print with reduced colors -even if they
are converted to CMYK. Colors eliminated in the original conversion can-
not be restored. Rescan the picture, if possible, or print a color proof to
see how it looks on output.

Incorrect number of printing
inks as compared to the
Document Output
Instructions.

A color’s value in document
does not match the color’s
value in a graphic.

Spot colors with identical
values have different
names.

Total ink coverage of a
color is greater than:

The color “Registration” is
used in a printing element.

RGB mode graphic is used
in the document.

CMYK color mode graphic
is used in the document.

Indexed color mode graphic
is used in the document.

Problem Item Description / SolutionFlag
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Pictures saved in this color mode can print as grayscale, or fail to print on
some composite RIPs. If this is the case for your system, convert the pic-
ture to multichannel or CMYK in an image-editing application before send-
ing it to a composite RIP.

Applying a color to a bitmap (1-bit) mode TIFF picture can cause some
OPI servers and RIPs to fail, or on some systems, the picture will not be
colorized on output. If this is the case with your system, applying the color
to the picture in an image-editing application before it is used in the docu-
ment will allow the picture to be output properly.

A rule or frame width is sized too small for printing clearly. Increasing the
size of the rule or frame will allow it to be printed clearly.

A rule or frame width is sized too small for printing clearly. This happens
most commonly when a rule or frame is colored with a process color.  If
the registration during printing is off, the colors won't overlap and will
appear distorted. Increasing the size of the rule or frame, or changing the
color to a single color will allow it to be printed clearly.

Multicolor gradients are very complex pieces of PostScript code that may
or may not output properly on the imagesetter. If they do output, the
processing time can be increased. With multicolor gradients, there is no
way to predict which colors result from the colors in the gradient. Defining
a gradient using a swatchbook can increase your chances of making a
successful gradient.

Monotone, duotone, tritone
or quadtone color mode
graphic is used in the
document.

A TIFF graphic is colorized
in the document.

Rule or frame pen weight
sized:

Rule or frame pen weight
sized below specified
points, and colored with
specified printing inks.

Multicolor gradient used.

o
o
o

o
o
o

o
o
o

Printing inks

Below              points

Below              points

o
o
o
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The "New elements overprint black by default" preference does not
match the setting in the profile. This setting, when enabled, tells Creator2
to overprint all newly drawn Black elements over other elements. If this
preference is not enabled it will knock out all Black elements.

This will alert you to user-defined traps applied to frames in the document
- allowing you to modify or remove the trap setting to match your pre-
ferred values.

This will alert you to user-defined traps applied to fills in the document -
allowing you to modify or remove the trap setting to match your preferred
values.

This will alert you to user-defined traps applied to shadows in the docu-
ment -allowing you to modify or remove the trap setting to match your
preferred values.

Preference “New elements
overprint Black by default”
is:

Frame has a trap applied.

Fill has a trap applied.

Shadow has a trap applied.

Problem Item Description / SolutionFlag
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Enabled

Disabled

Choke

Spread

Overprint

Knockout

Choke

Spread

Overprint

Knockout

Choke

Spread

Overprint

Knockout
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If a screen font is not available to the system, text in the graphic may not
print incorrectly. Locate and activate the font that was used to create the
graphic. Configuring a Preflight Pro Font Search Path may find the screen
font, but it won't activate it. Be sure to activate the font before printing the
graphic.

A missing printer font may be substituted as Courier, or as a bitmap
(jagged) version of the font. If a font with the same name is present on the
RIP, that font will be used. Customized characters in the original font may
not be in the version of the font located on the RIP and will be missing in
the final output. To ensure proper output, use the copy of the font that was
used to create the graphic.

A TrueType font does not print to a "PostScript Only" output device such
as an imagesetter RIP. In the "Download fonts" pop-up located in the Print
dialog, choose "PostScript and TrueType" when printing. Also be sure to
choose the correct PPD for your output device. If the TrueType font is
"included" in the PostScript print stream, or file, the LaserWriter printer dri-
ver converts it to usable PostScript outlines that image correctly. As a poli-
cy, test this process through your workflow.

Multiple Master fonts can cause an output error on output devices that
cannot handle fonts larger than 300K. Use updated font management
tools and in the "Download fonts" pop-up located in the Print dialog,
choose "PostScript and TrueType" when printing.

Missing screen font.

Missing printer font.

TrueType font used in the
document.

Multiple Master font used in
the document.

Graphics Application Font profile items
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The page size of the graphic may be larger or smaller than expected.
This item compares the graphic size to the trim size you specify for the
graphic in the Job Jacket Output Instructions. If necessary, change the
size of the graphic to match the job trim size. Another option might be to
print the graphic at a reduced or enlarged size.

DCS files consist of a preview and multiple plate files (usually CMYK). All
these plate files are necessary for successful separation. When printed
composite, the preview file is sent to the output device. If any of the other
files are missing, they must be located and placed in the same folder as
the preview file to output properly.

The high resolution version of this OPI graphic can not be found. This
may be because the volume it exists on is not currently available to this
machine, or it may in fact be missing. If it is missing, it may not be output
when the graphic is printed. If the high resolution location/volume
becomes available, reinspect the document so the high resolution
graphic data can be inspected for any printing problems. The name and
location of the high resolution graphic is obtained by looking at the OPI
"comments" inside the low resolution OPI "layout" graphic used in the
document. 

This is a low resolution graphic created by an OPI graphic replacement
program. Preflight Pro does not check resolution, color or image quality in
this file. It will attempt to find the high resolution version of the graphic and
report problems, if they exist, for that graphic. You should replace this
graphic with the high resolution version, if you are not printing to an OPI
server and want high resolution output.

This vector graphic contains an embedded graphic. There is not a prob-
lem embedding a graphic -unless the graphic has an incorrect color
mode, incorrect resolution, or has extra colors defined that may output
extra color plates. Make sure colors are properly defined as spot or
process before outputting the file.

The original disk file for this embedded graphic is missing on disk, which
means it can not be edited, if needed. If the embedded picture is accept-
able for proper output (proper color mode, resolution, etc.), there will not
be a need to edit the original, so this problem may be ignored.

A missing linked graphic is a graphic that has been moved or renamed on
disk after it was placed in the document. Low resolution previews will be
printed for missing linked graphics, instead of the high resolution graphics.
If the graphic is relinked to the document, it can be output correctly. This
can sometimes be done by opening the document the graphic is used in,
locating the missing graphic, and placing it in the document again.
Another option is to embed the graphic in the document, so the disk file is
no longer needed.

Graphic document size
does not match paper trim
size set in document
Output Instructions.

Multi-file DCS graphic is
missing.

High-resolution OPI graphic
is missing.

Graphic is a low-resolution
OPI “layout” file.

A vector graphic contains
an embedded graphic.

Vector graphic contains an
embedded graphic with
missing disk file.

Linked graphic is missing.

Problem Item Description / SolutionFlag
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If a vector graphic contains a linked, not embedded, graphic, it may not be
found when output.  If the linked graphics are not located with the vector
graphic they are used in, their low-resolution preview will be output.

There may also be problems with the linked graphic that Preflight Pro is
not able to report. If all the linked graphics are available, it is recommend-
ed that you inspect them to find any problems that may be encountered
during the printing of the vector EPS.

When saving files in a vector drawing program, there is an option to store
a placed picture in the EPS. If this is not done, the graphic is often lost or
not sent with the job. In Adobe Illustrator, the option to embed is available
when the file is saved or exported. In Macromedia FreeHand, the graphic
can be embedded based on preferences when the graphic is imported or
placed. To avoid missing graphics or graphics not printing, embedding is
recommended. Also be sure to have the colors in the graphic properly
defined as spot or process before saving the file, or the output provider
may have problems getting the colors to print.

This graphic contains an embedded graphic that does not have an origi-
nal disk file located on disk. This means the graphic was either pasted or
dragged-and-dropped onto the page from another application. 

If the graphic is a screen capture, it will be output as a PICT format
graphic, which can not be in CMYK color mode, and will not separate
properly. Screen captures are also commonly low resolution, which will
give you poor output.

To ensure proper output, embed the graphic in the document from an
original disk file that has the proper resolution, color mode, etc. for proper
output. These graphics can also be edited later, if needed.

Some graphic file formats can cause problems on output. Select the
graphic file formats you would like to be notified of when used.

A vector graphic contains a
linked, not embedded,
graphic.

No disk file exists for
embedded graphic.

Incorrect graphic file
formats: 

Graphics Application Graphics profile items  (continued)

Problem Item Description / SolutionFlag

o
o
o

o
o
o

EPS

GIP

DCS

BMP

WMF

PICT

TIFF

Illustrator

OtherJPEG

Scitex CT
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If you turn on this alert, there must be some issue in your process that
causes this EPS format to be a problem. A solution may be to open the
graphic in an image-editing application and save it in a different file format
that works for your workflow.

A compressed picture can be problematic on a PostScript RIP. LZW
decompression can cause delays on Level 1 PostScript output devices,
but work fine on PostScript Level 2 devices. EPS/DCS pictures with JPEG
compression can cause Level 1 devices to fail.

A TIFF graphic with extra channels will cause some output device RIPs to
fail. These graphics can be resaved in an image-editing application with-
out the extra channels to output properly. In general, document originators
should remove all extra data from graphics that are ready for output.

If a graphic is saved with a custom line screen, it will be imaged at that
line screen. This may result in a graphic that prints differently than other
pictures in the same document. Custom curves are ignored if the image is
sent to a composite color RIP. Two different screens cannot be applied on
composite color RIPs.

Graphics saved with custom transfer functions may not output correctly.
The curve may cause the graphic to print differently than it appears on-
screen, or the curve may be ignored if sent to a composite color RIP. For
composite color RIPs the curve should be applied to the graphic in an
image-editing application prior to placing the graphic in a document for
output.

Too low of a flatness setting for a path may create an excessive amount
of points on the clipping path, while too high of a flatness setting for a
path may cause a graphic to print with edges that are flat or angular on
output, instead of rounded.

EPS graphic created in an
incorrect application:

Graphic is compressed: 

TIFF graphic saved with
extra channels.

Graphic saved with custom
line screen.

Graphic is saved with a
custom transfer function.

Graphic clipping path
flatness: 

Problem Item Description / SolutionFlag

o
o
o

Graphics Application Graphics profile items  (continued)

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o Less than

More than

LZW TIFF

JPEG EPS

JPEG DCS

QuarkXPress

Creator2

PageMaker

Photoshop

CorelDRAW

Illustrator

FreeHand

Other
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If the resolution of a color or grayscale graphic is too low, pixels may be
prominent on output and the picture will appear jagged. Rescan the
image at a higher resolution, or decrease the scaling of the graphic on the
page to increase the resolution. The correct resolution is 1.5 to 2  times
the output line screen at the final image size after scaling it on the page.

If the resolution of a color or grayscale graphic is too high, it will take
longer to output than necessary.  Excess resolution does not result in an
improvement in quality. If there are many of these or if the excess resolu-
tion is significant, investigate sampling the data down in an image-editing
application. The correct resolution is 1.5 to 2 times the output line screen
at the final image size after scaling in a page layout program.

If the resolution of a bitmap (1-bit) graphic is too low, the graphic may
appear jagged. If it is too high, the file will take longer than necessary to
output.

Resolution of a color or
grayscale picture too low.
Less than:

Resolution of a color or
grayscale picture too high.
More than:

Resolution of a bitmap
(1-bit) graphic is:

Problem Item Description / SolutionFlag

o
o
o

Graphics Application Graphics profile items  (continued)

o
o
o

o
o
o Less than ppi

More than ppi

x Line Screen

Pixels per inch

x Line Screen

Pixels per inch
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An incorrect number of printing inks will result in the output of extra plates
when printing separations. This item compares the number and type of
colors the graphic will output to the colors specified in the Job Jacket
Output Instructions for the graphic. Unneeded spot colors should be con-
verted to process.

RGB color mode graphics must be converted to CMYK color mode before
they are able to separate properly on output. Some RIPs can make the
conversion, but the results may not be acceptable. It is best if this is done
in an image-editing application, such as Adobe Photoshop. 

This graphic was saved in the CMYK color mode. If your workflow does
not require CMYK color mode graphics, you may choose to change the
color mode of the graphic in an image-editing application.

Indexed color graphics usually come from the Internet and have a severe-
ly reduced color palette. They will print with reduced colors -even if they
are converted to CMYK. Colors eliminated in the original conversion can-
not be restored. Rescan the picture, if possible, or print a color proof to
see how it looks on output.

Graphics saved in this color mode can print as grayscale, or fail to print
on some composite RIPs. If this is the case for your system, convert the
graphic to multichannel or CMYK in an image-editing application before
sending it to a composite RIP.

Incorrect number of printing
inks as compared to the
document Output
Instructions.

Graphic saved in RGB
color mode.

Graphic saved in CMYK
color mode.

Graphic saved in Indexed
color mode.

Graphic saved in monoto-
ne, duotone, tritone, quad-
tone color mode.

o
o
o

o
o
o

o
o
o

o
o
o

Problem Item Description / SolutionFlag

Graphics Application Colors profile items  (continued)

o
o
o
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The page size of the PDF may be larger or smaller than expected.  This
item compares the page size of the PDF document to the Trim Size you
specify in the Job Jacket Output Instructions. If necessary, change the
page size before generating the PDF to match the job trim size. Another
option might be to print the document at a reduced or enlarged size.

Distiller can create PDFs that are compatible with Acrobat  2.1 or Acrobat
3.0. The Acrobat 3.0 format is preferable in most cases because it takes
advantage of a number of improvements in PDF technology, such as bet-
ter pattern display and more advanced compression.  However, PDFs in
3.0 format cannot be read properly with 2.1 viewers. For compatiblity with
a wider range of viewers, choose the 2.1 format. For better output,
choose the 3.0 format.

You can change this compatibility setting when creating a PDF with
Preflight Pro by using the Compatibility pop-up menu in the General sec-
tion of the  Edit PDF Settings window.

Distiller gives you the option of saving PDFs in Binary or ASCII format.
Binary-formatted PDFs are preferable, as they are about 20 percent
smaller in size. Most printers require PDFs saved in Binary format.

You can change this format setting when creating a PDF with Preflight Pro
in the General pane of the  Edit PDF Settings window. To create PDFs in
Binary format, make sure the ASCII Format checkbox is left unchecked.

Exchange allows you to save a PDF in an optimized mode, which restruc-
tures the document so that pages can be downloaded one at a time when
viewed on the web. Optimization also reduces file size by removing multi-
ple occurrences of text, images and other objects in a document and
swapping them with pointers to the first occurrences of those items. This
setting is not recommended for PDFs intended for high-end printed out-
put, as it can cause problems in print production.

To change a document's optimization setting, open the PDF with
Exchange, choose the Save As command and turn the Optimize check-
box on or off.

The PDF may be damaged, but opening the file in Exchange and resav-
ing it may correct the problem. If that isn't possible, it may be necessary
to return to the orginal application in which the document was created and
distill a new PDF. 

Exchange allows you to save a PDF with a password-protected security
code that prevents unauthorized printing of the document. If this printing
security feature is enabled for a document, users will not be able to print it
without entering a password. To access Exchange's security features,
open the PDF with Exchange, choose the Save As command and click
the Security button.

Incorrect page size, as
compared to the trim size
entered in the Document
Output Instructions.

Document saved in version
2.1/3.0 PDF compatibility.

____ 2.1
____ 3.0

Document uses
Binary/ASCII format.

____ ASCII
____ Binary

Document not saved with
“Optimized” enabled in the
Save dialog.

Document is damaged and
needs repair on Open.

Document security
Does/Does Not allow 
printing.

____ Does
____ Does Not

Acrobat PDF Document profile items

Problem Item Description / SolutionFlag

o
o
o

o
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o

o
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o
o
o

o
o
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Exchange allows you to save a PDF with a password-protected security
code that prevents unauthorized selecting of text or graphics, editing of
notes, or changing of other document contents. If this security feature is
enabled for a document, users may not be able to select and copy text or
graphics, edit notes or otherwise alter the PDF without entering a pass-
word. To access Exchange's security features, open the PDF with
Exchange, choose the Save As command and click the Security button.

The PDF file contains a different number of pages than is specified in the
profile that was used to inspect it with Preflight Pro. The document may
be missing pages or contain extra pages that were not intended for out-
put.

Different size pages exist in this document. This may not be as expected,
or the file may need special attention in order to output each page proper-
ly. If adjustments in page size are necessary, return to the application
from which the PDF was distilled, adjust the original document, and distill
again.

One or more of the pages in the PDF file are blank and will be output.
When outputting to film, this is unnecessary and will result in wasted film.
For press impositions, it is preferred if the job actually has blank pages. If
you do not need blank placeholders in the digital file, open the PDF with
Exchange and delete the blank pages.

The PDF was created by using the Adobe Acrobat PDFWriter printer dri-
ver in the Chooser. The current version of Acrobat PDFWriter does not
handle EPS files correctly and is not recommended for high-end printed
output. Choose the LaserWriter 8 printer driver or Adobe's PSPrinter dri-
ver instead when creating PostScript files.

This document contains PostScript code that is not part of the standard
page description language used to image the page.

Document security
Does/Does Not allow 
editing.

____ Does
____ Does Not

Incorrect number of pages.

Less Than ____ pages
Exactly ____ pages
More Than ____ pages

Document has different size
pages.

Blank pages exist in the
document.

Document created with 
the Adobe PDFWriter 
print driver.

Document description 
contains PostScript code.

Problem Item Description / SolutionFlag

Acrobat PDF Document profile items (continued)
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One or more of the fonts needed to print the file was not embedded in the
PDF when it was distilled. This means the same font will have to be resi-
dent on the final output device in order for the document to print correctly.
If the font is embedded in the PDF, it will print correctly, regardless of the
fonts available on the final output device.

You can ensure that all fonts are embedded in the PDFs you create with
Preflight Pro by choosing All from the Font Inclusion pop-up menu in the
PostScript panel of Preflight Pro's Edit  PDF Settings dialog box and by
checking the Embed All Fonts checkbox in the Font Settings section of
the General pane. 

Note that Distiller never embeds the 14 "base" fonts (Times, Helvetica,
etc.) that are resident on all standard PostScript devices.An embedded
font in the document has been subsetted. When a font is subsetted, only
those characters that actually appear in the document are embedded into
the PDF file, while the unused characters are discarded, resulting in a
smaller PDF file.  Subsetting a font also forces Distiller to assign the font
in the PDF file a unique name, ensuring that the embedded font will not
be substituted with an identically-named font when the file is output. 

Generally, subsetting fonts is recommended for high-end printed output.
The percentage listed in the Subset Fonts Below field in the Font Settings
section of Preflight Pro's Edit PDF Settings dialog box determines which
fonts Distiller will subset. The recommended percentage is 99%, meaning
that if less than 99 percent of the font's characters set appear in the docu-
ment, the font will be subset. This essentially guarentees that all embed-
ded fonts in a document will be subset. 

Some TrueType fonts may not distill correctly when included in a PDF.
The result is that some characters may not be rendered properly on
screen or in  final output. Also, a TrueType font does not print to a
"PostScript Only" output device such as an imagesetter RIP.

Multiple Master fonts can cause an output error on output devices that
cannot handle fonts larger than 300K. As a policy, test this process
through your workflow.

An "Bold" styled font may not look as balanced and well-proportioned as a
font that has a true bold when output on a high-resolution printing device.
Return to the files from which the PDF was distilled and choose a font
that has a true bold style.

An "Italic" styled font may not look as balanced and well-proportioned as
a font that has a true italic or oblique style when output on a high-resolu-
tion printing device. Return to the files from which the PDF was distilled
and choose a font that has a true italic or oblique style.

An "Outline" styled font prints well to a laser printer, but on a high resolu-
tion device the outlines may become much thinner. The style may look
even thinner if Computer-to-Plate processing is used. Choose a font that
has a true outline style, or convert the font to a graphic in a vector draw-
ing program and apply a stroke of a specific width.

Font is not embedded in
the document. 
(excludes base 14 fonts)

Embedded font is/is not
subsetted.

____ Is
____ Is Not

TrueType font is used in the
document.

Multiple Master font is used
in the document.

Font has “Bold” menu style
applied.

Font has “Italic” menu style
applied.

Font has “Outline” menu
style applied.

Acrobat PDF Font profile items

Problem Item Description / SolutionFlag
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Type 3 fonts are rarely-used bitmapped fonts that are incompatible with
Adobe Type Manager. Type 3 fonts also are not recommended for high-
end output and should not be used in PDFs.

A small point sized font may reproduce badly on press and be difficult to
read. Increase the point size of the font, if possible. You can do this in
Exchange, with a PDF-editing tool, or by making changes in the original
document from which the PDF was distilled.

A small point sized font, colored with screen tints, may reproduce badly
on press and be difficult to read. Color the font with a Printing Ink (spot
color), or increase the point size of the font, if possible. You can change
the size of the font in Exchange, with a PDF-editing tool, or by making
changes in the original document from which the PDF was distilled.

When a required font is missing, output devices such as laser printers and
imagesetters often substitute Courier for the missing font. Flagging the
actual presence of Courier in a document can help you determine
whether this font has appeared  intentionally (the original document was
formatted with Courier) or by accident (Courier was swapped in fora miss-
ing font).

Type 3 font is used in the
document.

Font sized too small.

Sized below ____ points

Font sized below X points,
and colored with X or more
printing inks.

Sized below ____ points
Colored with ____ or
more printing inks

“Courier” font is used in the
document.

Problem Item Description / SolutionFlag

Acrobat PDF Font profile items (continued)
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If the resolution of a color or grayscale graphic is too low, pixels may be
prominent on output and the picture will appear jagged. The correct reso-
lution is 1.5 to 2  times the output line screen at the final image size after
scaling it on the page.

The low resolution may be the result of downsampling the image data
when the PDF was distilled.  You can turn downsampling off by adjusting
the settings in the Compression pane of the Edit PDF Settings dialogue
box. If the resolution of the original image is too low, youll have to return
to the document from which the PDF was distilled and rescan the image
at a higher resolution, or decrease the scaling of the graphic on the page
to increase the resolution. 

If the resolution of a color or grayscale graphic is too high, it will take
longer to output than necessary.  Excess resolution does not result in an
improvement in quality. If there are many of these or if the excess resolu-
tion is significant, investigate downsampling the data when distilling the
PDF or return to the original images and downsample them in an image-
editing application. The correct resolution is 1.5 to 2 times the output line
screen at the final image size after scaling in a page layout program.

You can downsample images as part of the distillation process in Preflight
Pro  by adjusting the settings in the Compression pane of the Edit PDF
Settings dialogue box.

If the effective resolution of a bitmap graphic is too low, the graphic may
appear jagged.  Each shop or customer may have their own acceptable
range.  A general minimum is 300 DPI. The maximum is usually around
2400 DPI (or the writing engine resolution). The most common range is
between 800 and 1200 DPI. Rescan the image at a higher resolution, or
decrease the scaling of the graphic on the page in the application from
which the PDF was created to increase the resolution.

If the effective resolution of a bitmap graphic is too high, the file will take
longer than necessary to output.  Each shop or customer may have their
own acceptable range.  A general minimum is 300 DPI. The maximum is
usually around 2400 DPI (or the writing engine resolution). The most com-
mon range is between 800 and 1200 DPI. If many images are above final
imagesetter resolution they can be reduced in resolution in an image-edit-
ing application. You can also downsample bitmapped images as part of
the distillation process in Preflight Pro  by adjusting the settings in the
Compression pane of the Edit PDF Settings dialogue box.

This is a low resolution picture created by an OPI picture replacement
program. Preflight Pro does not check resolution, color or image quality in
this file. It will attempt to find the high resolution version of the picture and
report problems, if they exist, for that picture. You should replace this pic-
ture with the high resolution version, if you are not printing to an OPI serv-
er and want high resolution output.

Effective resolution of a
color or grayscale picture
too low.

(  ) Less than ____ times
the line screen.

( ) Less than ____ pixels
per inch.

Effective resolution of a
color or grayscale picture
too high.

(  ) More than ____ times
the line screen.

( ) More than ____ pixels
per inch.

Effective resolution of a
bitmap (1-bit) picture is too
low, or too high.

[  ] Less than ____ pixels
per inch.

[  ] More than ____ pixels
per inch.

Picture is a low-resolution
OPI layout file.

Problem Item Description / SolutionFlag

Acrobat PDF Graphics profile items
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The high resolution version of an OPI picture can not be found. This may
be because the volume it exists on is not currently available to this
machine, or it may in fact be missing. Or, when creating the PDF, you
may not have had the Preserve OPI Comments checkbox selected in
Distiller's Job Options (or in the Advanced panel of Preflight Pro's Edit
PDF Settings dialog box). 

If the high-res picture is missing, it may not be output when the document
is printed. If the high resolution location/volume becomes available, rein-
spect the document so the high resolution picture data can be inspected
for any printing problems. The name and location of the high resolution
picture is obtained by looking at the OPI "comments" inside the low reso-
lution OPI "layout" picture used in the document.

When making PDF files with Preflight Pro, make sure the Preserve OPI
Comments option is turned on in the Advanced panel of the Edit PDF
Settings dialog box to preserve OPI comments 

Rotated or skewed picture can increase the output time of the document
and occasionally activate bugs in OPI servers or imposition programs -
which will cause items not to print or move out of position at print time.

Distiller allows you to compress Text and Line Art when creating a PDF.
This option generally can be left on without problems, as it results in
smaller PDF files but does not degrade the quality of the images or text.
You can control this setting in Preflight Pro in the Compression panel of
the Edit PDF Settings dialog box. Turning on the Compress Text and Line
Art checkbox activates the compression.

High-resolution OPI picture
is missing.

Picture has been rotated or
skewed in the document.

Text and Line Art is com-
pressed/not compressed.

____ Compressed
____ Not Compressed

Problem Item Description / SolutionFlag

Acrobat PDF Graphics profile items (continued)
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JPEG compression is a "lossy" compression scheme, meaning that it pro-
duces smaller files by discarding a certain amount of color information.
The higher the level of JPEG compression, the lower the quality of the
resulting image. On high resolution images, JPEG Low usually can be
used without degrading the quality of the final output. For non-critical
color, some printers also recommend JPEG Medium (more compression,
lower quality). In general, JPEG Medium-High and JPEG High should not
be used in high-end output jobs because they noticeably reduce the quali-
ty of images.

JPEG compression works best with photographic images, not those con-
taining large areas of solid color, such as those produced by drawing pro-
grams. ZIP compression is lossless (does not degrade image quality) and
is preferable for images containing large areas of solid color. If you
choose the Automatic Compression option when distilling PDF files,
Distiller will choose either ZIP or JPEG compression, based on the type of
image file being compressed.  Some prepress professionals prefer the
Automatic settings, while others do not recommend compression on
images intended for high-end output. It's recommended that you test
these settings to ensure the best possible results in your workflow.

(NOTE: The Zip 4-bit and Zip 8-bit options available under Manual
Compression are different than the Automatic ZIP compression, and are
lossy, meaning they reduce file size by removing data.)

ZIP and LZW are both lossless compression methods, meaning they can
reduce the size of files without degrading image quality. These methods
work best with images containing large areas of solid color, such as those
produced by drawing programs, and not continuous-tone photographic
images. For photographic images, choose JPEG compression instead.

You also must choose LZW compression in order to retain compatibility
with Acrobat 2.1. If your workflow doesn't require 2.1 compatibility, use
ZIP instead of LZW. ZIP is more efficient than LZW and results in smaller
PDF files.

The LZW 4-bit, LZW 8-bit, Zip 4-bit and Zip 8-bit options available under
Manual Compression are different than the Automatic ZIP and LZW com-
pression options. The 4-bit and 8-bit version of these compression meth-
ods are lossy, meaning they reduce file size by removing data.

You can adjust the compression settings used to create PDFs with
Preflight Pro in the Compression panel of the Edit PDF Settings dialog
box.

Incorrect Color or
Grayscale image compres-
sion scheme used. 

[  ] JPEG

[  ] ZIP/LZW

Problem Item Description / SolutionFlag

Acrobat PDF Graphics profile items (continued)
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CCITT Group 3 compression is the data compression method used by
most fax machines to handle monochrome bitmapped images.
Compressing with CCITT Group 3 does not result in any data loss or
image degradation, but it is not the best choice for monochrome images
intended for high-end output. Choose CCITT Group 4, LZW or ZIP com-
pression instead. Some prepress professionals do not recommend com-
pression on images intended for high-end output. It's recommended that
you test these settings to ensure the best possible results in your work-
flow.

CCITT Group 4 compression provides good overall data compression for
monochrome (1-bit) images. Compressing with CCITT Group 4 does not
result in any data loss or image degradation.  However, images that con-
tain numerous repeating patterns can be more efficiently compressed
using  LZW or ZIP compression. Images with large areas of solid white or
solid black can be best compressed using the Run Length method. Some
prepress professionals do not recommend compression on images intend-
ed for high-end output. It's recommended that you test these settings to
ensure the best possible results in your workflow.

LZW and ZIP are preferred image compression methods for monochrome
images that contain  repeating patterns. Neither method results in any
data loss or image degradation. Images with large areas of solid white or
solid black can be best compressed using the Run Length method. For
general monochrome images, CCITT Group 4 is an efficient compression
method. Some prepress professionals do not recommend compression on
images intended for high-end output. It's recommended that you test
these settings to ensure the best possible results in your workflow.

Run Length compression is sometimes chosen to efficiently compress
monochrome images containing large areas of solid white or solid black.
This method does not result in any data loss or image degradation, but for
monochrome images in general, CCITT Group 4 is a more efficient com-
pression method.

Some prepress professionals do not recommend compression on images
intended for high-end output. It's recommended that you test these set-
tings to ensure the best possible results in your workflow.

You can adjust the compression settings used to create PDFs with
Preflight Pro in the Compression panel of the Edit PDF Settings dialog
box.

Incorrect Monochrome
Bitmap image compression
scheme used.

[  ] CCITT Group 3

[  ] CCITT Group 4

[  ] ZIP/LZW

[  ] Run Length
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An incorrect number of printing inks will result in the output of extra plates
when printing separations. This item compares the number and type of
colors the document will output to the colors specified in the Job Jacket
Output Instructions for the document. Unneeded spot colors should be
converted to process. If the PDF was created in QuarkXPress, you can do
this by selecting each spot color in the Color dialog, clicking the Edit but-
ton, and checking the "Process Separation" (QuarkXPress 3.3) or "Spot
Color" (QuarkXPress 4) checkbox.

RGB color mode pictures must be converted to CMYK color mode before
they are able to separate properly on output. Some RIPs can make the
conversion, but the results may not be acceptable. It is best if this is done
in an image-editing application, such as Adobe Photoshop.

Indexed color pictures usually come from the Internet and have a severely
reduced color palette. They will print with reduced colors -even if they are
converted to CMYK. Colors eliminated in the original conversion cannot
be restored. Rescan the picture, if possible, or print a color proof to see
how it looks on output.

This picture was saved in the CMYK color mode. If your workflow does
not require CMYK color mode pictures, you may choose to change the
color mode of the picture in an image-editing application.

The color "Registration" is meant to be used for items that need to print
on all plates. Usually, this is used for registration marks. It is sometimes
mistaken as the color Black in the color palette. If this is the case, return
to the application from which the PDF was created and replace each
occurrence with the proper color.

The total ink coverage of this color is too high. Certain printing conditions
can only support so much ink on paper. If too much ink is placed, it caus-
es problems. Adjustments must be made to the color's total ink usage to
be printed properly.

A rule or frame width is sized too small for printing clearly. Increasing the
size of the rule or frame in the application from which the PDF was made
will allow it to be printed clearly.

A rule or frame width is sized too small for printing clearly. This happens
most commonly when a rule or frame is colored with a process color.  If
the registration during printing is off, the colors won't overlap and will
appear distorted. Increasing the size of the rule or frame  in the applica-
tion from which the PDF was made, or changing the color to a single color
will allow it to be printed clearly.

Incorrect number of printing
inks as compared to the
Document Output
Instructions.

RGB color mode picture
used in the document.

Indexed color mode picture
used in the document.

CMYK color mode picture
used in e document.

The color “Registration” is
used in a printing element.

Total ink coverage of a
color is greater than X per-
cent.

Rule or frame sized below
X points, is used in the doc-
ument.

Sized below ____ points.

Rule or frame sized below
X points, and colored with
X or more printing inks.

Sized below ____ points.
Colored with ____ or
more printing inks.

Problem Item Description / SolutionFlag

Acrobat PDF Color profile items

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o

o
o
o
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Color Profile Items
Acrobat PDF  162, 209
Creator2   154, 191
Graphics Applications   156, 200
PageMaker   148, 182
QuarkXPress   142, 171

Color Sample   seealso Colors
accessing   36   
where shown   36

Colors
information gathered about   36
Profile Items   seeColor Profile Items
tab described   36

Compressing a collectionseealso Collection
how to   94
options   88
segmenting  94

Configure Profiles   seealso Profiles
how to   59
tutorial on   113

Contact tab   21
Correcting problems     seealso Problems

with Pilot, described   17 
how to   73-75   
tutorial on    123

Creator
Document, where listed   30
icon   28, 29   
Picture File, where listed   32, 33 

Creator2   see Multi-Ad Creator2
CMYK

color values, where shown   32, 36

D
Date   see also:Log tab

document added to list   37
note created   38

Default
Job Ticket   seeJob Ticket
Output Instructions   seeOutput Instructions
Profile   seeProfiles

Default Output Instructions   40, 51
see also:Output Instructions

Default Ticket   see also:Job Ticket
menu command   50

Delete Entry
of a note   38

Delivery tab, of Job Ticket   22

A
Add documents

button described   25    
to Files list   44
to Job Jacket   44
to collection list   94
tutorial   104

AppleScripts
in Automations   97, 98, 102

Assigning a Profile   see also:Profiles
how to   61
tutorial   115

Automations    97-102
configure   100
menu selection   100
overview of   99
settings   97, 98
success/failure folders   98
Technical Details   99  
Watch folder, specifying   101 

B
Button Bar

functions described   26
icons defined   25

C
Caution Checkbox   see“Show only” checkbox
Caution Flag   seeProblem Severity Flags
Collecting Job Elements   seealso Collection

button described   25, 26
described   87-96

Collection
add files to   94
button described   25
creating a, how to   91-93
compressing a, how to   94
Collecting job elements, how to   94
embedded pictures and   96
delete files from   95
folder contents   93
items collected   88, 89
options described   88, 89
process described   87, 88-90
Preview dialog   90  

Index
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Flags   seeProblem Severity Flags
Font   see also:Font Info window, Fonts tab

information gathered about   
info window   35
tab described   34
Screen Font name, where shown   34, 35
Style applied, where shown   34, 35
Printer Font name, where shown   34, 35
Profile Items seeFonts Profile Items
Status   34, 35
Type, where shown  34, 35
Search Paths   53-54     
System Status of, where shown   34, 35
Foundry name, where shown   34, 35
Version of, where shown   34, 35

Font Info window
accessing   34-35
described   35

Fonts Profile Items
Acrobat PDF  160, 203
Creator2   151, 186
Graphics Applications   156, 195
PageMaker   145, 175
QuarkXPress   139, 164

Fonts tab
accessing   34
described   34
opening detailed info window   35

Font Search Paths
described   53
specifying   54

Foundry
of font, where shown   34, 35

FreeHand   see also:Graphics Profile
support for   5, 8
Profile, described   55
Profile Items   157, 195

G
General Profile Items   seeDocument Profile Items
Generating reports   seealso Report

button described   25, 26
how to   65

Graphics Profile Items
see also:Pictures Profile Items
Acrobat PDF  161, 205
Creator2   152, 187
Graphics Applications   157, 195
PageMaker   146, 177
QuarkXPress   140, 166

Document
name, where shown    24, 28, 30, 32, 33, 35

Document Info window
accessing   30
described   30

Document Profile Items
Acrobat PDF  159, 201
Graphics  156, 195
Creator2   150, 185
PageMaker   144, 174
QuarkXPress   138, 163

Document Status Icon   28, 29
tutorial   103

Duplicate documents
command described   44
how to   44

E
Edit

Job Ticket, how to   20
Note, how to   38
Profiles, how to    59  seeConfiguring

Profiles
Edit Job Ticket   seeJob Ticket
Eff Res

of a Picture, where shown   
Embedded Pictures

explained   96
collecting   96

Equipment needs 5
Error Checkbox   see“Show only” checkbox
Error Flag   seeProblem Severity Flags
Exclude pages

button described   25, 26
command described   26, 43
from Report, how to   43
how to   43

Exclude from Report   seeReport
Export Job Info 47
Export to PDF    18, 26, 78-86   see also:PDF
Exporting job information   47
Extensis

how to contact   2
Technical Support   6

F
Files

adding to a Job   12
adding to a Collection    94 
Files List described   28
tab described 27

First only   67
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I
Icon list   29
Ignore Flag   seeProblem Severity Flags
Ignore Checkbox see“Show only” checkbox
Illustrator   see also:Graphics Profile

support for   5, 8
Profile described   55
Profile Items   157, 195

Include pages    seeExclude Pages
Ink   seePrinting Inks
Inspect   see also:Inspecting documents

button described   25
command described   42

Inspecting documents   41-42
automatically, preference   49
button described   25
how to   26, 42
tutorial on   109

Inspect Selected   see also:Inspecting documents
how to   42

Installation   6
Instruction tab, of Job Ticket   23
Item   seeProfiles

J
Job

Collection   seeCollection
creating a new   12 
File, creating   9, 12, 24, 104
Jacket   seeJob Jacket
Ticket   seeJob Ticket

Job Jacket
Button Bar   25
Colors tab described   36
Files list described   27, 28
Files tab described   27
Fonts tab described   34
Pictures tab described   32
“Show only” checkboxes   31
window described   24

Job Ticket
button   25, 26
creating   20, 25
Default Ticket   23, 50
described   10, 20-23
editing   20
Log tab   37
Notes tab   38
tabs described   21-23

L
Line Screen

defined   39
specifying  40 

Log tab, of Job Ticket   37

M
Media tab, of Job Ticket   22
Mode   
Multi-Ad Creator2

support for   5, 8   
Profile Items  150, 185

N
Name

of document, where shown   
of font, where shown   
of color, where shown   
of note creator   
of picture, where shown   

Navigating problems
with Preflight Pro Pilot, how to   
tutorial on   

New job , creating a   9, 12, 24, 104
Notes tab   38

O
Open documents

button described   25, 26
command described   26, 46
how to   46

Open Pilot   see also:Pilot
button, described   25, 26
using   17, 73-74, 123

Order Info tab   21
Output Instructions

entering   39-40
applying to multiple documents   40
button described   25, 26 
Default, specifying   40, 51
specifying   39

P
Page Status Icon   28, 29, 31
PageMaker see also:Profiles

correcting problems in, how to   76
export to PDF   81
Preflight Pro menu in   76
Profile Items  144, 174
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Leave documents open in QuarkXPress   52 
Leave documents open in PageMaker   52 
Only Analyze when Building Report   49
setting   49
Specify copy of PageMaker   52
Specify copy of QuarkXPress   52

Preflighting
commands described   25, 26  
defined   7
getting started with   9-10   
overview   12-19  
tutorial on   103 

Preflight Pro   see also:Preflighting
benefits   5
quick start   9, 12
tutorial on   103
What’s New in 2.0   8

Printed Reports   see also:Reports
Collection Report   70, 72
Consolidated Report   70, 71
described   69
how to print   70
Job Inventory Report   65
Job Ticket info   70, 71
types of   69, 71-72

Printer Font
name, where shown   34, 35

Printing Ink
defined   39
specifying   40 
type, where shown   36

Problem see also:Problem Items, Problem
Severity Flags, Pilot

assigning severity to   31, 55, 59-60, 114
correcting, tutorial on   123
detail area, of Pilot   73
detail area, of Report window   
determining severity of, tutorial on   114
first only, showing   67
items, list of   138-210
reporting, tutorial on 117

Problem flags   seeProblem Severity Flags
Problem Item(s)

complete list of   134-158
flags   seeProblem Severity Flags

Problem Severity Flags
checkboxessee“Show only” checkboxes
described   59
discussed    31, 55, 59-60, 114
categories of   59-60
meaning of   59
tutorial on   113

PDF   78-86
creating a new settings file   83   
creating a PDF   81
Delete settings   84
export to   81-82
PPD preferences   85
Rename settings   84
Settings   79-80
Sharing PDF settings   86

Page
Color found, where shown   
Font found, where shown    
icons described    28, 29
icons discussed   110-111

Photoshop   see also:Graphics Profile
support for   5, 8
Profile described   55
Profile Items   156, 195

Picture Box Profile Items
seePicture Profile Item

Picture File Profile Items
seePicture Profile Items

Picture Info window
accessing   33
described   32-33, 112

Pictures   see also:Pictures tab, Graphics
information gathered about   32-33

Pictures tab
accessing   32 
described   32-33
opening detailed info window   33, 68

Pilot
correcting problems with   73-75
described   17, 73
going to a problem with   74
going to a different problem   75
return to Preflight Pro from   75
using   73-75
tutorial on   123

Pilot palette    seePilot
Preferences

Analyze only on Report   49
Auto-add PDF to job   49
Auto-inspect documents   49
Auto-open Pilot   49
Auto-open Report   49
Auto-prompt for Output Instructions   49 
Default Ticket   50
Default Output Instructions   51
Display full pathname   49
Font Search Paths   53
General   49



R
Relinking Documents   48
Remove documents   45

button described   25, 26
command described   45
from Files list   45
from Job Jacket   45
from Collection list   95
how to   45

Report
button described   25, 26
described   63-74
Consolidated Report described   69
Consolidated Report printout   70, 71 
how to generate a   65
Job Inventory Report   70
problem reports   63-77
Report On list described    66
printing   70
tutorial on   117
window described   63

S
Sample Files

about using   11
tutorial using   103

Screen Angle   see also:Colors
of a color, where shown   

Screen Font    seeFonts
name, where shown   34, 35

Section    seeProfiles
Selected

column described   28
Setting Preferences   seePreferences
Spot Color

about   39
specifying   40

Sharing Profiles   see also:Profiles
described   61, 62
how to   62

Show/Next
button described   73
using   74-75

215

Profile Items   see also:Profiles
Item, displayed in Pilot   73
described   55-56
How they work  138-162

Profile Sections   see also:Profiles
defined in Pilot    73
defined in Report   63, 67
described   55-57
Items included in 138-162  

Profiles
assigning   61
configuring   57, 59-60
default   58   
described   55-57
dialog described   55
for Creator2   150, 185
for FreeHand   157, 195
for Illustrator   157, 195
for PageMaker   144, 174
for Photoshop   157, 195
for QuarkXPress   138, 163
How they work  138
Items in Pilot   73  
Problems and Solutions  163
Section defined in Pilot   73
Sections, items included in   138-210
sharing   62
tutorial on   113
Understanding Profile Items   138-210
where to place   61
when looked at   56
working in the Profile dialog   55
why needed   56

Q
QuarkXPress see also:Profiles

correcting problems in, how to   76
correcting problems in, tutorial   103
export to PDF   81
Profile Items  138, 163
Preflight Pro menu in   76
specify copy to use   52

Quick start   9, 12-17
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“Show only” checkboxes
see also:“Problem Severity Flags”
described   31
discussed   31, 55, 59-60
tutorial on   113
using   65, 67

Software Requirements   5
Status

column described   28
icon defined   28, 29
of document discussed   24, 28, 29, 66
of font   34, 35
of Picture, where shown   32, 33

Style
of font, where shown   34, 35

System Requirements   5
System Status

of font, where shown   34, 35

T
Technical Support

contacting   5
web site address   5

Thumbnail Preview   see also:Pictures
of picture, accessing   32, 33
shown   33

Ticket   seeJob Ticket
Time   see also:Log tab

document added to list   37
Total

pages in a document, where shown  24, 28,
30 

problems found, where shown  24, 28, 30, 
63, 67, 73 

Trapping Profile Items
Creator2   155, 193
PageMaker   149, 184
QuarkXPress   143, 173

Trim Size
defined   39
specifying   40

Troubleshooting info, where to find   6
Tutorial

about   103
Inspecting Documents   109
Profiles   113
Problem Reports   117 
Starting a Job   104
Using the Pilot   123

Type
of picture, where shown   32, 33
of color, where shown   36
of font, where shown   34, 35

U
Update Analysis Now   seeAnalyze command

V
Version

of font, where shown   34, 35

W
Web site

Extensis   2
Technical Support   6

What’s New in Preflight Pro 2.0   8 
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